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Chapter 1

Introduction

Sage, the recognized leader in business management for small- and mid-size
businesses, welcomes you to Sage 100 2020.

How to Use This Guide

This guide has been created to ease the process of upgrading your software. While
the new features included in this release have been designed to improve your
workflow and business processes, this means that the way you use your system
may change.

This guide contains the following information you need for a successful upgrade:
e Alist of changes to the installation program

e A list of enhancements and changes made in Sage 100

e Checklists to guide you through migrating and converting your data

For a complete list of enhancements in this release, see What's New in Version 2020
on page 3. After installing the product, you can view this information and the release
notices, which is a list of corrections incorporated into this release. To view, click the
Resources link on the Tasks tab, and then click What's New to see the enhancement
information. At the top of the What's New page, click Release Notices to see the list
of corrections.

Depending on your purchase agreement, some features described here may
not be available in your product.

The remaining chapters highlight the differences that you need to be aware of and
the steps you need to take before using the new system. The upgrade checklists
provide instructions for migrating and converting your company data.

Review the information in this guide before installing the software. For more
information, refer to your Installation and System Administrator's Guide. The
Installation and System Administrator's Guide can be found in the Documents folder
of the Sage 100 installation program, or by starting the installation program,
selecting a product, and then clicking Documentation. The guide is in PDF format
and is named Sage 100_Install.pdf.

Some sections of this guide reference Business Insights Reporter and the eBusiness
Manager, Material Requirements Planning, and Work Order modules, which are not
available for Sage 100 Premium.
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How to Use This Guide

Graphic Conventions

The following icons are used throughout this guide to indicate different types of

information.
The NoTe symbol is followed by additional information
& about a topic.
The WARNING symbol is followed by information to help you
avoid costly mistakes.

Text Conventions

The following table describes the text conventions used in this guide.

Text Convention Explanation

Menus Menus are shown in this format:
Select menu > menu task name.

Examples:

e Select File menu > Change Company.
e Select General Ledger Budget menu >
Budget Maintenance.

Bold font Indicates text entered at a field or text selected
at a field.

Examples:

e At the Value field, type a search value, such
as 01, for the lookup.

e In the Filter window, to delete a filter, select
<none> at a filter's Column field.

Italic font Indicates references to other manuals.
Example:

e For more information, refer to your
Installation and System Administrator's
Guide.
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Chapter 2

What's New in Version 2020

This chapter describes the enhancements added in Sage 100 2020. Global changes
are listed first, followed by module-specific changes, any updates to Office 365
integration, and then retired features.

Global

The following changes are carried throughout multiple modules.

Expanded Name Fields

The following fields have been expanded to 50 characters:

e Customer name

e Customer contact name
e \endor contact name

e Confirm to name

e Requested by name

The fields previously held 30 characters. Note that the field for vendor names was
expanded to 50 characters in a previous release.

>a. We're listening! This idea was a suggestion on the Sage 100 ideas site. Share
< your ideas and vote for your favorites at:
https://wwwb5.v1ideas.com/TheSageGroupplc/Sage100ERP

Expanded Fields for Address Information

The following fields have been expanded for customer, vendor, and employee
addresses:

e Address lines: from 30 to 40 characters
e City: from 20 to 30 characters
e Country name: from 30 to 50 characters

Changes for Telephone and Fax Fields
The following changes have been made for telephone and fax number fields.

e Telephone and fax number fields have been expanded from 17 to 20 characters.
e The telephone extension field has been expanded from 5 to 6 characters.

e A Type field has been added for customer, vendor, and contact telephone
numbers. You can select Work, Cell, Home, or Other.

e A Primary check box has been added for the two telephone number fields in
Customer Contact Maintenance and Vendor Contact Maintenance.
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Global

International Address Support

You can now enter an international address for customers, vendors, and contacts. To
support international addresses, the following changes have been made:

e The Country field has been moved above the address lines. A country code is
needed to ensure that the correct city and state or province is entered based on
the ZIP or postal code.

e ZIP Code fields have been renamed ZIP/Postal Code.

o State fields have been renamed State/Province.

e Telephone and fax number fields support international number formats.
e In Company Maintenance, the following changes were made:

o On the Main tab, the following fields were added: Country, ZIP/Postal Code,
City, State/Province.

o An Additional tab was added to this task. The federal and state tax ID number
fields were moved to this tab, and fields for contact information and a trade
name were added.

o On the Preferences tab, a Default Country Code field was added.

Maintenance Task for State and Province Codes

State/Province Code Maintenance has been added to the Library Master Setup
menu. State and province codes are maintained for each country code. You can
enter and maintain the state or province name, alternate code, and geocode. The
state and province codes for Canada and the United States are prepopulated.

Default Country Code

A Default Country Code field has been added to the Preferences tab in Company
Maintenance. The default code will be automatically used in data entry and
maintenance tasks, but it can be changed.

Data Conversion

When you convert your company data from an earlier version of Sage 100, USA will
automatically be entered as the default country code on the Preferences tab in
Company Maintenance.

Various Task Window Updates

To accommodate the expanded fields and longer field labels, some task windows
have been resized, and fields were rearranged on others. In some instances in
which the field is view-only, it may be truncated due to space constraints.

Report and Listing Updates

Reports and listings have been modified to accommodate updated fields and
formats. The longer customer and contact names are accommodated if they print on
a separate line or if there is enough space.
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Global

Form Updates

The expanded field sizes are reflected in the work tables, but the forms have not
been updated to accommodate the expanded fields.

The Country, City, State/Province, and ZIP/Postal Code fields added in Company
Maintenance have been added to the work tables, but they have not been added to
the forms. The forms still print the information in the four address lines that were on
the window prior to this release.

Country Code Selections Grid Option

A Country Code field has been added to the Selections grid for various form printing
tasks. For any source documents with no value in the Country Code field, the default
country code entered in Company Maintenance will be used for selection purposes.

Import Jobs

Any Visual Integrator import jobs that include address information must be modified
to include the CountryCode column, and it must be imported before the ZipCode
column.

Payroll Version

If you're using Sage 100 Payroll, you must upgrade to version 2.20.1. Earlier
versions have not been updated to support international addresses, and you will
encounter errors. More changes to support international addresses are planned for
Sage 100 Payroll 2.20.2.

~a. We're listening! This idea was a suggestion on the Sage 100 ideas site. Share
= your ideas and vote for your favorites at:
https://www5.v1ideas.com/TheSageGroupplc/Sage100ERP

Map Service Choices

You now have a choice of which map service to use when you click a Map button
next to address field. A Select Map Service field has been added to the following
locations:

e The Preferences tab in User Maintenance.
e The User Settings window accessed from the File menu.
You can select Bing Maps, Google Maps, or MapQuest.

Note: This feature is available if you purchased Sage 100 through a subscription
plan.

a7 We're listening! This idea was a suggestion on the Sage 100 ideas site. Share
= your ideas and vote for your favorites at:
https://www5.v1ideas.com/TheSageGroupplc/Sage100ERP

Export to Excel Button Added for List Boxes

An Export to Excel button allows you to export the contents of a list box to Microsoft
Excel. The button has been added for numerous list boxes throughout Sage 100.
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Desktop Utilities

As part of this enhancement, the related module option in Role Maintenance has
been renamed Allow Export to Excel from Lookups/Grids/Lists.

Add PIl Work Tables To Custom Reports

You can add multiple work tables that contain personally identifiable information (PII)
to custom reports. When running the Menu Wizard accessed through Report
Manager, if you're adding a custom report for which work tables that contain PIl are
available, you'll have the opportunity to add them. Note that users’ ability to view PII
is dependent on their role security. Currently only the General Ledger and Payroll
modules include work tables that contain PII.

Admin Rights Not Required for Workstation Synchronization

You no longer need administrative rights on your workstation to run the Workstation
Synchronization program that automatically starts after some Sage 100 updates are
installed on the server.

To eliminate the need for administrative rights, some files are now installed in a
different location. The Sage folder that was previously installed in this location:

C:\Program Files (x86)\Common Files
Is now installed in this location:

C:\Program Data

Desktop Ultilities

You can access two utilities from the Sage 100 Desktop File menu.

Customization Import

Use this utility to import custom settings if you were using the classic Desktop in an
earlier version of Sage 100 and made any of the following customizations:

e Added tasks to a public or private folder on the My Tasks tab
e Added tasks or shortcuts to other programs to the button bar

If you're using the latest version of Sage 100 on the same workstation as your earlier
version, the utility adds your public and private tasks and shortcuts to other
programs to the Favorites panel on the standard Desktop.

To start this utility, on the Desktop File menu, point to Desktop Utilities, and click
Customization Import.

Logging Level

Use this utility if asked to do so by Sage customer support. This utility was previously
accessed by browsing to the ..\MAS90\Launcher\ folder and double-clicking
launcher.logging.exe.

To start this utility, on the Desktop File menu, point to Desktop Utilities, and click
Logging Level.

Sage 100 2020 Customer Upgrade Guide Page 6



Accounts Payable

Links to Sage University Training

A Sage University button (ﬁ) has been added to additional task windows in the
Common Information and Library Master modules and to the Visual Process Flows
Manager window.

Click the button to view a list of training videos related to the task. Depending on
your Business Care plan, there may be no charge to watch the videos.

Accounts Payable

The following changes were made in the Accounts Payable module.

Encrypt PII for Inactive Vendors

As a means to comply with consumer privacy laws that require you to either delete
or deidentify personally identifiable information (PII) so that it can’t be used to
identify an individual, there are two ways to encrypt an inactive vendor’s PlII:

e An Encrypt button has been added to the Additional tab in Vendor Maintenance.

e An Encrypt Vendor Personally Identifiable Information utility has been added to
the Accounts Payable Utilities menu. You can use this utility to encrypt vendor PII
if the vendor’s record has already been deleted in Vendor Maintenance.

After Pll is encrypted, it no longer appears in task windows or reports. Furthermore,
the data cannot be viewed in Data File Display and Maintenance or accessed
through Visual Integrator or external reporting using an ODBC data source. For
more information, see Encryption for Inactive Vendors' Personally Identifiable
Information in the help.

Note: This feature is available if you purchased Sage 100 through a subscription
plan.

Reverse Check Run Utility

A Reverse Check Run utility has been added to the Accounts Payable Utilities menu.
You can use this utility to reverse an entire check run. Check runs are selected by
entering either a register number or a bank code and check number. Checks with a
type of Auto (a standard check) and Electronic that are posted to the cash
disbursements journal can be reversed.

Note: This feature is available if you purchased Sage 100 through a subscription
plan.

>a. We're listening! This idea was a suggestion on the Sage 100 ideas site. Share
* your ideas and vote for your favorites at:
https://wwwb5.v1ideas.com/TheSageGroupplc/Sage100ERP
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Accounts Payable

New Options for Retaining Paid Invoices
Two new fields have been added to the Additional tab in Accounts Payable Options:

e Months to Retain Paid Invoices (replaces Days to Retain Paid Invoices)
e Purge Paid Invoices During

You can enter a value ranging from 0 to 9,999 in the months field, and select
whether paid invoices are purged during period-end or year-end processing.

Note: These fields are available if you purchased Sage 100 through a subscription
plan; otherwise, you'll still have the Days to Retain Paid Invoices field.

>a. We're listening! This idea was a suggestion on the Sage 100 ideas site. Share
= your ideas and vote for your favorites at:
https://www5.v1ideas.com/TheSageGroupplc/Sage100ERP

1099-NEC Form Added

The IRS is introducing Form 1099-NEC, used to report nonemployee compensation,
for tax year 2020. Nonemployee Comp (to be used for Form 1099-NEC) is now
available to select in the following locations:

e Vendor Maintenance — Default Form field on Additional tab

e 1099 Payment History window — 1099 Form Type field

e A/P Invoice Data Entry — (1099 Payment) Form field on the Header tab
e Manual Check and Payment Entry — 1099 Form field on the Lines tab

Because From 1099-NEC is now used for nonemployee compensation, changes
have been made to Form-1099 MISC. Included in the changes, Box 7 is now used
for the Payer Made Direct Sales of $5,000 or More check box. (For more details on
the form changes, see the IRS website: www.irs.gov/instructions/i1099msc

In Vendor Maintenance, the Misc Box 9 check box has been renamed Payer Made
Direct Sales $5000+. This check box is now used for Box 7 on Form 1099-MISC.

If you've already recorded nonemployee compensation for tax year 2020 in Box 7,

a utility is available to move the totals to Box 1. Contact Sage Support for more
information.
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Accounts Receivable

Unlimited Cost Types in Open Invoice By Job Report

You are no longer limited to selecting only 12 cost types when printing the Open
Invoice by Jobs Report. In the Cost Types to Print section of the task window, the
check boxes for individual cost types have been replaced with a Select Cost Types
button. Click this button to open the Cost Type Selection window and select all cost
types needed for the report.

Relocation of Paperless Option in Vendor Maintenance

To access the Paperless Office Delivery Options window from Vendor Maintenance,
click the arrow in the top-right corner of the window, and then select Paperless
Delivery Options.

Accounts Receivable

The following changes were made in the Accounts Receivable module.

elnvoicing for Accounts Receivable Invoices

Through the elnvoicing feature that works with Paya Connect Desktop, you can send
your customers emails that include an invoice summary and a link for online
payments. Customers can use the payment link to make online credit card and ACH
payments. If you're using Paperless Office for invoicing, the invoice PDF is attached
to the email. After customers make online payments, you can import them into Cash
Receipts Entry.

There are two ways to enable elnvoicing for customers:

e To enable the feature for an individual customer, select the elnvoice Payments
check box on the Additional tab in Customer Maintenance.

e To enable the feature for a range of customers, use the Global Customer Field
Change utility.

An elnvoice Payments check box has been added to the Header tab in Invoice Data
Entry. The check box is selected by default if the elnvoice Payments check box in
Customer Maintenance is selected, but you can clear it as needed.

If the check box is selected, the invoice information is sent to Paya when the Sales
Journal is updated, and the email with the invoice information and Pay Now link is
then sent to the customer.

An elnvoice Payments button has been added to the Cash Receipts Deposit
window. Click this button to import online payments.

A merchant account with Paya (formerly Sage Payment Solutions) is required to use
elnvoicing. Paya will provide you with a user ID and API key, which you must enter in
System Configuration.

Next, enable the feature in Company Maintenance, and then you can enabile it for
customers in Customer Maintenance. For more information, see the elnvoicing
article in the Sage 100 help.
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Accounts Receivable

A utility, elnvoicing Error Log Viewer, has been added to the Accounts Receivable
Utilities menu. After you update the Sales Journal, a message lets you know if there
were any invoices that should have been sent to Paya Connect but were not. Use
the viewer to see which invoices were not sent, view error information, and send the
invoices to Paya Connect.

Note: This feature is available if you purchased Sage 100 through a subscription
plan.

Viewing Addresses in Invoice History Inquiry

In Invoice History Inquiry, the address no longer appears on the Main tab. Click the
new Addresses button to view the bill-to and ship-to addresses for the invoice.

New Options for Retaining Paid Invoices

Two new fields have been added to the Additional tab in Accounts Receivable
Options:

e Months to Retain Paid Invoices (replaces Days to Retain Paid Invoices)
e Purge Paid Invoices During

You can enter a value ranging from 0 to 9,999 in the months field, and select
whether paid invoices are purged during period-end or year-end processing.

Note: These fields are available if you purchased Sage 100 through a subscription
plan; otherwise, you'll still have the Days to Retain Paid Invoices field.

~a. We're listening! This idea was a suggestion on the Sage 100 ideas site. Share
= your ideas and vote for your favorites at:
https://www5.v1ideas.com/TheSageGroupplc/Sage100ERP

Encrypt PII for Inactive Customers

As a means to comply with consumer privacy laws that require you to either delete
or deidentify personally identifiable information (PII) so that it can’t be used to
identify an individual, there are two ways to encrypt an inactive customer’s PII:

e An Encrypt button has been added to the Additional tab in Customer
Maintenance.

e An Encrypt Customer Personally Identifiable Information utility has been added
to the Accounts Receivable Utilities menu. You can use this utility if the
customer’s record has been deleted in Customer Maintenance.

After Pll is encrypted, it no longer appears in task windows or reports. Furthermore,
the data cannot be viewed in Data File Display and Maintenance or accessed
through Visual Integrator or external reporting using an ODBC data source. For
more information, see Encryption for Inactive Customers' Personally Identifiable
Information in the help.

Note: This feature is available if you purchased Sage 100 through a subscription
plan.
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Custom Office

Relocation of Paperless Option in Customer Maintenance

To access the Paperless Office Delivery Options window from Customer
Maintenance, click the arrow in the top-right corner of the window, and then select
Paperless Delivery Options.

Custom Office

The following changes were made in the Custom Office module.

Improved Grid Customization

When you're editing a panel with a grid, right-clicking within the grid now opens the
Customize Grid Definition window. The appearance of the grid is virtually identical to
its appearance in Sage 100 task windows. As you edit the grid

e Drag and drop columns to rearrange them.

e If the panel has a primary and secondary grid, drag and drop columns to move
them from one grid to another.

e Click a column label to open the Column Properties window, which lets you
specify various properties, such the column length and description, and whether
it's locked.

e Click the Add Column button to add additional columns.

e Access the Bulk Hide window, which lets you set the Hidden option for all
columns in the grid.

Note: This feature is available if you purchased Sage 100 through a subscription
plan.

>a. We're listening! This idea was a suggestion on the Sage 100 ideas site. Share
= your ideas and vote for your favorites at:
https://www5.v1ideas.com/TheSageGroupplc/Sage100ERP

Apply Grid Customizations to a Customization Group

When selecting a customization group from the User list in the Customizer Panel
Selection window, you can now customize the grid(s) included in the panel. The
customized grids will be available to all users in the customization group.

Save UDF Changes in Pending Status

I's no longer necessary to choose between updating your user-defined field (UDF)
changes right away or discarding them. UDF additions and modifications are now
saved in a pending table. In the User-Defined Fields window, when you click Cancel,
a message will let you know that your changes have been saved. You can return to
the User-Defined Fields window at a later time to continue working on your changes
and update them when you’re ready.
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Inventory Management

A new task, Pending Changes Summary, has been added to the Custom Office Main
menu. You can also access this task by clicking the Summary of Pending Changes
button in User-Defined Field and Table Maintenance.

Use this task to view a list of pending changes. Click the Update All button to update
all changes. If you have changes for multiple tables, a message appears after each
table has been updated. You can click Continue to update the remaining tables or
click Stop to leave the remaining changes in pending status to be updated at a later
time.

When you have changes in pending status, a Pending folder appears beneath the
module list in User-Defined Field and Table Maintenance. Expand the folder to view
a list of tables with pending changes. You can select a table and click the Delete
Pending Changes button to delete all pending changes for the table.

You can schedule an update of the pending changes using Task Scheduler.

Note: This feature is available if you purchased Sage 100 through a subscription
plan.

Mask Information in Data Entry Fields

A Mask Display check box has been added to the Options tab in the Multi-Line
Definition window. Select this check box to display filled-in circles in place of the
actual characters when data is entered into this field.

Note that the data is not encrypted and it is masked only when displayed in task
windows. For example, the actual characters would appear if this field is added to a
lookup view or if you viewed the table in Data File Display and Maintenance.

A Mask Display check box has also been added to the Add/Edit Field window. If you
select this check box, the Mask Display check box in the Multi-Line Definition
window is selected by default when you add the UDF to a panel.

Inventory Management

The following changes were made in the Inventory Management module.

Expiration Dates for Lot and Serial ltems

Expiration dates can be added for items with lot or serial numbers when items are
received into inventory or produced through Bill of Materials. Expiration dates can be
manually entered, or you can enter settings to automatically calculate them. You can
also calculate sell-by, use-by, and return dates to determine how many days before
or after an item's expiration date it can be distributed.

Note: This feature is available if you purchased Sage 100 through a subscription
plan.

The expiration date feature must be enabled in Inventory Management Options, and
the related settings are entered in this task. However, you can override the settings
for product lines and individual items in Product Line Maintenance and Item
Maintenance.
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Inventory Management

For more information, see Set Up Expiration Dates for Lot and Serial ltems in the
Sage 100 2020 help.

Utility for Adding and Changing Expiration Dates

The Change Lot and Serial Expiration Dates utility has been added to the Inventory
Management Utilities menu. Use this utility to add expiration dates for existing items
and to change any expiration dates that have already been entered.

Note: Before using the utility, you must:
1 Enable the expiration date feature in Inventory Management Options.

2 For applicable items, select the Track Lot/Serial Expiration Date check box in the
Lot/Serial Expiration Settings window, accessed using the More button in ltem
Maintenance.

For more information, see Change or Add Expiration Dates for Lot and Serial Items
in the Sage 100 help.

Change Lot/Serial Expiration Date from Item Maintenance

To change expiration dates for lots or serial numbers one at a time, click the Change
Lot/Serial Expiration Date button, which has been added to the Cost Detail tab in
Iltem Maintenance.

Option to Exclude Expired ltems From Reorder Calculations

An Include All Expired Lot/Serial Items in Quantity Available check box has been
added to the following windows:

e Auto Reorder Selection (Purchase Order)
e Inventory Reorder Report (Inventory Management)

You can clear this check box to exclude expired items from the calculation of the
available quantity.

Forms, Reports, and Registers

A new report, Lot Serial Expiration Status Report has been added to the Inventory
Management Reports menu. Use this report to view a list of items' expiration dates.
You can also use the report to view a list of items that are missing an expiration date
or a list of items that are expired as of a specified date.

The expiration date is printed on the reports and registers listed later in this section if
the Track Lot/Serial Expiration Dates check box is selected in ltem Maintenance.

If applicable, the expiration date prints on the following registers:

e Bill of Materials registers:
o Production Register
o Disassembly Register

e Inventory Management registers:
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Inventory Management

o Transaction Register
o Physical Count Variance Register
o Count Card Variance Register

e Purchase Order registers:
o Receipt of Goods Register
o Return of Goods Register
o Material Requisition Register

If applicable, the expiration date is printed on the following reports:

e Bill of Materials reports
o Production History Report

e Inventory Management
o Inventory Detail Transaction Report
o Lot/Serial Transaction History Report

e Purchase Order

o Receipt History Report (if the Print Lot/Serial Information check box is
selected)

e Return Merchandise Authorization reports (if the Print Lot/Serial Information
check box is selected)

o Return Reason Report
o RMA Receipts History Report

e Sales Order reports (if the Print Lot/Serial Distributions check box is selected)
Shipping History Report

Open Sales Order Report

Open Sales Order by Item Report

Open Sales Order by Promise Date Report

Open Sales Order by Job Report

Lot and Serial Number History Report

0O 0O O o o o

The expiration date has been added to the worktables for the following forms to
make it easier to add the field to the forms if needed.

e A/R invoice (historical)

e B/M production label

e |/M receipts label

e PJ/O return order

e R/A customer RMA

e R/A RMA receiver

e S/O sales order
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Job Cost

e S/O picking sheet

e S/Oinvoice

e S/O packing list

~a. We're listening! This idea was a suggestion on the Sage 100 ideas site. Share

= your ideas and vote for your favorites at:
https://www5.v1ideas.com/TheSageGroupplc/Sage100ERP

Job Cost

The following changes were made in the Job Cost module.

Option for Expensing Work-In-Process Costs

A new field, Recognize WIP when Billing % Complete Jobs, has been added to the
Main tab in Job Cost Options. This field is available when the (Post to General
Ledger) Work in Process check box is selected.

There are two options available in this field:

e Select Actual Costs to expense WIP costs using actual costs posted to the job
that have not been previously billed as of the job billing date.

e Select % of Estimate to expense the WIP costs as cost of goods sold by
multiplying the revised estimated cost by the job's completion percentage less
the previously recognized estimated costs.

After converting company data from an earlier version of Sage 100, the default
selection is Actual Costs. For new companies, the default selection is % of Estimate.

If you change the selection in this field, and there are open jobs that have been billed
using the original method, the next time you process an invoice in which WIP is
accrued, that accrual will include a reversal for costs recognized when you were
using the previously selected WIP accrual method. Consider processing a
zero-dollar invoice after making the change to process the reversal.

Actual % Complete Field

A new field, Actual % Complete, has been added to the locations listed below so that
you can enter the job’s completion percentage when processing invoices for the job.

e S/O Invoice Data Entry Header tab

e Shipping Data Entry Shipping tab

This field is available if:

e The Job Cost module is integrated with Sales Order.

e In Job Cost Options, % of Estimate is selected in the Recognize WIP when
Billing % Complete Jobs field.
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Library Master

e In Job Maintenance, for the selected job, Percentage of Completed is selected in
the Acct Method field, and Fixed is selected in the Billing Method field.

A view-only Job No. field has also been added to the Shipping tab in Shipping Data
Entry.

elnvoicing for Job Cost Invoices

Through the elnvoicing feature that works with Paya Connect Desktop, you can send
your customers emails that include an invoice summary and a link for online
payments. Customers can use the payment link to make online credit card and ACH
payments. If you're using Paperless Office for invoicing, the invoice PDF is attached
to the email. After customers make online payments, you can import them into Cash
Receipts Entry.

An elnvoice Payments check box has been added to the Header tab in Job Billing
Data Entry. The check box is available and selected by default if the elnvoice
Payments check box in Customer Maintenance is selected, but you can clear it as
needed.

If the check box is selected, the invoice information is sent to Paya when the Job
Billing Register is updated, and the invoice is then emailed to the customer. For
more information, see the elnvoicing article in the Sage 100 help.

A merchant account with Paya (formerly Sage Payment Solutions) is required to use
elnvoicing. Paya will provide you with a user ID and API key, which you must enter in
System Configuration. Next, enable the feature in Company Maintenance, and then
you can enable it for customers in Customer Maintenance. For more information,
see the elnvoicing article in the Sage 100 help.

Note: This feature is available if you purchased Sage 100 through a subscription
plan.

Library Master

The following changes were made in the Library Master module.

Conversion Options

Two new options in the Convert Module Data Files window allow you to do more
when converting company data.

Convert SAP Crystal Reports

If you select the Convert SAP Crystal Reports check box, the custom reports and
forms for active modules are converted to the current level when you run conversion.

After the company data conversion is complete, anyone logged into Sage 100 can
continue working while the reports and forms are being converted.

The amount of time needed to convert company data is not affected by the SAP
Crystal Reports conversion.
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Update Custom Office Panels to Current Level

If you select the Update Custom Office Panels to Current Level check box, the
Custom Office panel update is run for any customized panels for the companies
being converted. This update runs without any prompts.

Purchase Order

The following changes were made in the Purchase Order module.

Apply Multiple Purchase Orders to An Invoice or Receipt

In Receipt of Invoice Entry and Receipt of Goods Entry, an Apply Purchase Orders
button has been added next to the Purchase Order Number field on the Header tab.
After selecting the first order for the invoice or receipt, click this button to add
additional orders.

Note: This feature is available if you purchased Sage 100 through a subscription
plan.

The first purchase order applied is considered the primary order. To add additional
orders, the information in the following fields must match:

Terms code

Sales tax schedule for purchase order
Sales tax schedule for purchase address
Shipping code (entered in Ship Via field)

Reports, Forms, and Registers

The documents listed below have been modified to display "Multiple" in the purchase
order number field if more than one order has been applied to the applicable
document.

Receipt of Goods Register
Receipt of Invoice Register
Daily Purchases Journal
Receipt History Report
A/P Invoice History Report

Inquiry Windows

In Receipt History Inquiry and A/P Invoice History Inquiry, "Multiple" appears in the
purchase order number field if multiple purchase orders were applied to the receipt
or invoice. You can click the Multiple Purchase Orders zoom button to view a list of
orders applied to the document.

In both inquiry windows, if multiple purchase orders with prepayments were applied
to the receipt or invoice, the total prepayment amount from all orders appears in the
prepayment field. You can click the Prepayments button to view a list of applied
purchase orders, along with the prepayment amount and check number.
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Sales Order

Landed Cost Calculation

If entry of landed cost is enabled in Purchase Order Options and Automatic Update
is selected for the FRGHT cost type in Landed Cost Maintenance, the landed cost
for all purchase orders applied to a receipt of goods is totaled and allocated to each
line item.

If entry of landed cost is not enabled, the freight amount for all orders applied to the
receipt is totaled and allocated to each line item based on the selection in the
Allocate Freight on a Line ltem Basis field in Purchase Order Options.

~a. We're listening! This idea was a suggestion on the Sage 100 ideas site. Share
= your ideas and vote for your favorites at:
https://www5.v1ideas.com/TheSageGroupplc/Sage100ERP

Sales Order

The following changes were made in the Sales Order module.

elnvoicing for Sales Order Invoices

Through the elnvoicing feature that works with Paya Connect Desktop, you can send
your customers emails that include an invoice summary and a Pay Now link.
Customers can click the Pay Now link to make online credit card and ACH
payments. If you're using Paperless Office for invoicing, the invoice PDF is attached
to the email. After customers make online payments, you can import them into Cash
Receipts Entry.

An elnvoice Payments check box has been added to the Header tab in Invoice Data
Entry. The check box is available and selected by default if the elnvoice Payments
check box in Customer Maintenance is selected, but you can clear it as needed.

If the check box is selected, the invoice information is sent to Paya when the Sales
Journal is updated, and the invoice is then emailed to the customer. For more
information, see the elnvoicing article in the Sage 100 help.

A merchant account with Paya (formerly Sage Payment Solutions) is required to use
elnvoicing. Paya will provide you with a user ID and API key, which you must enter in
System Configuration.

Next, enable the feature in Company Maintenance, and then you can enable it for
customers in Customer Maintenance or by using the Global Customer Field Change
utility. For more information, see the elnvoicing article in the Sage 100 help.

Note: This feature is available if you purchased Sage 100 through a subscription
plan.
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Visual Integrator

Visual Integrator

The following changes relate to the Visual Integrator module.

Change for Import Jobs that Include Addresses

Any import jobs that include address information must be modified to include the
CountryCode column, and it must be imported before the ZipCode column. This
requirement is related to changes made to support international addresses. For
more information, see International Address Support on page 4.

Office 365 Integration

A new screen has been added to the Sage 100 Office Configuration wizard. On the
Microsoft Power Apps and Power Automate screen, if you select the check box, the
information needed to create a custom connector appears on the last page of the
wizard.

The same information is automatically copied to the Windows clipboard so that you
can paste it into a document to reference when setting up your custom connector.
This is required if you plan to use Power Automate or Power Apps that work with
your Sage 100 data.

Retired Features

The following features are no longer available in version 2020.

Classic Desktop

The classic version of the Sage 100 Desktop is no longer available. To learn more
about the standard version of the Desktop, refer to the following resources:

e To watch a video providing an overview of the standard Desktop, click the Help
tab at the top of the Desktop, and then click Tour the Desktop.

e To read detailed instructions on using and customizing the Desktop, see chapter
2, Touring the Software, in the Getting Started Guide.

To view this guide, click the Web Content tab at the top of the Desktop, click
Resources, and then click Getting Started Guide. If the guide is opened in the
embedded browser, you can right-click the tab and then select Open in new
window.

If you were using the classic Desktop and had created public or private tasks or
customized the button bar, you can run a utility to add those tasks and/or programs
to the Favorites panel in the standard Desktop. For more information, see
Customization Import on page 6.
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Chapter 3

Changes in Version 2019

This chapter describes the changes made in the Sage 100 2019 release and the
subsequent updates for that version. Installation and global changes are listed first
followed by module changes, third-party features, and then retirements.

Global

Global changes are carried throughout multiple modules.

The following changes were made in version 2019.2.

Automatic Update of Daily Transaction Register

A security event has been added to Role Maintenance that allows you to
automatically update the Daily Transaction Register. For any series of journal and
register updates that concludes with the Daily Transaction Register, you will not
receive a prompt to print and update the register if the security event check box is
selected for your role. The Daily Transaction Register will be printed and updated
automatically.

The security event has been added for the following modules:

Accounts Payable
Accounts Receivable
Bank Reconciliation
Bill of Materials
Inventory Management
Job Cost

Purchase Order

Sales Order

Work Order

0O 0O 0O 0 0O o 0o 0 o

Warning Message for Document Dates

A Use Document Date Warning check box has been added to the Preferences tab in
Company Maintenance. After selecting this check box, you can enter a value in one
or both of the following fields:

e Document Date - Prior Periods to Allow Outside of Current Period
e Document Date - Future Periods to Allow Outside of Current Period
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These values are compared to the current period entered in the module's Options
task to determine when a date falls outside of the valid date range. Alternately, in Bill
of Materials, Inventory Management, Purchase Order, Return Merchandise, and
Sales Order, the values are compared to the current calendar month and year if
Calendar Months is selected in the Base Inventory Periods On field in Inventory
Management Options.

If you start to create a document with a date that falls outside of the valid range,
you'll receive one of two messages:

e If you're using the default date for that session, a warning message appears, and
you can click OK to continue.

e If you manually enter the date, a warning message asks if you want to proceed. If
you click Yes to continue with the date entered, a record is written to the Activity
Log.

If you import records with a document date falling outside of the specified range
through Visual Integrator, a warning is written to the Import Log.

Document dates are checked in the following tasks:

e Bank Reconciliation:
o Reconcile Bank
o Check Deposit and Adjustment Entry
e Bill of Materials
o Disassembly Entry
o Production Entry
e Accounts Payable
o Invoice Data Entry
o Repetitive Invoice Selection
o Manual Check and Payment Entry
e Accounts Receivable
o Invoice Data Entry
o Cash Receipts Deposit
o Repetitive Invoice Selection
e Inventory Management
o Transaction Entry
e Job Cost
o Job Billing Selection
e Purchase Order
o Material Requisition Issue Entry
o Purchase Order Entry
o Receipt of Goods
o Receipt of Invoice Entry
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o Return of Goods
e Return Merchandise Authorization
o Generate Transactions
o RMA Entry
o Receipts Entry
e Sales Order
o Sales Order Entry
o Invoice Data Entry

Note: This feature is available if you purchased Sage 100 through a subscription
plan.

Links to Sage University Training

A Sage University button (with a graduation cap icon) has been added to additional
Purchase Order and Sales Order task windows. Click the button to view a list of
training videos related to the task. Depending on your Business Care plan, there
may be no charge to watch the videos.

The following changes were made in version 2019.1.

View Paperless Documents from Journal Drill Down Window

A Paperless Viewer button has been added to the Journal Drill Down window. If
you've set up Paperless Office and have the appropriate security setup, you can
click the button to open the Journal and Register Viewer. The button is available
when you access the Journal Drill Down window from the following tasks:

° A/P Invoice History Inquiry

° A/P Payment History Inquiry

° A/R Invoice History Inquiry

° G/L Account Maintenance/Inquiry
° G/L Source Journal Maintenance
° I/M Item Maintenance/Inquiry

° P/O Receipt History Inquiry

Links to Sage University Training

A Sage University button (with a graduation cap icon) has been added to additional
task windows. Click the button to view a list of training videos related to the task.
Depending on your Business Care plan, there may be no charge to watch the
videos.
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The following changes were made in version 2019.

Auto-Complete for Account Numbers

The auto-complete feature has been added for general ledger account number
fields. You can now search for an account by entering any of the following in an
account number field:

e Account number

e Main account

e Account description
e Account group

As you type, a list of accounts matching your entry appears, and you can select one
from the list.

This feature is automatically enabled for all users. You can disable the feature for
individual users in Library Master > User Maintenance.

To enable this feature, run the Build Search Index utility on the Library Master
Utilities menu to create an index. As you add accounts, you’ll need to run the utility
again to index the new records.

Print Status Updated When Using Keep Open Check Boxes

In the tasks listed below, when you print a document while the Keep Window Open
After Print or Keep Window Open After Preview check box is selected, the
document’s print status will reflect that the document has been printed. Previously
the document’s print status would have been set to not printed.

e Invoice Printing (Job Cost)

e Purchase Order Printing

e Return Order Printing

e Sales Order Printing

e Picking Sheet Printing

e Shipping Label Printing

e Invoice Printing (Sales Order)

Security Update for E-mail Delivery

Transport Layer Security (TLS) 1.2 is now supported when sending e-mails through
Paperless Office and eBusiness Manager.

Message Enhancements
Some message windows now have a More Info link. When you click this link, you will
see another message with additional information or a related help article.

When you're opening a task and a message appears indicating that a file is locked,
you can click More Info to see who has the file locked and in which task.
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Copy Feature for Custom Lookup Views

A Copy button has been added to the User Lookup Wizard. You can now copy a
custom lookup for other companies and users. Also, selecting companies and users
is now easier—check boxes have been added to the company and user list.

Links to Sage University
A Sage University button (with a graduation cap icon) has been added to additional
task windows.

You can click the button to view a list of training videos related to the task.
Depending on your Business Care plan, there may be no charge to watch the
videos.

The Sage University button has been added to the tasks windows listed below.

e Accounts Payable
o ACH Maintenance
Expense Distribution Table Maintenance
Invoice Payment Selection
Repetitive Invoice Selection

O O O o

Vendor Maintenance

e Accounts Receivable

Cash Receipts Entry
Commission Edit Maintenance
Customer Maintenance
Invoice Printing

Repetitive Invoice Entry
Repetitive Invoice Selection

0O O O 0O 0 O o

Salesperson Maintenance

e Bank Reconciliation
Auto Check Reconciliation

[e]

o Bank Code Maintenance
o Check, Deposit and Adjustment Entry
o Positive Pay Export

e General Ledger
o Transaction Journal Entry

e Job Cost
o Contractor Maintenance
o Job Maintenance
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e Library Master
o Activity Log

Payroll Module Removed from Installation Program

The Payroll module is no longer part of the Sage 100 installation program. To install
the module, use the standalone installation program. For information on installing the
Payroll module, see the Sage 100 Payroll Installation and Upgrade Guide. The guide
is available online at:
http://cdn.na.sage.com/docs/en/customer/100erp/Documentation.htm

Custom Office

You can now customize the columns and buttons on the following Paperless Office
viewers:

e Journal and Register Viewer

e Period End Report Viewer

e Report Viewer

General Ledger

The following changes were made in the General Ledger module.

Consolidate Journal Entries in General Journal PDF

When printing the General Journal and selecting PDF output, you can now
consolidate all General Journal entries into one PDF. A module option, Print Multiple
PDFs for General Journal, has been added in Role Maintenance. Clear the check
box for this option to consolidate the entries.

Account Appears on All Pages of Detail Reports

The account number and description are now printed on each page of the General
Ledger Detail Report and General Ledger Detail by Source Report.

Encrypted Bank Information
Bank descriptions and account numbers are now encrypted. Bank descriptions are
still visible in windows and on reports and forms.

A new security event, “Allow Viewing, Printing and Editing of Highly Sensitive
Personally Identifiable Information,” determines whether users will be able to view
and print bank account numbers.

For more information, see Additional Security for Bank Information in the help.
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Inventory Management

The following changes were made in the Inventory Management module.

Option to Include Inactive Items in Physical Count

An Include Inactive Items check box has been added to the Physical Count
Worksheet task window. If you select this check box, inactive items are printed on
the worksheet and included in Physical Count Entry and on the Variance Register. If
the check box is cleared, inactive items are excluded from the physical count
process.

Option to Print Variances Only

An Only Print Variances on Register check box has been added to the Physical
Count Variance Register task window. If you select this check box, all items for which
there is no variance are omitted from the register.

Item Quantity Inquiry Button in Physical Count Entry

An Item Quantity Inquiry button has been added to the Lines tab in Physical Count
Entry. Click this button to view quantity information for the selected item.

You can click the arrow next to this button and select Item Inquiry to open the Item
Inquiry window, or select ltem Memo to view, create, or maintain memos for the
selected item.

Note: To see the Item Memo option, it must be enabled in Memo Manager
Maintenance:

1 Select Inventory Management > Setup > Memo Manager Maintenance.

2 In the Memo Type field, select Item.

3 Selectarole.

4 To add Physical Count Entry to the Task list, click the Reset All to Defaults button.

5 For Physical County Entry, in the Memo option column, select Show or Maintain.

Library Master

The following changes were made in the Library Master module.

Data File Display and Maintenance
Data File Display and Maintenance has been upgraded with several new features.

e If you're using Sage 100 Premium, you can now access files stored in a SQL
database.

e To select a file in the File Name field, you can enter the company code, followed
by a colon, followed by the file name. For example: ABC:AR_Customer
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For files in modules upgraded to Business Framework, the Data File Display and
Maintenance — Edit window now lists all fields and values in a grid.

Encrypted fields are not available to edit, but you can select the Allow Read-Only
Fields to Be Changed check box to edit the read-only fields.

Validation is now performed on date and numeric fields.

For multi-segment keys, the key scan filter allows you to filter the records using
one or more segments of the key. Enter the selected key column separators as
needed to indicate which segments of the key your search criteria must match.

For example, the key for customer records is ARDivisionNo:CustomerNo. To
search for customer number 02-CAPRI, you can enter the following in the Key
field:

:CAPRI

Alternately, you can select a different character to separate the segments of the
key in the Key Column Separator field. If you select the tilde (~) character, you
can then search by entering the following in the Key field:

~CAPRI

Note that you don’t need to enter the full value contained in the segment.
Continuing with the above example above, you could also enter the following:

~CAP

You can filter by multiple segments. For example, to view records in the
GL_DailyPosting file from 2018 with AP as the source journal, enter the following
in the Key field:

2018:AP

For modules that have been upgraded to Business Framework, you can click
Add to add a record.

If you adjust the width of the Data File Display and Maintenance — Key Scan
window, and then close the window to run a second scan, the window reopens at
the width that you used previously. The Key and Data columns are automatically
adjusted to fill the width of the window.

In the Data File Display and Maintenance — Key Scan window, when entering
search criteria in the Search field, you can use a special character to define the
scope of the search:

o To search for text in any location within the current key, add an asterisk (*) at
the beginning of your search text. For example: *14072

o To search for text within the current key and the data record, add a percent
symbol (%) at the beginning of your search text. For example: %14072

The Print button has been removed.
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When starting Data File Display and Maintenance using the Run Program window
accessed on the File menu, you can now enter SY_FileDisplay_UI.

Activity Log

The following changes have been made to the Activity Log:

Changes made in Role Maintenance and User Maintenance are now tracked. A
new activity type, Security, has been added and is used to categorize these
changes.

You now have the option to track changes in Company Maintenance and System
Configuration. For more information, see Activity Log Configuration Window on
page 28.

To improve performance, there is now a configurable limit on the number of
records that display when you open the Activity Log window. If the number of
records in the log file exceeds this threshold, the Activity Log / window
automatically opens before any records are loaded. Use the Activity Log - Filter
window to filter the records and then view them in the Activity Log window.

To change the auto-load threshold, click the Configure button on the Activity Log
window.

A Cancel button is now available while the progress bar indicates that records
are loading so that you can cancel the process if needed.

A Refresh button has been added to the window. Click this button to reload the
records, including any new ones created after you started the session.

The newly added first column in the grid contains an asterisk (*) if a log file is
available for the record.

The Purge button now appears below the list of records. Also, a purge utility has
been added to the Utilities menu. For more information, see Activity Log Purge
Utility on page 29.

When purged, records are either deleted or added to an archive file based on
settings in the Activity Log Purge Configuration window, which is described on
page 29.

You can view purged records stored in an archive file by clicking the History
button and, in the Select Archive Year window, selecting a year. Archived records
from that year are then displayed in the Activity Log window.

Activity Log Configuration Window

The Activity Log Configuration Window, accessed by clicking the Configure button in
the Activity Log window, allows you to set various options. You can use this window

to:

Control how many records are loaded by default, either by entering a value or
setting a date range.
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e Specify whether to track changes made in Company Maintenance and System
Configuration.

e Specify how data is purged.
e Specify what information is recorded when errors occur in Sage 100.

For more information, refer to the on-screen help that appears at the bottom of the
configuration window when you click one of the rows.

Activity Log Purge Utility

You can use the Activity Log Purge utility to purge records from the Activity Log file.
To access the utility:

e Click the Purge button on the Activity Log window.
e Select the task on the Library Master Utilities menu.

When purged, records are either deleted or added to an archive file based on
settings in the Activity Log Purge Configuration window, which is described in more
detail in the next section. You can schedule automatic purges using Task Scheduler.
Archive files are stored here: ..\MAS90\MAS_System\Archive

Activity Log Purge Configuration Window

Click the Activity Log Purge Configuration button to open the configuration window.
Use this window to control how many records are loaded by default and specify how
data is purged.

Note that the default setting for the Minimum Days to Keep field is 365; therefore, the
Records to Purge list may be empty when you initially start the utility.

Activity Log Filter Window

The Activity Log Search window has been renamed Activity Log Filter. In addition,
the following changes have been made:

e You can filter records by company code and module code.
e You can enter search text to filter records by the text in the Description column.

e File Display/Maintenance and Visual Integrator have been added as options to
filter records.

Activity Log Report
The following changes were made to the Activity Log Report task window:
e An Archive Year field has been added to the Activity Log Report. If you have

archived records, you can select a year in this field, and only the archived
records from that year are included in the report.

To include unarchived records on the report, select Current Activity in the Archive
Year field.
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e You can filter the report by module using the Module Code fields in the
Selections grid.

User ID Field Expanded

The User ID field on the E-mail tab in Company Maintenance has been expanded to
hold 254 characters.

Keep Window Open Check Box in Rebuild Key Files

A Keep Window Open check box has been added to the Rebuild Key Files window.
If you select this check box, the window remains open after you rebuild files, but the
company, module, and file selections are cleared.

Paperless Office

The following changes were made in the Paperless Office module.

Text Formatting Options for Messages

A new message editor has been added to Electronic Delivery Message Maintenance
and to the Edit Message window accessed through the Customer, Employee, and
Vendor Viewer windows. The editor features a tool bar with text formatting options,
including the ability to:

e Change the text color, font, and size
e Use bold or italic text

e Create bulleted and numbered lists
e Insert links and images

Square Brackets Replace Angled Brackets for Merge Fields

Previously the merge fields were enclosed in angled brackets (< >). However, the
new message editor is HTML based, and angled brackets are reserved for a specific
purpose in HTML. Therefore, square brackets ([ ]) are now used to enclose the
merge fields.

If you have existing messages that contain merge fields in your earlier version of
Sage 100, the angled brackets will be replaced with square brackets when you
convert your data. For example, <DocumentNo> will be converted to [DocumentNo].

If you have message fields that contain an angled bracket that is not being used to
enclose a merged field, the bracket is not converted, and an entry is written to the
Conversion Log.

Angled brackets used for merge fields in the Subject field are also converted, but the
Subject field does not support formatted text; only plain text is allowed.

Be sure to test any messages that were saved in your prior version of Sage 100 after
converting your data.
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Size of Message Field Increased

The message field holds 7168 characters, increased from 4096. However, the
special characters used in the HTML code count toward this limit.

New Merge Fields

Three new merge fields have been added in Electronic Delivery Message
Maintenance:

e [CustomerPoNo] for sales orders and Accounts Receivable and Sales Order
invoices

e [InvoiceDueDate] for invoices
e [ShipDate] for sales orders and Sales Order invoices

The merge fields are available depending on which module and document is
selected.

Also a Copy Merge Field to Clipboard button has been added to the window. Click
this button to copy the selected merge field to the Windows clipboard and then paste
it in multiple locations.

Cc and Bcc Options for E-mail Address

You can now specify whether the e-mail addresses used when e-mailing documents
are added to the To, Cc, or Bcc field when e-mails are sent.

In the locations listed below, a Recipient field has been added; use this field to select
To, Cc, or Bcc.

e Paperless Office Delivery Options (accessed from Customer Maintenance and
Vendor Maintenance)

e Electronic Delivery (accessed from the customer, employee, and vendor
viewers)

e Paperless Office Selection (accessed from all reports supported by Paperless
Office)

When converting data, To is automatically selected in the Recipient field for the
existing e-mail addresses.

In the Paperless Office Delivery Options window accessed through Employee
Maintenance, the E-Mail Address field has been relabeled as the To field, and Cc
and Bcc fields have been added. When converting data, existing e-mail addresses
are added to the To field.

E-mail addresses entered in the Cc and Bcc fields are included in the customer,

employee, and vendor listings if the option to print Paperless Office delivery options
is selected.
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Additional Attachments When Emailing Forms

In the Electronic Delivery for Forms window, you can now select additional
attachments to include when emailing forms. You can select multiple attachments,
and there is no restriction on the file type.

PDF File Name Options

A PDF File Name field has been added in Form Maintenance. In this field, if you
select Document No., the document number is used as the file name for the PDF
that is attached to the email. The full description is still used for the PDF file that is
stored in the PDF directory.

If you select Full Description, the file name will vary depending on the document
type. The file naming convention for this option is the same that was used in earlier
versions of Sage 100.

Option to Copy Salespeople When E-mailing Forms

A Paperless button has been added in Salesperson Maintenance. Click this button
to open the Electronic Delivery Options window and specify whether the salesperson
will receive a copy of orders, invoices, and statements when they are e-mailed to
customers from data entry, inquiry, and history tasks.

Search by Posting Date in Journal and Register Viewer

A Posting Date column has been added to the list box in the Journal and Register
Viewer. When you click the Search button, you can include a posting date or range
of posting dates in the search criteria.

Updated Printer Driver

The Amyuni PDF Converter, the virtual printer driver used to create PDF documents,
has been updated to version 6.0.1.1.

Purchase Order

The following changes were made in the Purchase Order module.

Change for Drop-Ship Purchase Orders

In Purchase Order Entry and Receipt of Invoice Entry, if Drop Ship is selected in the
Order Type field, the Work Order field on the Lines tab is not available.

When copying from a purchase order in Purchase Order Entry, if Drop Ship is
selected in the Order Type field for the new purchase order, no history or work order
information is copied from the source document.

Data Conversion

When converting your data after upgrading to version 2019, work order fields for
drop-ship inventory lines and the corresponding history detail lines are cleared in
purchase order and receipt of invoice records. History detail records that do not have
corresponding data entry records are not affected.
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Sales Order

The following changes were made in the Sales Order module in version 2019.1.

Add Tracking Number to Email Messages

In Electronic Delivery Message Maintenance, when you're creating a message for a
Sales Order invoice, you can add the tracking number to the subject or the body of
the message. To add the tracking number, insert the new TrackingNo merge field.

If you add the tracking number to the subject, they are displayed in plain text and
multiple tracking numbers are separated by commas. In the body of the message,
the tracking numbers are links that the recipient can click to track the shipment.
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Chapter 4

Changes in Version 2018

This chapter describes the changes made in the Sage 100 2018 release and the
subsequent updates for that version. Installation and global changes are listed first
followed by module changes, third-party features, and then retirements.

Global Changes in 2018.4

The following changes were made throughout Sage 100 in version 2018.4.

Links to Sage University

A Sage University button (with a graduation cap icon) has been added to several
task windows.

You can click the button to view a list of training videos related to the task.
Depending on your Business Care plan, there may be no charge to watch the
videos.

The Sage University button has been added to the tasks windows listed below.

e Accounts Payable:
o Invoice Data Entry
o Manual Check and Payment Entry
o Check Printing and Electronic Payment
o Period End Processing
e Accounts Receivable Invoice Data Entry
e Bank Reconciliation Reconcile Bank
e General Ledger General Journal Entry
e Payroll:
Check Printing
Deduction Code Maintenance
Employee Maintenance
Payroll Data Entry
Punch In/Out
Tax Profile Maintenance
Time Off Maintenance

O O 0O o 0o 0O o o

Time Track Entry
e Purchase Order Return of Goods
e Sales Order Invoice Data Entry
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Global Changes in 2018.3

The following changes are carried throughout multiple modules in version 2018.3.

Reset Button for Period End Report Selection

A Reset Default Reports button has been added to the Period End Report Selection
window in all modules in which this window is present. Click the button to reset the
report list to its original settings.

Improved Navigation in Calendar Window
The following changes have been made to the Calendar window:

e The last day(s) of the prior month are displayed when the first week of the month
doesn’t begin on a Sunday. Also the first day(s) of the next month display when
the last week of the month doesn’t end on a Saturday.

e Pressing the up arrow key moves focus to the same day of the previous week.
Pressing the down arrow key moves focus to the same day of the next week.

e When focus is on the first day of the month, pressing the left arrow key displays
the prior month. Pressing the Page Up key does the same. When focus is on the
last day of the month, pressing the right arrow key displays the next month.
Pressing the Page Down key does the same.

Global Changes in 2018

The following changes are carried throughout multiple modules in version 2018.

Spell Checking

An in-line spell checker has been added. Misspelled words are underlined, and you
can right-click them to open a menu with the following options:

e Select a replacement for the misspelled word

e Add the word to your personal dictionary so that it will no longer be shown as
misspelled. This does not affect other users.

e Ignore all instances of the misspelled word. The word will not be shown as
misspelled as long as the current session of the task remains open.

The spell check feature has been added in the following locations:

e Memos

e Messages that print on forms, such as invoices, statements, and checks
e Paperless Office Electronic Delivery windows

e Comments

e Notes in Customer Contact Maintenance and Vendor Contact Maintenance
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e E-mail Notification Maintenance (accessed from eBusiness Manager)
e Test E-Mail and Test Fax subject fields (accessed from Company Maintenance)
e Broadcast Message (accessed from Master Console)

When adding a multi-line user-defined field (UDF) to a screen, you can select
whether to enable spell check.

Updated Desktop

The following changes have been made to the Sage 100 Desktop.

Option to Minimize the Desktop

A Toolbar Mode button has been added to the top-right corner of the Desktop. Click
this button to minimize the Desktop. You will then see only the tab labels for the
ribbon and the status bar. When you click a tab label, the full ribbon is displayed until
you make a selection.

When the Desktop is minimized, you can click the Expand the Ribbon button next to
the Toolbar Mode button to keep the full ribbon in view even after making a selection.

If you start an application, such as Sage Payment Center, that runs in the embedded
browser, the Desktop will be automatically expanded.

Web Content
e A Web Content tab has been added to the ribbon.

e An Open in New Window check box has been added to the Link window that
appears when you add a new link or edit an existing one. If you select this check
box, the web page will open in your default browser instead of the browser
embedded in the Desktop.

Navigation Buttons for Embedded Browser
Forward and Back navigation buttons have been added for the embedded browser.

SAP Crystal Reports 2016

SAP Crystal Reports 2016 for Sage (version 2016SP04) now ships with Sage 100.
The following new features are included in this version:

e Conditional formatting of boxes and lines, including the ability to conditionally
suppress

e Vertical text alignment at Top, Middle, or Bottom

e A GetValueDescriptions function to display parameter value descriptions in your
report layout

e Direct data access for SQL Server 2014

Important: You must uninstall earlier versions of SAP Crystal Reports before
installing SAP Crystal Reports 2016 for Sage.
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For Sage Fixed Assets Customers

If you have Sage Fixed Assets installed on the same computer as Sage 100 2018,
you may receive an error when trying to preview reports in Sage Fixed Assets. The
error occurs because the two programs use a different version of the SAP Crystal
Reports runtime engine.

An upcoming release of Sage Fixed Assets will resolve this issue. For information on
how to resolve the issue in your current version of Sage Fixed Assets, see article ID
86606 in the Sage Knowledgebase:
https://support.na.sage.com/selfservice/viewdocument.do?externallID=86606

Service Notification Maintenance

A new task, Service Notification Maintenance, has been added to the following
locations:

e Library Master Main menu.
e Payroll Setup menu

Use this task to manage who will receive e-mails related to Sage services. E-mails
are sent to let you know about scheduled maintenance, unplanned outages, or other
events that affect your ability to use the service.

Currently the only service available is the Payroll Tax Calculation Engine, but
additional services may be added in the future. Until you designate at least one
person to receive service notifications, a message appears each time anyone
accesses the Payroll module alerting them that a user must be set up in Service
Notification Maintenance.

Installation Changes in 2018.1

The following change was made in version 2018.1.

Workstation Synchronization Update for Sage 100 Standard

The Workstation Synchronization program has been enhanced to update Sage 100
Standard workstations when you install a product update.

Accounts Payable Changes in 2018.2

The following changes were made in the Accounts Payable module in version
2018.2.

Search Invoice History from Vendor Maintenance

In Vendor Maintenance, you can open the new Invoice History Inquiry window by
clicking the arrow button in the top-right corner of the screen and then clicking
Invoices Inquiry. The window lists invoices and shows the invoice number, date,
amount, purchase order number, order date, and ship-to location code.
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From the Invoice History Inquiry window, you can:

e Select an invoice and then click the Zoom button to view invoice details in the
Invoice History Inquiry window.

e Click the Search button to search for invoices by the invoice number, date,
purchase order number, and ship-to location code.

Accounts Payable Changes in 2018

The following changes were made in the Accounts Payable module in version 2018.

Form 1099 Tax Reporting

The 1099 eFiling and Reporting task has been renamed Form 1099 Tax Reporting.
Also, the Minimum YTD Payment field has been replaced with a Minimum YTD
button. Click this button to open the Minimum YTD Payment window and enter the
minimum payments for the corresponding Form 1099 boxes.

Accounts Receivable Changes in 2018

The following changes were made in the Accounts Receivable module in version
2018.

Fields Added to Pay Cycle Window

As part of the enhancements to the Payroll module, the following fields have been
added to the Pay Cycle window that appears when updating the Commission Edit
Register:

e Period Starting Date

e Check Date

Bank Reconciliation Changes in 2018.5

The following changes were made in the Bank Reconciliation module in version
2018.5.

Sage Bank Feeds

Sage Bank Feeds simplifies the process of reconciling your bank statements by
importing bank transactions into Check, Deposit, and Adjustment Entry and
matching them against Sage 100 transactions.

You can connect your banks to Sage Bank Feeds in Bank Maintenance when you
access the task through the Bank Reconciliation menu. A wizard walks you through
the process. Note that the wizard will need your ZIP Code; therefore, you must enter
one on the Registration tab in System Configuration before connecting a bank.

To learn how to connect a bank, see Connect a Bank to Sage Bank Feeds in the
help.
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For information on how transactions are matched, see the help for Check, Deposit,
and Adjustment Entry.

Bill of Materials Changes in 2018.3

The following changes were made in the Bill of Materials module in version 2018.3

Update Changes to Miscellaneous Charge Items

A new field, Sync Misc Charge Changes with Bill Tables, has been added to Bill of
Materials Options. There are three options for updating bills with changes made for
miscellaneous change items in Miscellaneous Item Maintenance:

e Select Yes to update bills with the changes made in Miscellaneous Item
Maintenance.

e Select No if you do not want to update the bills.

e Select Prompt to receive a message when you update a field for a charge item in
Miscellaneous Item Maintenance asking if you want to update the field in Bill of
Materials.

Changes are updated only if the content in Bill of Materials matches the content that
was in Miscellaneous ltem Maintenance before the change was made. If you're
using revisions, all revisions are updated with the change.

Business Insights Dashboard Changes in 2018

To protect sensitive employee information, the Workforce Statistics option has been
removed from Business insights Dashboard in version 2018.

Credit Card Processing Changes in 2018.4

Processing payment cards with EMV chips through Paya (formerly Sage Payment
Solutions) is supported when using the following card readers:

e Ingenico ipp320
e Equinox L5300

The supported device list is subject to change. Please see the Integrated Solutions
Compatibility Matrix for the latest information. You can find the matrix in the Sage
Knowledgebase. See article ID 48274:
https://support.na.sage.com/selfservice/viewdocument.do?noCount=
true&externalld=48274
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Before processing payments with chip cards, you must update your settings in Sage
Exchange Desktop:

1 In the Windows system tray, right click the Sage Exchange 2.0 icon and then
click Settings.

2 In the Sage Exchange - Settings window, under Hardware, select EMV Devices.
3 Select your card reader device.
4 Select the Generate EMV receipts check box.

A PDF receipt will be generated after processing a payment in the Sage Exchange -
Authorization window.

Custom Office Changes in 2018.3

The following changes were made in the Custom Office module in version 2018.3.

Calculator Option for Numeric Fields

A Calculator check box has been added to the Multi-Line Definition window. Select
this check box to include the Calculator button next to the field. The check box is
available for numeric fields only.

Buttons Appear in Screen Editor

In the Customizer screen editor, Calendar, Calculator, and Lookup buttons now
appear as they do when using the screen in Sage 100.

Ability to Exclude UDFs from Selection Grids

An Exclude from Report Selection check box has been added to the Add Field and
Edit Field windows. Use this check box when adding a user-defined field (UDF) to a
table for a main entity, such as AR_Customer, to exclude the UDF from selection
grids for reports that use the table.

Inventory Management changes in 2018.3

The following changes were made in the Inventory Management module in version
2018.3.

Item Images Open in Windows Photo Viewer

In Item Maintenance and Item Inquiry, when you click the Show Image button, the
image now opens in Windows Photo Viewer. You can then email the image, copy it
to the Windows clipboard, and adjust the zoom level.
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Inventory Management Changes in 2018

The following changes were made in the Inventory Management module in version
2018.

Warehouse Status Field in Warehouse Code Maintenance

A Status field has been added to Warehouse Code Maintenance. The three status
options are Active, Inactive, and Restricted.

Inactive Warehouse Status

The Inactive status is intended for warehouses that are no longer in use. If a
warehouse status is Inactive, you cannot select the warehouse in any data entry
tasks.

A warehouse cannot be set to inactive if there is a record of inventory in the
warehouse or if the warehouse is used in data entry or maintenance records, such
as an open sales order or a ship-to address. If you try to change a warehouse status
to inactive while the warehouse is in use, a message appears letting you know that
the warehouse cannot be set to inactive. You can click the Details button in the
message windows to see a list of records in which the warehouse is used.

Display Inactive Warehouse in Lookup Views

A new check box, Display Inactive Warehouses in ALE Lookups, has been added to
the Preferences tab in Company Maintenance. The check box is selected by default.
Clear the check box if you don’t want to display inactive warehouses in lookup views.

Restricted Warehouse Status

The Restricted status is intended for a warehouse that is still in use but activity
needs to be temporarily suspended, for example, to take inventory. If a warehouse
status is Restricted, it cannot be selected in data entry tasks unless an exception is
created in the new Allow Entry of Restricted Warehouse window.

To create exceptions, click the Allow Inactive Warehouse button, which is next to the
Warehouse Status field and available when Restricted is the selected status. You
can then select data entry tasks, and the restricted warehouse can be used in those
tasks.

You can enter dates in the Restricted Start Date and End Date fields to automatically
start and end a period in which the warehouse is restricted.

A permanent code, RESWH (Restricted Warehouse), has been added to S/O
Cancel and Reason Code Maintenance.
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Job Cost Changes in 2018.5

The following changes were made in the Job Cost Module in version 2018.5.

Certified Payroll Reporting

Certified Payroll Reporting has been added to the Reports menu in Sage 100 Payroll
2.18.5. This section describes changes made to the Job Cost module to collect
information for the reports.

To learn more about Certified Payroll Reporting, see the Sage 100 Payroll
Installation and Upgrade Guide, available here:
https://cdn.na.sage.com/docs/en/customer/100erp/2_18/open/Payroll_Upgrade.pdf

Certified Payroll Reporting Window

In Job Cost Maintenance, a More button has been added in the top-right corner of
the window. Click this button or the arrow next to it and select Certified Payroll to
open the Certified Payroll Reporting window. Use this window to enter information
for the current job that will be used in the Certified Payroll Report.

This window is also available from Job Inquiry, but it's view-only. You can access the
window from Job History Inquiry by clicking the Certified Payroll button that has been
added to the window.

Job Contractor Maintenance

Job Contractor Maintenance has been added to the Job Cost Setup menu. Use this
task to create and maintain records for each of the contractors with whom you do
business. The records are available to select as the prime contractor and awarding
contractor in the Certified Payroll Reporting window accessed through Job
Maintenance.

Job Listings

A Certified Payroll check box has been added to the Job Listing and Job History
Listing task windows. Select this check box to include the certified payroll
information for each job in the listing.

Cost Code Detail Window

The Cost Code Detail window accessed in Job Maintenance has been added to the
menu for the More button. The Cost Code button has been removed.

Job Cost Changes in 2018.2

The following changes were made in the Job Cost module in version 2018.2.

Time Track

Time Track is the new time entry feature that comes with the TimeCard module.
Time Track replaces the features previously available in TimeCard, most of which
have been kept and redesigned for better usability. Job numbers and cost codes can
be associated with time entries created in the Payroll module so that you can update
the labor costs to Job Cost.
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For a list of TimeCard Tasks and their Time Track replacements, see Time Track
Task Locations on page 54.

For information on the Time Track features in the Payroll module, see the Sage 100
Payroll 2.18 Installation and Upgrade Guide, available online at:
https://cdn.na.sage.com/docs/en/customer/100erp/2_18/open/Payroll_Upgrade.pdf

For setup instructions, see Set Up Time Track for Job Cost in the Sage 100 help.

Job Cost Options

The Enable Time Track for TimeCard check box has been added in Job Cost
Options.

Time Track Menu

A Time Track menu has been added in the Job Cost module. This menu contains the
following tasks:

e Time Track Selection: Use this task to select time entry records so that the
associated labor costs can be updated to Job Cost.

For more information, see Post Time Track Entry Costs for Jobs in the help.

e Time Track Register / Update: Use this register to view information for the jobs
included when running Time Track Selection. The register lists the employees
who entered time for each job, the earnings code used, the hours worked, the
cost code, and the cost amount per cost code.

Note: Select Employee in the Sort By field when printing this register to use it as
a replacement for the J/C Selection Audit Report that was previously available in
the TimeCard module.

e Job Daily Production Report: This report provides a summary, by job, of the
number of hours worked for each day of the week, and lists the week-to-date
total, job-to-date hours, job-to-date estimate, and variance.

Job Cost Maintenance

The Exclude from Certified Payroll Report check box has been added in Job Cost
Maintenance. This field is available if the Payroll module is integrated with Job Cost.

Select the check box to exclude the job from the Certified Payroll Worksheet, which
has been added to the Payroll Main menu.

Cost Code Maintenance

An Earnings button is available in Cost Code Maintenance when Time Track is
enabled for Job Cost and the option to validate cost code/earnings code
combinations is enabled in Time Track Options (on the Payroll Setup menu).

Click Earnings to open the Valid Earnings Codes window and select earnings codes
that are valid for the selected cost code. Combinations of cost codes and earnings
codes are validated in Time Track Entry and Punch In/Out.
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Job Transaction Detail Report & Job Transaction Detail History Report

The Source Journals to Print field was renamed Source Modules to print. If you
converted data that included TimeCard entries, they are still reflected in the TC
module information. New Time Track entries are included when you select the JC
source module.

Time Track Task Locations

To view a list of TimeCard tasks and the name and location of the Time Track tasks
that have replaced them, see Time Track Task Locations on page 54.

Job Cost Changes in 2018

In version 2018, the Job Cost module has been rearchitected to improve
performance and usability.

User Interface Enhancements

These changes have been incorporated to make it easier to access data and
complete tasks.

e Data entry grids are used to improve efficiency.

e Selection grids are available on most report task windows and elsewhere.
e Calculator buttons have been added to dollar amount fields.

e Calendar buttons have been added to date fields.

e Hyperlinks to related tasks have been added where applicable.

Batch Entry

Batch entry can be used in the following tasks:
e Job Posting Entry

e Job Billing Entry

e Field Report Entry

You can enable batch entry for each of these tasks and set the next batch number on
the Entry tab in Job Cost Options.

History

On the History tab in Job Cost Options, you can select whether to retain history and
set the number of years to retain history. The minimum is two years.
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Utilities Menu

The utilities used to control the archiving, restoring and purging of Job Cost history
have been updated for the new number of years option, and are now available on
the Utilities menu.

The Summarize Cost Detail utility has been moved to the Utilities menu.

Forms and Reports

e Report setting options now appear on the header area of the applicable report
window. You can avoid reentering selections each time you print a report by
creating a new report setting. For more information, see Create a Report Setting
in the help.

e SAP Crystal Reports is now used for all reports and forms. Non-graphical forms
are no longer available.

e Selection grids have been added so that it's easier to filter report data.

e The option to keep the task window open after printing or previewing a report has
been added to report task windows.

e If you use Job Cost for billing, the invoice form will need to be reformatted.

Period, Year, and Job-to-Date Totals

The Job and Job Cost Code Detail tables no longer contain period-to-date,
year-to-date, and job-to-date totals. If you have custom reports that contain this
information, you must create a sub-report to summarize the data from the Job Cost
Code History table to calculate the totals.

Period End Processing Reports

A Print Period End Reports check box has been added to the J/C Period End
Processing window. If you select this check box, the J/C Period End Reports window
opens when you click Proceed. The reports selected in Period End Report Selection
are listed, and you can select which ones that you want to print. If no reports are
selected in Period End Report Selection, the check box is not available.

Mobility for Bar Code Changes in 2018

The Bar Code module has been renamed in version 2018; it is now the Mobility for
Bar Code module. This section provides an overview of the changes. For more
details on how the new features work, see the help.

Mobility Remote Setup for Scanco Mobile App

The Mobility Module Setup task has been added as part of the setup process for
Scanco’s mobile app for Apple iOS and Android devices.
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Mobility for Bar Code Options (formerly Bar Code Options)

The Bar Code Options task has been renamed Mobility Options and offers a simple
configuration for number of days to retain import history. Also the File tab has been
removed.

EZ Import Tasks

The following four tasks have been added to import data collected on mobile
devices.

e Inventory EZ Import for Physical Count Entry, Count Card Entry, receipts, issues,
adjustments, alias entry, and job issues. This task replaces Import Inventory
Transactions.

e Sales Order EZ Import for Invoice Data Entry and Shipping Data Entry. This task
replaces Import Sales Order Transactions.

e Purchase Order EZ Import for Receipt of Goods. This task replaces Import
Purchase Order Transactions.

e Bill of Materials EZ Import for Production Entry. This task replaces Import Bill of
Materials Transactions.

e EZ Import can be used to import any transaction type.

You can use EZ Import exclusively; or you can use the module-specific import tasks
listed above, in conjunction with Role Maintenance, to manage which types of
transactions that users are able to import.

The new tasks show all data imported by type. For example, data for Physical Count
and Issues is shown separately.

EZ Import Inquiry

Use the new EZ Import Inquiry task to view and print all imported data within a
specified date range.

EZ Import Reject Maintenance

The new EZ Import Reject Maintenance task displays detailed information in a grid
view which you can use to make corrections as needed. This task replaces Rejected
Import Maintenance.

EZ Import Reporting

The following reports show all data collected on mobile devices:
e EZ Import Report for all records currently in process.
e EZ Import History Report for all records that have been processed.

e EZ Import Rejection Report for all records that have been rejected due to
discrepancies
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Other Renamed or Removed Tasks
The following tasks have been renamed or replaced.

e Purge Bar Code History has been renamed Purge EZ Import History.

e The Unattended Bar Code Transaction Import task has been removed from the
Main menu. Use the EZ Import tasks instead.

Paperless Office Changes in 2018

The following changes were made in version 2018 as part of the redesign of the
Payroll module.

e You can now create and email employee payroll checks in PDF format. In Forms
Maintenance, a check option has been added to the Documents list for the
Payroll module.

e The Employee Viewer task has been added to the Main menu. The Form Type
field has Check and Direct Deposit Stub options.

e In Employee Self Service, the View Documents button has replaced the View
Stubs button. The button opens the Employee Viewer window in which you can
view both checks and direct deposit stubs.

Payroll Changes in 2018

The Payroll module has been redesigned to improve performance and usability. For
details, see the Payroll What's New guide available here:
https://cdn.na.sage.com/docs/en/customer/100erp/2018n/open/payroll_upgrade.pdf

Purchase Order Changes in 2018.3

The following changes were made in the Purchase Order module in version 2018.3.

Auto Generate from Sales Orders

When creating purchase orders using Auto Generate from Sales Orders, any
drop-ship items that are used in multiple lines in a sales order can now remain on
separate lines in the purchase order. Previously the duplicate lines were
consolidated into one line in the purchase order.

The Summarize Multiple Items by Line check box is now available for both drop-ship
and non-drop-ship lines. Also the check box is available when Sales Order Line No.
is selected in the Sort Purchase Order Lines By field in Purchase Order Options.

If you don’t want to consolidate duplicate sales order drop-ship lines into one line on
the purchase order, select the Summarize Drop Lines By Vendor check box, and
clear the Summarize Multiple Items by Line check box.
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To consolidate the duplicate drop-ship lines on the purchase order, select both the
Summarize Drop Ship Lines by Vendor check box and the Summarize Multiple Items
by Line check box.

Sales Order Changes in 2018.4

The following changes were made in the Sales Order module in version 2018.4.

Consolidate Multiple Orders in Shipping Data Entry

You can now consolidate multiple sales orders into one shipment in Shipping Data
Entry.

Shipping Setup Options
Two new fields have been added on the Entry tab in Shipping Setup Options.

e Consolidate Orders on One Invoice

o Select Yes to automatically consolidate sales orders for one invoice as the
orders are processed in Shipping Data Entry.

o Select Prompt to display a message when you click Accept asking if you want
to add another order.

e Consolidate by Customer PO No. (Available if you select Yes or Prompt in the
Consolidate Orders on One Invoice field)

o Select Yes to consolidate orders into one invoice only if the purchase order
number is the same.

o Select No to consolidate orders with different purchase order numbers into
one invoice.

o Select Prompt to display a message asking if an order should be added to an
existing shipment when the purchase order numbers are different.

Shipping Data Entry

In Shipping Data Entry, when multiple orders have been added to the current
shipment, you can select the Show Detail for All Orders check box to view the lines
for all of the orders. If the check box is cleared, the grid displays lines only for the
order entered in the Order No. field.

Shipping History Inquiry

If you're viewing a shipment that includes multiple sales orders, the word Multiple
appears in the Order No. field. If more than one customer purchase order number is
associated with the orders, Multiple appears in the Cust PO field. Click the Zoom
button next to either field to view details in the Sales Orders Applied on Invoice field.
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Forms and Reports

On packing lists and the Shipping History Report, if a shipment includes more than
one order, “Multiple” prints in the Order Number field in the heading area, and the
individual order numbers print in the area with the line details.

View Multiple Sales Order and Purchase Order Numbers

When you’re viewing an invoice to which multiple sales orders are applied, you can
click the Zoom button next to the Order No. field to view a list of the orders. If there
are multiple customer purchase order numbers associated with the orders, a Zoom
button also appears next to the Customer PO field.

The Zoom buttons have been added to the following tasks:

e S/O Invoice Data Entry (for customer purchase order numbers)

e A/R Invoice History Inquiry (accessed from both the Sales Order and Accounts
Receivable modules)

e Shipping History Inquiry

e Shipping List lookup window (accessed from Shipping History Inquiry)

View Multiple Deposits

If you’re viewing an invoice to which multiple sales orders are applied and one or
more orders includes a deposit, "Deposits from Applied Sales Orders" appears in
place of the Deposit Payment Type field, and the Deposits on Applied Sales Orders
Zoom button appears. Click the button to view the deposit details in the Deposits on
Sales Orders window.

Sales Order Changes in 2018.3

The following changes were made in the Sales Order module in version 2018.3.

Apply Multiple Sales Orders to an Invoice

In Invoice Data Entry, an Apply Sales Orders button has been added next to the
Sales Order Number field on the Header tab. After selecting the first order for the
invoice, click this button to select additional orders.

You can apply multiple sales orders to invoices if the invoice type is either Standard
or Cash Sale, and only if there has been no credit card deposit or credit card
payment applied to the invoice before you apply the sales orders.

Sales orders can be applied to an invoice if they have not been used for any other
invoice, and if there has been no credit card deposit or credit card payment applied
to the order. You can add a credit card payment or deposit to the invoice after
applying all of the sales orders.
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For each order added to an invoice, the fields listed below must all contain the same
value. The first order selected in Invoice Data Entry is used to determine whether
additional orders are valid. Some fields may not be available depending on your
settings.

e Terms code

e Ship-to code

e Discount rate

e Sales tax schedule

e Salesperson (or salespersons) and commission rate(s)
e Job number

e Ship-via shipping code and shipping zone

e Bill-to customer

e ACH Payment ID (The payment IDs must match or you can combine with an
order that has no payment ID.)

e CRM person ID, CRM company ID, and CRM opportunity ID

Reports, Forms, and Registers

In the header section of the documents listed below, “Multiple” is printed in sales
order number and customer purchase order number fields when applicable. The
sales order number and customer purchase order number are printed in the line
detail section.

e Sales Order invoice

e Sales Journal

e Gross Profit Journal

e Daily Deposit Recap Report

e Accounts Receivable Invoice History Report

When printing an invoice that includes multiple sales orders, the order date for the
first order selected prints on the invoice.

Accounts Receivable Invoice History Inquiry

In Invoice History Inquiry, “Multiple” appears in the Order No. field and, on the Main
tab, in the Customer PO field when applicable. To view a sales order number or
customer purchase order number, select a line on the Lines tab, and click the
Additional Information button. The order number and customer purchase order
number are shown in the Additional Fields window.

If a deposit was entered for multiple orders, the total deposit amount appears on the
Main tab in the Deposit field, and a Deposit Information button appears next to the
field. Click the button to open the Deposit Inquiry window, which lists the individual
deposits.
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Sales Order Changes in 2018.2

The following changes were made in the Sales Order module in version 2018.2.

Reprint Sales Orders and Quotes from History

A Print button has been added to the Sales Order and Quote History Inquiry window.
You can click the button to print the selected order or quote.

If you need to reprint a range of orders or quotes, you can use the new Sales Order
and Quote History Printing task, which has been added to the Sales Order Reports
menu. You can select whether to include active, complete, and deleted orders as
well as active and deleted quotes.

Exclude Orders Being Invoiced from Reports

You now have the option to exclude sales orders that are in the process of being
invoiced when printing the following reports:

e Open Sales Order Report
e Open Orders by ltem Report
e Open Orders by Promise Date Report

e Open Orders by Job Report

TimeCard Changes

As a result of the extensive improvements to the Payroll module, the TimeCard
module is not compatible with Payroll for version 2018.

Time Track is the new time entry feature that replaces the features previously
available in the TimeCard module. To use Time Track, you must install Sage 100
2018.2.

For information on using Time Track with the Job Cost module, see Time Track on
page 42.

For information on using Time Track with the Payroll module, see the Sage 100
Payroll 2.18 Installation and Upgrade Guide, available online at:
https://cdn.na.sage.com/docs/en/customer/100erp/2_18/open/Payroll_Upgrade.pdf
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Visual Integrator Changes in 2018

The following changes made in version 2018 apply to the Visual Integrator module.

Module Options for Managing Job Access

You can now control whether users can create and run import and export jobs on a
module-by-module basis. Module options to manage job access have been added to
Role Maintenance for the following modules:

e Accounts Payable

e Accounts Receivable

e Bar Code

e Bill of Materials

e Bank Reconciliation

e Common Information

e Customer Relationship Management

e eBusiness Manager

e Fixed Assets

e General Ledger

e Inventory Management

e Library Master

e Purchase Order

e Payroll

e Return Merchandise Authorization

e Sales Order

Job Cost and Payroll Import and Export Jobs

All import and export jobs for the Job Cost and Payroll modules must be recreated.

Renamed and Replaced Tasks

This section lists tasks that have been renamed or replaced with another task in
version 2018.

Accounts Payable
Form 1099 eFiling and Reporting has been renamed Form 1099 Tax Reporting.

Mobility (Formerly Bar Code)
e Inventory EZ Import replaces Import Inventory Transactions.

e Sales Order EZ Import replaces Import Sales Order Transactions.
e Purchase Order EZ Import replaces Import Purchase Order Transactions.

e Bill of Materials EZ Import replaces Import Bill of Materials Transactions.
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e Purge Bar Code History has been renamed Purge EZ Import History.

e The Unattended Bar Code Transaction Import task has been removed from the
Main menu. Use the EZ Import tasks instead.

Sage Contact for Office 365

When you integrate Office 365 with Sage 100 version 2018, you can use the Sage
Contact app to view Sage 100 customer information in Outlook, including the
following:

e Recent invoices and payments

e Credit information

e Contacts’ name, address, phone, and email
e Customer memos

You can also edit contact information and create new customer contact records in
Outlook, and the changes are updated to Sage 100.

An Office 365 Business Premium or Enterprise subscription plan and an Azure
Active Directory subscription are required. For more details, see the Sage 100
Integrated Solutions Compatibility Matrix in the Sage Knowledgebase (article ID
48274).

For setup instructions, see Set Up Office 365 Integration in the help.

Retired Features

The integration between the General Ledger module and the BenefitMall payroll
service is no longer supported beginning with version 2018. Sage Payroll Services is
now the only supported payroll service. Based on your implementation, it is possible
that the integration for the BenefitMall payroll service may continue to function.
However Sage has discontinued our ongoing development efforts.
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Time Track Task Locations

Refer to the following table to see which Time Track tasks replaced TimeCard tasks
in version 2018.2 and where they are located.

TimeCard Task Time Track Task

Setup Menu

Cost Code/Earnings Code Setup

Exception Code Maintenance
TimeCard & TimeClock Options

TimeCard Employee Maintenance

TimeCard Job Maintenance

TimeCard Ultilities

TimeClock Shift Maintenance

Main Menu
TimeCard Entry and Edit
TimeCard Entry and Edit --New Entries Only

TimeCard Inquiry

TimeCard History Inquiry

TimeClock Punch In/Punch Out

Period End Menu

Purge History Files

Select Job Cost > Setup > Cost Code
Maintenance. Click Earnings to open the Valid
Earnings Code window.

Not available.
Payroll > Setup > Time Track Options

Select Payroll > Main > Employee
Maintenance. Click More and select Time Track
to open the Employee Time Track Settings
window.

Select Job Cost > Main > Job Cost
Maintenance. Select or clear the Exclude from
Certified Payroll Report check box.

Not available.

Select Payroll > Time Track > Shift
Maintenance.

Select Payroll > Time Track > Time Track Entry.
Select Payroll > Time Track > Time Track Entry.

Select Payroll > Time Track > Time Track
Inquiry.

Not available. To view history, select Payroll >
Time Track > Time Track Report, and select the
History check box before printing the report.

Select Payroll > Time Track > Punch In/Out.

Select Payroll > Period End > Period End
Processing.
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TimeCard Task Time Track Task

Purge/Transfer to History Not available. Data is automatically transferred
to history when time entries are updated in the

Job Cost Menu
Calculate Job Cost Selections
Daily Transaction Register

J/C Distribution Register/Update

J/C Selection Audit Report

Job Costs Selection

Reports Menu

Approaching Overtime Report

Attendance Worksheet

Average Hourly Pay Report

Certified Payroll Report

Departmental Exception Report
Employee Exception Report
Exception Calendar Report
Gross Earnings Report

Job Daily Production Report

TimeCard Report

Job Cost and Payroll modules.

Not available.*
Not available.*

Select Job Cost > Time Track > Time Track
Register / Update.

Select Job Cost > Time Track > Time Track
Register / Update.

Select Job Cost > Time Track > Time Track
Selection.

Select Payroll > Time Track > Approaching
Overtime Report.

Select Payroll > Time Track > Attendance
Worksheet.

Not available.

Select Payroll > Main > Certified Payroll
Worksheet.

Not available.
Not available.
Not available.
Not available.

Select Job Cost > Time Track > Job Daily
Production Report.

Select Payroll > Time Track > Time Track
Report.

*Labor costs are automatically calculated when they are selected and updated to the Job
Cost module. There is not a separate Daily Transaction Register for Time Track. Costs are
updated when you update the Job Cost Daily Transaction Register. For more information,
see Post Time Track Entry Costs for Jobs in the help.
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Chapter 5

é NOTE

To activate the
enhanced
auto-complete
feature, run the
Build Search
Index utility after
upgrading to
version 2017.
Run the utility as
new customer,
vendor, and item
records are
created to see
the records in
auto-complete
search results.

Changes in 2017

This chapter describes the changes made in the 2017 release that you should be
aware of. Installation and global changes are listed first followed by module changes
and retirements.

Global

The following changes are carried throughout multiple modules.

Enhanced Auto-Complete

When using the auto-complete feature, your search criteria is compared with all
words within the searched fields. Previously the feature considered only the
beginning of the text in the searched fields.

For example, if you have a customer named Allen’s Appliance Repair and a
customer named Appliance Services, typing Appl in the Customer No. field results in
a list that incudes both customers.

In addition, the number of fields included in the search has been expanded. For
example, to search for a vendor by phone number, start typing the phone number,
digits only, in the Vendor No. field.

After adding new records, you’ll need to run the Build Search Index utility on the
Library Master Utilities menu to index those records so that they appear in the
auto-complete search.

For more information on this feature, see Auto-Complete Search in the help.

Build Search Index Utility

To activate the enhanced auto-complete feature, run the Build Search Index utility
on the Library Master Utilities menu. If you do not run the utility, auto-complete will
work as it did before this update.

Run the utility after creating new customer, vendor, and item records so that the
records are indexed and appear in the auto-complete results. Running the utility
updates the index for all of your companies.

You can use Task Scheduler to automatically run the indexing utility on a regular
basis.

Full Text Search Option in Lookup Windows

A Full Text option has been added to the Search list in Lookup windows. When you
select Full Text, your search criteria is compared with the data in all columns
available in the Lookup window.
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é NoTE

The Commodity
Code field
appears in Sales
Order Entry and
S/0 Invoice Data
Entry only if a
credit card set up
for Level 3
processing is
selected as the

payment method.

Note that your search criteria must match the beginning of a word. For example, if
you have a customer named Hydromart and a customer named Martin Supply, when
you type Mart, Martin Supply will appear in the search results, but Hydromart will not.

Search for Empty Fields in Lookup Windows

You can now search for fields that do not contain any value in Lookup windows. After
selecting a field from the Search list, select Is Empty from the operand list, and then
click Find.

Maintain Commodity Codes for Miscellaneous and Inventory
ltems

You can now maintain a list of commodity codes and associate them with
miscellaneous and inventory items. Commodity codes are included with the data
sent when processing Level 3 credit card transactions in the Sales Order module.

e Commodity Code Maintenance has been added to the Common Information
Setup menu. Use this task to maintain a list of commodity codes and their
descriptions. The codes and descriptions are available in the lookup views for
Commodity Code fields. You can click the Apply button to assign a commodity
code to a range of items.

e The Commodity Code Import Wizard, available on the Common Information
Utilities menu, guides you through importing commodity codes from tab-delimited
text files.

e A Commodity Code field has been added to the Main tab in Miscellaneous ltem
Maintenance and the Additional tab in ltem Maintenance. You can enter an
existing code or create a new one on the fly.

e A Commodity Code field has been added to the Main tab in Product Line
Maintenance. A Commodity Code check box has been added to the Apply
Product Line Information window so that you can apply the code entered in
Product Line Maintenance to the selected inventory items within the product line.

e When an item is selected in Sales Order Entry and S/O Invoice Data Entry, the
code entered in the item’s maintenance task is the default value in the
Commodity Code field, but it can be changed.

e A new Commodity Desc field displays the commodity code description in Sales
Order Entry and S/O Invoice Data Entry.

Prior and Next Buttons for Calendar Window

Prior and Next buttons have been added to the Calendar window. You can use the
buttons to quickly change from month to month.

Resizable Memo Maintenance Window

You can now resize the Memo Maintenance window by dragging the lower-right
corner of the window.
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Ability to Suppress "Remove Forms" Message
A module option in Role Maintenance allows you to suppress the message that
reminds you to replace forms with paper after printing.

To no longer see this message, clear the Show Prompt to Remove Forms From
Printer check box in the Common Information section.

Larger Font for Selected Reports

The font size used for selected reports has been increased to improve readability.
These reports previously used a 6 point font. The new font is horizontally equivalent
to the previous font, but it is 30 to 40 percent taller.

Cancel Button Available When Printing Reports

You can now cancel report printing by clicking the Cancel button on the message
window that appears while the report is processing. Note that clicking the Cancel
button will cause the report's task window to close, even if you have selected the
Keep Open After Print check box.

New Options on Help Ribbon

Several buttons have been added to the Help ribbon on the standard Desktop. The
new options include the ability to:

e Access the Sage 100 knowledgebase
e Start a chat session with Sage 100 tech support
e Create a support ticket

You must log in to use some of these features.

Accounts Receivable

Ability to Accept ACH Payments

You can now enter ACH payments in the following tasks:

e A/R Invoice Data Entry
e Cash Receipts Entry
e Repetitive Invoice Entry

To enable this feature, you must have a Sage Payment Solutions account that is set
up for ACH payments. You can then enable the feature on the Payments tab in
Company Maintenance and set up ACH payment types in Payment Type
Maintenance. For more information, see Set Up Credit Card and ACH Payment
Processing in the help.

To accommodate this feature, some tasks, fields, and tabs have been renamed to
reference "payments” instead of "credit cards.” Details are in the following sections.
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ACH Payment Processing

ACH payments are submitted to Sage Payment Solutions as part of the Cash
Receipts Journal and A/R Sales Journal update process. They cannot be processed
individually. For more information, see Process ACH Payment Transactions in the
help.

Data Entry Tasks
The following changes were made in the data entry tasks.

The Credit Card tab has been renamed; it is now the Payment tab. Fields related
to ACH payments have been added, and the Payment ID field has replaced the
Card ID field.

On the Payment tab, the Fix button is available based on the Allow to Override
ACH Payment Transaction security event in Role Maintenance.

ACH payment related fields have been added to the Cash Receipts Deposit
window and the Cash Receipts Entry Header tab.

Maintenance Tasks
The following changes were made in maintenance tasks:

In Payment Type Maintenance, you can now select ACH Payment as the
payment method.

On the Customer Maintenance Additional tab, the Payment ID field has replaced
the Card ID field. ACH payment-related fields have been added.

On the Customer Maintenance Invoices and Transactions tabs, ACH payments
now appear in the secondary grid.

The Customer Credit Card Maintenance window has been renamed Customer
Credit Card and ACH Payment Maintenance. ACH payment-related fields have
been added to the window.

In Invoice History Inquiry, an ACH account field displays the last four digits of the
ACH payment bank account for invoices with ACH payments. A Payment
Information button has replaced the Credit Card Information button. The button
opens the new Payment Information window to view additional details about the
payment.

Reports and Listings

The option to print customers’ ACH payment information has been added to the
Customer Listing task window. The last four digits of the bank account appear on
the listing.

On the Deposit Transaction Report, the last four digits of the bank account
appear for ACH payments in the renamed Credit Card/ACH/Reference/Check
Number column.
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Accounts Receivable

The Credit Card Settlement Report has been renamed Credit Card and ACH
Settlement Report. ACH payments are included on the report.

Changing Transaction Information

A new security event, Allow to Override ACH Payment Transactions, has been
added. This security event enables the Fix button on the Payments tab in A/R
Invoice Data Entry and Cash Receipts Entry, which lets users update ACH payment
transaction information.

Renamed Tasks, Tabs, and Fields
As part of the ACH payments enhancement, the following changes were made:

In Accounts Receivable Options, the Allow Credit Cards field was renamed Allow
Credit Cards / ACH Payments.

In Customer Maintenance, the Card ID field was renamed Payment ID, and the
Credit Cards button was renamed Credit Cards/ACH.

The Customer Credit Card Maintenance window was renamed Customer Credit
Card and ACH Payment Maintenance.

In Customer Credit Card and ACH Payment Maintenance, the following items
were renamed:

o The Card ID field was renamed Payment ID.
o The Add New Card button was renamed Add New.
o The Edit Card button was renamed Edit.

The Customer Credit Card Listing was renamed Customer Credit Card and ACH
Payment Listing.

In Invoice Data Entry, Repetitive Invoice Entry, and Cash Receipts Entry, the
following changes were made:

o The Credit Card tab was renamed Payment.
o The Card ID field was renamed Payment ID.
o The Submit Card button was renamed Submit Card/ACH Account.

The Credit Card Settlement Report was renamed Credit Card and ACH
Settlement Report.

The Clear Credit Card Information utility was renamed Clear Credit Card and
ACH Information.
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Bank Reconciliation

Bank Reconciliation

Option to Keep Bank Reconciliation Report Window Open

The following check boxes have been added to the Bank Reconciliation Report task
window:

e Keep Window Open After Print
o Keep Window Open After Preview

Note that the task window will automatically close when updating the report, even if
the check boxes are selected.

Improved Export to Excel for Reports

When exporting Bank Reconciliation reports to Microsoft Excel, the resulting Excel
file is easier to view and manipulate.

e The minimum font size is 8 points.
e Empty columns and rows are minimized.

Credit Card Processing

Sage Exchange Desktop No Longer Automatically Installed

Sage Exchange Desktop (SED) is no longer automatically installed when adding a
customer credit card or processing a credit card transaction. You must install the
program on each workstation that will be used to process credit card or ACH
payments.

The SED installation program has been added to the Productivity Applications
screen within the Sage 100 installation program and to the Workstation Setup
installation program. For more information, see the Sage Exchange section in the
Sage 100 Installation and System Administrator’s Guide, or refer to the data
conversion checklist for the Sage 100 version that you’re upgrading from. The
checklists are in Appendix A.

Customer Relationship Management

Sage CRM 7.3 SP3 is now included with Sage 100. For information on what’s new in
this version, see Sage CRM 7.3 SP3 Release Notes. This document is available in
the Documentation folder within the Sage CRM installation program. To access this
guide, click the Documentation link on the Autorun screen that appears when you
start the Sage CRM installation program.
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General Ledger

General Ledger

Improved Export to Excel for Financial Reports

When exporting financial reports to Microsoft Excel, the resulting Excel file is easier
to view and manipulate.

e The minimum font size is 8 points.

e Empty columns and rows are minimized.

Library Master

Search Added to Role Maintenance

After selecting a role in Role Maintenance, you can click the Search button and enter
search criteria. A list of matching tasks, security events, and module options
appears, and you can select one to go to its location on the applicable tab.

Changes for ACH Payments
As part of the ACH payments enhancement, the following changes were made in
Company Maintenance:

e The Credit Card Processing tab was renamed Payments

e The Enable Credit Card Processing check box was replaced with an Enable
Payments field to accommodate both credit cards and ACH payments.

For more information on this enhancement, see Ability to Accept ACH Payments on
page 58.

Sales Order
Ability to Accept ACH Payments

You can now enter ACH payments in the following tasks:

e Sales Order Entry
e S/O Invoice Data Entry

To enable this feature, you must have a Sage Payment Solutions account that is set
up for ACH payments. You can then enable the feature on the Payments tab in
Company Maintenance and set up ACH payment types in Payment Type
Maintenance. For more information, see Set Up Credit Card and ACH Payment
Processing in the help.

To accommodate this feature, the following changes were made in the data entry
tasks.
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Sales Order

e The Credit Card tab has been renamed; it is now the Payment tab. Fields related

to ACH payments have been added, and the Payment ID field has replaced the
Card ID field.

e On the Payment tab in Invoice Data Entry, the Fix button is available based on
the Allow to Override ACH Payment Transaction security event in Role
Maintenance.

ACH Payment Processing

ACH payments are submitted to Sage Payment Solutions as part of the Sales
Journal update process. They cannot be processed individually. For more
information, see Process ACH Payment Transactions in the help.

Renamed Tabs, Fields, and Buttons

As part of the ACH payments enhancement, the following changes were made in
Sales Order Entry and S/O Invoice Data Entry.

e The Credit Card tab was renamed Payment.
e The Card ID field was renamed Payment ID.

e The Submit Card button was renamed Submit Card/ACH Account.
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Chapter 6

Changes in 2016

This chapter describes the changes in versions 2016, 2016.1, and 2016.2.
Installation and global changes are listed first, followed by module changes and
retirements.

Global Changes in Version 2016.2

Easy Way to Update Subscription Information

An Update button has been added to the Registration tab in System Configuration. If
you've made changes to your subscription agreement, you can click this button to
download your new product key. You can still manually enter your product key, and
the system automatically checks for updates every 28 days when someone logs into
Sage 100.Global Enhancements in Version 2016

Global Changes in Version 2016
New Product Key Required

If you use the Payroll module, you must enter your new product key when installing
Sage 100 2016. If you enter a product key obtained when purchasing a previous
version of the program, you will not be able to open any Payroll tasks.

New User Interface

The user interface has been updated with new features and a more modern
appearance. The following is a list of highlights.

For more details, refer to the Sage 100 Getting Started Guide, which you can access
form the Resources page: On the Sage 100 Desktop, click Web Content, and then
click Resources.

Ribbon Replaces the Toolbar

A ribbon has replaced the Desktop toolbar. You still have access to the same
features, but the new interface makes them easier to find.

Change Font Size for Desktop and Task Windows

You can now increase the size of text that appears in the Desktop and task windows.
The task windows will be automatically resized to accommodate the text size. Use
the Application Scaling menu on the View tab to adjust the text size.

Themes for the Desktop and Task Windows

You can now select from one of several themes for the Desktop. Use the View tab to
select a theme.
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Global Changes in Version 2016

Different themes are also available for task windows. You can select a preconfigured
theme or create your own. For more information, see Theme Tab in Company
Maintenance on page 72.

Individuals can select their own themes on the new User Settings window if they
have the appropriate security setup.

Extended Item Descriptions for All ltems

You can now enter an extended item description for all items, with the exception of
Comment-type items. The following changes have been made as part of this
enhancement:

e An Extended Item Description button has been added to the Miscellaneous ltem
Maintenance window. Click this button to open the Item Text Maintenance
window to view and maintain extended item descriptions.

e A Print Extended Descriptions check box has been added to the Miscellaneous
Item Listing window.

e An Extended Item Description button has been added to the Lines tab in A/R
Invoice Data Entry and A/R Repetitive Invoice Entry.

e On all other data entry screens with an Extended Item Description button, the
button will now be available when miscellaneous, special, and charge items are
selected.

User Settings Window

The new User Settings window allows users to set certain preferences, such as the
default zoom level for previewing reports and whether a decimal point is
automatically inserted when entering quantities.

Users can also use this window to select whether they want to use the standard or
classic Desktop and, if they have the appropriate security setup, a theme for task
windows. A new security event, Allow to Modify Theme in User Settings, has been
added to Role Maintenance. For more information on selecting a Desktop or theme,
see New User Interface on page 64.

The User Settings window is accessed by clicking the Settings button on the User
Logon window after entering a valid user logon ID and password, or by selecting
Change User Settings from the Sage 100 File menu.

Expanded Customer Purchase Order Field
The customer purchase order number field has been expanded to 30 characters.
The field held a maximum of 15 characters in prior versions.

e The standard forms and reports handle the expanded field differently, depending
on the report layout. If the longer number doesn't fit on one line, it wraps to the
next.

e Test all customized forms that print the customer purchase order number to
ensure that they correctly display numbers that exceed 15 characters.
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e Reports created with the Business Insights Reporter Wizard must be modified by
editing the report using SAP Crystal Reports Designer, or you can recreate the
reports using the wizard.

e Windows and tabs that display the customer purchase order number have been
updated to display either all 30 characters or as many as possible. For fields that
do not display all 30 characters, you can use the Right Arrow key or the End key
to move the cursor within the field and view the full number. The Home key
returns the cursor to the beginning of the field.

New Fields Added to History Tables

For internal control purposes, the following fields have been added to various tables:

e Created By (UserCreatedKey)
e Date Created (DateCreated)
e Time Created (TimeCreated)

The fields were added to the following tables:

e AP_CheckDetailPosting

e AP_CheckHeaderPosting
e AP_CheckHistoryHeader
e AP_InvoiceHeaderPosting
e AP_InvoiceHistoryHeader
e AP_Openinvoice

e AR _CashReceiptsHistory
e AR _InvoiceHistoryHeader
e AR _Openlnvoice

e AR TransactionPosting

e PO_ReceiptHistoryHeader
e RA_ReceiptsHistoryHeader

The data in these fields can be viewed using a Visual Integrator export or a custom
report. In history inquiry tasks, you can right-click the task window and then click
System Info to view the Created By and Date Created information.

Transfer Document to a Different Batch

A Transfer Document button has been added to data entry windows that include the
batch entry feature. If batch entry is enabled, you can click this button to move the
current document to a different batch.
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Accounts Payable Changes in Version 2016

Accounts Payable Changes in Version 2016

Electronic Payment Vendor Option for Aged Invoice Report

An Include Electronic Payment Vendors field has been added to the Accounts
Payable Aged Invoice Report window. You can use this field to specify whether
vendors with the Electronic Payment check box selected in Vendor Maintenance are
included on the report. The available options in the field are No, Only, and Yes.

Larger Font Size Option for Aged Invoice Report

A Print Condensed check box has been added to the Accounts Payable Aged
Invoice Report window. When the check box is cleared, the report will be printed in
landscape view with an 8 point font size. When this check box is selected, the report
will be printed in portrait view with a 6 point font size as it was previously.

New Vendor Maintenance Fields for 1099 Reporting
Two check boxes used for 1099 reporting have been added to the Additional tab in
Vendor Maintenance:

e Electronic Consent Signed: Select this check box if the vendor has provided
consent to receive an electronic 1099 form instead of a paper copy.

e FATCA: Select this check box if you are required to report payments to this
vendor according to the Foreign Account Tax Compliance Act.

Accounts Receivable Changes in Version 2016

Reference Memos in Repetitive Invoice Entry

A Memo button has been added next to the Reference field in Repetitive Invoice
Entry. When using the Copy From button to copy information to a new repetitive
invoice, you will have the option to copy any existing memos.

Larger Font Size Option for Aged Invoice Report

A Print Condensed check box has been added to the Accounts Receivable Aged
Invoice Report window. When the check box is cleared, the report will be printed in
landscape view with an 8 point font size. When this check box is selected, the report
will be printed in portrait view with a 6 point font size as it was previously.

Custom Office Changes in Version 2016.1

Resizable Option for User-Defined Panels

A Sizing field has been added to the Panel Header Definition window. The field is
available when working with a user-defined panel and gives you the option to make
the window resizable.
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Credit Card Processing Changes in Version 2016.1

Object Positioning Options for Resized Windows

Two new fields, Resize and Anchored, have been added for several object types.
You can use the Resize field to specify whether an object's position changes based
on window resizing or if it remains fixed relative to the anchor point selected in the
Anchored field.

The fields have been added to the Options tab in the following windows:
e Button Definition

e Check Box Definition

e Drop Box and List Box Definition

e Frame Definition

e External Link Definition

e Multi-Line Definition

e Radio Button Definition

e Text Definition

Credit Card Processing Changes in Version
2016.1

Sage Payment Center

If you use Sage Payment Solutions for credit card processing, you can now use
Sage Payment Center for greater visibility into your payment transactions. Use Sage
Payment Center to:

e View payment stats, including recent activity, weekly and monthly totals, and
recent deposits

e Settle daily transactions

e View and export reports for transactions, batches, deposits, and merchant
statements

e Search for transactions by customer name, last four digits of card number, order
number, reference number, and other criteria

For more information, go to the Information Center page and click the Sage Payment
Solutions link.

After you've set up the Payment Center, it can be accessed from the following
locations:

e The ribbon on the standard Desktop or toolbar on the classic Desktop
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e The Accounts Receivable and Sales Order Main menus
e The Invoice and Receive Payment visual process flow

e The Entry and Invoice visual process flow

New Visual Process Flow

You can now access all of the tasks needed to set up credit card processing from
one screen—the new Credit Card Setup visual process flow. Select the Visual
Process Flows > Credit Card Processing > Credit Card Setup when you're ready to
get started. Note that you must have access to the new process flow in Role
Maintenance.

Security Settings

The following security events have been added to Role Maintenance under Library
Master:

e Allow User to Access Credit Card Processing Application Form gives access to
the Sage Payment Solutions application form when it's accessed through the
embedded Desktop browser.

e Allow User to Access Payment Center gives access to the Sage Payment
Center.

Transfer Options for Vault-Only Accounts

When turning on credit card processing in Company Maintenance, if you have credit
card data stored in a Vault-only (nonprocessing) account, you are no longer required
to immediately enter the virtual terminal ID and merchant key for your processing
account. Instead you will have the option to enter the information later in Payment
Type Maintenance.

Fixed Assets Changes in Version 2016.1

The Fixed Assets module, which links Sage 100 and Sage Fixed Assets, has been
modernized to improve performance and provide a better user experience. Also, the
module is now available for Sage 100 Premium in addition to Sage 100 Standard
and Advanced.

Fixed Assets Options

The Fixed Assets Options task has been moved to the Fixed Assets Main menu.
Also the task has been reorganized and simplified.

e The Main tab has been simplified.

o The Database Name & Path field has been replaced with a Database field.
The system now detects the location of your Sage Fixed Assets databases.

o The Company ID field has been renamed SFA Company and is now a
drop-down list of available companies.
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o The Fixed Assets Product field has been removed.

o The Post Registers in General Ledger in Detail field has been renamed Post
to General Ledger in Detail.

e The Period Definition and Posting Books tabs have been combined into an
Additional tab, and the information on the fields on those tabs have been
replaced with data entry grids.

Asset Depreciation Report Task

The following features have been added to the Asset Depreciation Report task
window.

e You can now create report settings and save selections such as the number of
copies to print.

e The Selection area has been replaced with a Selections grid.
e The Sort Options field has been renamed Sort Report By.

Asset Account Maintenance

The fields on the Asset Account Maintenance window have been replaced with a
data entry grid.

Other Relocated or Renamed Tasks

The Fixed Assets Daily Transaction Register task has been moved to the Fixed
Assets Period End Processing menu.

e The Refresh Asset Templates task has been moved to the Fixed Assets Main
menu.

e The Fixed Assets Maintenance task has been renamed Fixed Assets.

Security Settings

The Fixed Assets security settings in Role Maintenance have been updated.
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General Ledger Changes in Version 2016.2
Sage Payroll Services Activity Log

e A User Logon field has been added to the Selections grid on the Sage Payroll
Services Activity Log task window, so you can now filter the log by user.

e If any errors occur while synchronizing data, more detailed error messages
appear in the log.

General Ledger Changes in Version 2016

Sage Payroll Services Integration

Sage 100 is now integrated with Sage Payroll Services (formerly known as
PayChoice). You can upload general ledger account numbers and bank codes to
Sage Payroll Services and download payroll transactions into Transaction Journal
Entry.

After setting up an account with Sage Payroll Services, use the tasks on the General
Ledger Payroll Services menu to set up the integration. For detailed steps, see
Integrate an Online Payroll Service with General Ledger in the help system. To learn
more, visit http://na.sage.com/us/sage-payroll-services.

This feature will not affect anyone using the previously existing online payroll
service, BenefitMall. A Payroll Service field has been added to Sage Payroll
Services Options, which allows you to select the online payroll service you are using.
However, the correct option will be automatically selected when you upgrade from a
system that was integrated with BenefitMall.

Reset Linked Company for Sage Payroll Services

If you synchronize payroll data between Sage Payroll Services and your general
ledger, please contact Sage Payroll Services Support for assistance with resetting
the link for your Sage 100 company.

You must complete this step before you can synchronize payroll data. This applies
only if Sage Payroll Services is selected in the Payroll Service field in Sage Payroll
Services Options.

Library Master Changes in Version 2016

Company-Specific Color Options

The Enable Company Specific Background Color field and Select Color button have
been relocated from the Preferences tab to the new Theme tab. The Select Color
button is now identified by an image of a color palette instead of a textual label. To
use the company-specific color feature, you must select Classic from the Theme
Code field.
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Expanded SMTP (Email) Server Password Field

The SMTP (email) server Password field in Company Maintenance has been
expanded to 128 characters. The field held a maximum of 14 characters in prior
versions.

Due to the space limitations, the data entry field displays 59 characters. As you type
a password that exceeds 59 characters, you’ll automatically scroll through the field
as needed.

Theme Tab in Company Maintenance

A Theme tab has been added to Company Maintenance. Use this tab to choose a
theme for the selected company. If you select the Classic theme, you can specify a
company-specific background color for the window background, frame, or both.

The Enable Company Specific Background Color field and Select Color button have
been relocated from the Preferences tab to this tab. The Select Color button is now
identified by an image of a color palette instead of a textual label.

For more information on user interface-related changes in version 2016, see New
User Interface on page 64.

New Task Scheduler Options

You can now schedule the following tasks in Task Scheduler:

e Print reports
e Run Visual Integrator import and export jobs

As part of this change, a Type field has been added to the Schedule tab. The grid on
the Task tab will vary based on what type is selected in this field.

Payroll Changes in Version 2016.2

Process Employee Pre-Note and Direct Deposit
Transactions Window

e A Manage Sage ID Users link has been added to the Process Employee
Pre-Note and Direct Deposit Transactions window. Click this link to access User
Management if you need to manage who is able to sign into the Sage 100 Direct
Deposit service.

e If any errors occur while synchronizing data, more detailed error messages
appear in the syncing window.

Sage 100 Direct Deposit Service Activity Log

e A User Logon field has been added to the Selections grid on the Sage 100 Direct
Deposit Service Activity Log task window so you can now filter the log by user.
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Payroll Changes in Version 2016
e Activity log entries now include the user logon for the person who initiated the
activity and the time the activity occurred.

e If any errors occur while synchronizing data, more detailed error messages
appear in the log.

Payroll Changes in Version 2016
Sage 100 Direct Deposit Service

Sage 100 Direct Deposit, a new service offered through Sage Payroll Services,
integrates seamlessly with the Payroll module. This new service uses the same
tasks as the existing direct deposit feature, but the process has been simplified.

e You no longer need to transmit the ACH file to your bank. Sage handles that for
you.

e Less information is required in the Direct Deposit Interface Setup task.

To get started with the new service, complete the application form. A link to the form
has been added to the Direct Deposit tab in Payroll Options.

For setup instructions, see Setting Up Sage 100 Direct Deposit Service in the help or
refer to the Sage 100 Direct Deposit User Guide available here:
https://cdn.na.sage.com/docs/en/customer/100erp/2016/open/Sage100_DirectDepo
sit_GettingStartedGuide.pdf

As part of this change, the Direct Deposit Interface options available in Payroll
Options have changed.

e Sage 100 Direct Deposit Service has been added.

e The Sage option, which was used for the preexisting direct deposit feature, has
been renamed Manually Send ACH File.

Updates for ACA Employer Maintenance

Several new fields were added to the ACA Employer Maintenance window.

e The ACA Forms to Use field allows you to select whether to use the
1094-C/1095-C forms or the 1094-B/1095-B forms when preparing forms in
Federal eFiling and Reporting.

e You can enter a value in the new Policy Origin Code field to print on Form 1095-B
in Part I, field 8 when using Federal eFiling and Reporting.

e The following check boxes allow you to select the corresponding check boxes on
Form 1094-C in Part Il, section 22 when preparing forms in Federal eFiling and
Reporting:

o Qualifying Offer Method

o Qualifying Offer Method Transition Relief
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Sales Order Changes in Version 2016

o Section 4980H Transition Relief

o 98% Offer Method

Renamed Fields

e In ACA Employee Maintenance and in the Tax Status window, the 1095-C
Electronic Consent Signed form has been renamed 1095 Electronic Consent
Signed.

e In ACA Employer Maintenance, the Provided Self-Insured Coverage field has
been renamed Provided Employer-Sponsored Self-Insured Coverage.

Renamed Menu Option

In Payroll Options on the Direct Deposit tab, the Sage option on the Direct Deposit
Interface menu has been renamed Manually Send ACH File. For more information,
see Sage 100 Direct Deposit Service on page 73.

Relocated Fields

As part of the changes for the new Sage 100 Direct Deposit service, the following
fields in Direct Deposit Interface Setup have been moved from the Advanced tab to
the Main tab:

e Alternate Employer ID Number
e Alternate Company Name

For more information on the service, see Sage 100 Direct Deposit Service on
page 73.

Sales Order Changes in Version 2016

Default Expiration Date for Quotes

A Default Days Until Quote Expires field has been added to the Entry tab in Sales
Order Options. The value entered in this field will be added to the Sales Order
accounting date to calculate the expiration date for quotes in Sales Order Entry.

Additional Options When Promoting Quotes

In addition to promoting quotes to standard orders in Sales Order Entry, you can now
promote them to back orders, master orders, and repeating orders.

Use Default Order Date When Promoting Quotes

The following check box has been added to the Entry tab in Sales Order Options:
Use Default Order Date When Promoting to Order

If you select this check box, the original quote date is replaced with the order date
from the Default Values for Sales Order Entry window when you promote a quote to
an order. If the check box is cleared, the original quote date is used for the order
date, as it was in past versions.
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Expanded Check Number Field

The Check Number field in Sales Order Entry and Invoice Data Entry has been
expanded to 10 characters. Only 6 characters could be entered in the field in prior

versions.
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Chapter 7

Sage 100 2020 Custom

Changes in 2015

This chapter describes the changes incorporated in the product for the 2015 release
as well as product updates released for that version. Installation and global changes
are listed first followed by module retirements.

Global Changes
Migration Changes

e If you are converting data for a company using the Purchase Order module, a
message appears asking if you want to retain purchase order history and
whether you want to create history using data in the Purchase Order data entry
files. For more information, see Purchase Order History on page 93.

e When upgrading Sage 100 Premium, you no longer have to manually copy your
company databases from the prior installation to the new one. The databases are
now automatically copied when running the Parallel Migration Wizard.

Option to Install Canadian Postal Codes

When installing Sage 100, you now have the option to install Canadian postal codes.
On the Module Selection page of the installation wizard, select Canadian Postal
Codes to install the codes. They can then be maintained in ZIP Code Maintenance.

Module Options for Printing and Exporting

The module options for Library Master now include two options related to securing
the data that appears in lookup windows and grids.

e The Allow Export to Excel from Lookups/Grids option allows the user to export
the information listed in lookup windows and grids to Excel.

e The Allow Printing from Lookup Windows option allows the user to print the
information listed in the lookup window.

Expanded Vendor Name Field

The vendor name field has been expanded to 50 characters. The field held a
maximum of 30 characters in prior versions.

e Check forms now display up to 50 characters. If you have customized check
forms, they will automatically print up to 50 characters, and long vendor names
will wrap to a second line. The customized check forms must be modified.
Otherwise, if a vendor name wraps, the city, state, and ZIP Code will not print
when two address lines are used.
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e The standard forms and reports handle the expanded field differently, depending
on the report layout. On some, vendor names that exceed 30 characters wrap to
the next line. On others, the longer names either fit on one line, or they are
truncated.

For all standard forms and reports, the vendor name field in the work table has
been expanded to hold 50 characters. You can use SAP Crystal Reports to
modify these forms to display the full name if needed.

e Test all customized forms that print the vendor name to ensure that they correctly
display names that exceed 30 characters. Be sure to check fields that include the
vendor name, such as “remit to,” “purchase name,” and so forth.

e Reports created with the Business Insights Reporter Wizard must be modified by
editing the report using SAP Crystal Reports Designer, or you can recreate the
reports using the wizard.

e Labels that include both the vendor name and address have been updated to
display a vendor name of 50 characters. Longer names will extend to a second
line.

The vendor name field for mailing labels that print in three columns remains
truncated. Also, labels that include only the vendor name, such as inventory
labels, were not updated.

e Windows and tabs that display the vendor name have been updated to display
either all 50 characters or as many as possible. For fields that do not display all
50 characters, you can use the Right Arrow key or the End key to move the
cursor within the field and view the full name. The Home key returns the cursor to
the beginning of the field.

Company-Specific Color for Window Frame Only

The Enable Company Specific Color check box on the Preferences tab in Company
Maintenance has been replaced with a drop-down list. When enabling the feature,
you can now specify whether the company-specific color will be used for the window
background, for the frame around the window, or for both.

Lookup Wizard Button Added to Lookup Windows
A Lookup Wizard button has been added to all lookup windows. Click the button to
start the User Lookup Wizard.

Clicking the Lookup Wizard button instead of the Custom button allows you to
specify which companies and users will have access to the customized lookup view.

You must have the appropriate security setup to access the Lookup Wizard button.

Stay in Current Module When Changing Company

You can now remain in the current module when switching to a different company. To
enable this feature, select the Retain Module on Company Change check box on the
Preferences tab in User Maintenance.
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Accounts Payable Changes

New Fields on User Logon Screen
The following fields have been added to the User Logon screen.

e Job Title
e E-mail Address

The fields appear if the Participate in Program check box is selected in the Sage
Product Enhancement Program window. The information will be used to help Sage
to learn more about who uses the software and to send occasional product-related
e-mails that provide information on product features and helpful tips.

Detailed Activity Log Entries for Changes to Module Setup
Options

When changes are made in module setup tasks, such as Accounts Receivable
Options, a more detailed description appears in the Activity Detail window accessed
from the Activity Log.

A new activity type, Setup Options Activity, has been created to group these events.
This allows you to easily view them when sorting by the Type column in the Activity
Log and to search for them using the Activity Log Search button.

Accounts Payable Changes

Changes in Product Update 1

The following changes were made in Product Update 1 (5.20.1).

Improved Message for Check Printing

When you attempt to print checks using a bank code that is currently being used by
someone else, the message that appears will now let you know which type of check
printing is in progress and which bank code is being used.

Check Total on Invoice Payment Selection Listing

The following information now appears at the end of the Invoice Payment Selection
Listing:

e The total number of checks that will be printed. This total includes ACH entries if
you have ACH payments enabled and you are printing remittance advices.

e The total number of checks that will not be printed. This total includes ACH
entries if you have ACH payments enabled and you are not printing remittance
advices.

e The total number of ACH entries (if you have ACH payments enabled and you
are printing remittance advices).

Changes in Version 2015

The following changes were made in Sage 100 2015.
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Ability to Reprint Quick Print Checks

In Manual Check and Payment Entry, you can now reprint checks that have been
quick printed. To reprint a quick print check, enter the check number and click the
Reprint Check button. The checks can be printed as long as they remain in the data
entry file.

Sort Report By Field for Vendor Audit Report

A Sort Report By field has been added to the Vendor Audit Report. You can now sort
the report by either the vendor number or the user logon.

Ability to Sort By Multiple Columns

A Sort Columns button has been added to the windows listed below. Click the button
to select one or more columns and specify whether to sort each one in ascending or
descending order.

e Select Invoices for Payment window (accessed from Invoice Payment Selection

e Select Check and Electronic Payment Maintenance Invoices (accessed from
Check and Electronic Payment Maintenance)

e Select Manual Check and Payment Invoices (accessed from Manual Check and
Payment Entry)

e Select Vendor Transfer Invoices (accessed from Invoice Data Entry and Manual
Check and Payment Entry)

e Select Customer Invoices (accessed through AP from AR Clearing Entry)

Purchase Vendor Transfer Invoice Selection

The Select button in the Purchase Vendor Transfer window is now available for all
vendors so that you can select multiple invoices. Previously the button was available
only if the vendor selected in the Purchase Vendor Transfer window was the same
vendor selected in Invoice Data Entry or Manual Check and Payment Entry.

Print Full Comments Selection Retained When Printing Journals and
Registers

When printing the journals and registers listed below, your choice of selecting or
clearing the Print Full Comments check box will be retained. The same choice will be
made automatically the next time you print the journal or register.

e Daily Transaction Register

e Invoice Register

e Manual Check and Payment Register

UDF Data Sources Added for Manual Check Printing

The following UDF (user-defined field) data sources have been added to
AP_CheckStubWrk for manual check printing:

e AP_InvoiceHistoryDetail
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e AP_InvoiceHistoryHeader
e AP_ManualCheckDetail

e AP_ManualCheckHeader
e AP_ManualCheckinvDetall
e GL_Account

Accounts Receivable Changes

Changes in Product Update 1

The following changes were made in Product Update 1 (5.20.1).

Purge Commission by Pay Date

A Pay Date field has been added to the select grid in the Salesperson Commission
Purge window. The field is available only if the Commissions Paid on Paid Invoices
Only check box in Accounts Receivable Options is selected.

Automatically Apply Changes to Repetitive Invoices

You can now specify whether changes to a customer’s default shipping code,
salesperson, tax schedule, or terms code made in Customer Maintenance are
automatically applied to the customer's existing repetitive invoices. To enable this
feature, select Yes or Prompt from the new Apply Changes to Repetitive Invoices
field on the Additional tab in Accounts Receivable Options.

Changes in Version 2015

The following changes were made in Sage 100 2015.

Cash Receipt List Button
A Cash Receipt List button has been added to two windows.

e In the Cash Receipts Deposit window, clicking the button lists all unposted cash
receipts. If batch processing is enabled, all unposted cash receipts for the
selected batch are listed.

e In the Cash Receipts Entry window, clicking the button lists cash receipts for the
selected deposit.

Sage Data Cloud Invoice Printing Option

A Use Sage Data Cloud for Invoice Printing check box has been added in Customer
Maintenance. When this check box is selected, the Print Invoice check box will be
cleared by default in A/R Invoice Data Entry and S/O Invoice Data Entry so that the
customer’s invoices are not printed as part of the typical invoice printing process.

This option is designed for use if you are e-mailing invoices to your customers using
Sage Billing and Payment. For more information on Sage Billing and Payment or
other solutions that leverage the power of the Sage Data Cloud, visit www.sage.com.

Page 80



Accounts Receivable Changes

Sort Report By Field for Customer Audit Report

A Sort Report By field has been added to the Customer Audit Report. You can now
sort the report by either the customer number or the user logon.

Ability to Sort By Multiple Columns

A Sort Columns button has been added to the Select Cash Receipts Invoices
window that is accessed through Cash Receipts Entry. Click the button to select one
or more columns and specify whether to sort each one in ascending or descending
order.

Calculator Button Added to Finance Charge Applied Field

A calculator button has been added to the Finance Charge Applied field in the
Finance Charge Entry window.

Ability to Filter Salesperson Commission Report by Pay Date

A Pay Date field has been added to the Selections grid in the Salesperson
Commission Report window. This field is available if the Commissions Paid on Paid
Invoices Only check box is selected in Accounts Receivable Options.

Ship Via Field Added to Customer Ship-To Address Maintenance

A Ship Via field has been added to customer Ship-To Address Maintenance. The
shipping code entered in this field will be the default shipping code for sales orders
and one-step Sales Order invoices.

Print Full Comments Selection Retained When Printing Journals and
Registers

When printing the journals and registers listed below, your choice of selecting or
clearing the Print Full Comments check box will be retained. The same choice will be
made automatically the next time you print the journal or register.

e Daily Transaction Register

e Cash Receipts Journal
e Sales Journal

Option to Keep Window Open after Print or Preview

The following check boxes have been added to several task windows used for form
printing:

o Keep Window Open After Print
o Keep Window Open After Preview

If the check boxes are selected, the window will remain open after printing or
previewing the form.

If the form is part of a printing sequence, a Print Add’l Documents button will appear
on the window. Click this button to continue with the print sequence when you have
one or both check boxes selected.
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For example, if you have the Keep Open After Print check box selected in Sales
Order Printing, after you print sales orders, the Print Add’| Documents button will be
enabled. You can then click the button to print picking sheets.

The check boxes were added to the following windows:

e Customer Mailing Labels

e Invoice History Printing

e Invoice History Printing (Quick Print)
e Invoice Printing

e Invoice Printing (Quick Print)

e Statement Printing

Bank Reconciliation

Sample Format in Positive Pay Export Wizard
A new sample format has been added to the Positive Pay Export Wizard.

Remit-To Vendor Name In Positive Pay Export File

If the Print Remit To Information check box in the Check Printing window is selected
when printing checks, the vendor name entered in Remit To Address Maintenance is
now used as the payee name in positive pay export files.

Ability to Sort By Multiple Columns

A Sort Columns button has been added to the windows listed below. Click the button
to select one or more columns and specify whether to sort each one in ascending or
descending order.

e Check Deposit and Adjustment Entry

e Reconcile Bank

Print Full Comments Selection Retained When Printing
Journals and Registers

When printing the journals and registers listed below, your choice of selecting or
clearing the Print Full Comments check box will be retained. The same choice will be
made automatically the next time you print the journal or register.

e Bank Reconciliation Transaction Register
e Daily Transaction Register
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Improved Process for Correcting Rejected Import Records

A Fix Entry button has been added to the Rejected Import Maintenance window. You
can select a transaction and click this button to open the record containing the error.

If the error exists in the line information, the Rejected Import Record - Line Edit
window opens with the applicable record selected, allowing you to bypass the
Rejected Import Record - Header Edit window.

Also, an Error Message field has been added to the window. The field displays the
message associated with the import failure.

Bill of Materials

Option to Synchronize Bill and Item Description

A Sync Bill Description and ltem Description field has been added to Bill of Materials
Options. You can select Yes, No, or Prompt to determine whether changes to the bill
description and item description fields are synchronized.

e If you select Yes and the two description fields contain the same value, an
update to one field automatically updates the other one.

e If you select Prompt and the two description fields contain the same value, a
message will appear when you update one field asking if you want to update the
other one.

This feature applies only to items that do not have an extended item description. If
the Require Bill Revisions check box is selected in Bill of Materials Options, only the
current revision is synchronized.

Print Full Comments Selection Retained When Printing
Journals and Registers

When printing the journals and registers listed below, your choice of selecting or
clearing the Print Full Comments check box will be retained. The same choice will be
made automatically the next time you print the journal or register.
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e Daily Transaction Register
e Disassembly Register/Update
e Production Register/Update

Credit Card Processing

Level 3 Credit Card Processing

You can now submit level 3 credit card transactions for payments entered in Sales
Order Entry and S/O Invoice Data Entry. (Deposit transactions are not subject to
level 3 processing because line item information is required, and there is no way to
associate specific lines with a deposit.) The following related changes have been
made.

Library Master

An ISO Country Code field has been added to the Country Code Maintenance
window. This code will be included with the ship-to address information when
processing level 3 credit card transactions.

Accounts Receivable

An Include Level 3 Data check box has been added to the Payment Type
Maintenance window.

Sales Order

The following fields have been added to the secondary grid in Sales Order Entry and
S/O Invoice Data Entry.

e Commodity Code
e AltTaxID

e Tax Type

e Net/Gross

e Debit/Credit

e Tax Amount

e Tax Rate

A Level 3 button has been added to the Credit Card tab in Sales Order Entry and
S/0 Invoice Data Entry. You can click the button to enter additional information for
level 3 transactions. An empty text string or a zero value (depending on the field
type) will automatically be transmitted for level 3 transactions if you do not enter a
value for these fields.

The new fields on the Lines tab and the Level 3 button are available only if the
following conditions are met:

e The customer’s credit card entered on the Credit Card tab is associated with a
payment type set up for level 3 processing.
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e The transaction type is Payment/PrePost Authorization.
e A value is entered in the Corporate ID/PO field.

Certain default values must be set to ensure that the fields added to the Lines tab
are available without first entering information on the Credit Card tab. For more
details and the steps required to prepare for level 3 processing, see “Setup
Customer Credit Cards for Level 3 Processing” in the help system.

Customer Purchase Order Number

When you process level 3 credit card payments, customers' purchase order
numbers will now be transmitted as part of the transactions.

The purchase order number will share the same field as the sales order or invoice
number, and they will be separated by a dash. The purchase order number will have
“PO” appended to the end. “SO” will be added to sales order numbers, and “IN” will
be added to invoice numbers.

For example: 1234567PO - 7654321IN

This information may print on customers' credit card statements; it may be truncated,
depending on the statement design.

Custom Office

User-Defined Scripts for Windows and Tabs

You can now create user-defined scripts for windows and tabs in Business
Framework modules. A script can be added to any panel that is available through
Customizer Selection. A User-Defined Scripts button has been added to the
Customizer Selection window, and it will appear when a panel is selected.

Also, a field with a drop-down list has been added next to the Compile button in the
User-Defined Script Maintenance window. Use this field to specify what type of
scripts you want to compile.

Customer Relationship Management

Changes in Product Update 1
The following changes were made in Product Update 1 (5.20.1).

Workstation Setup Not Required to Manage Relationships

If you are using Sage 100 Advanced or Premium, you no longer need to run
Workstation Setup to access Maintain Relationships within Sage CRM. To enable
this feature, go to the ERP Preferences tab in Sage CRM, and select Web Forms
Embedded in Sage CRM in the Access Sage 100 Tasks Using field. As part of this
enhancement, that field name was changed from Default Form for Quotes/Orders.
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Note that you will not have access to the Sage 100 Inquiry tasks if you use the
embedded web forms to access Sage 100 tasks.

Promote Quote to Order from Sage CRM Quote Summary Screen

A Promote to Order button has been added to the Quote Summary Page in Sage
CRM. When you click this button, the quote is promoted to an order in Sage CRM
and Sage 100. Please note that the page will not automatically refresh after you
promote a quote.

Quick Order Entry Print Options

When printing an order or quote from the Quick Order Entry screen in Sage CRM,
you can now print to any printer on your network. The Email and PDF options are
also still available.

Changes in Version 2015

The following changes were made in Sage 100 2015.

Access RMA Entry from Sage CRM

You can now access RMA Entry from within Sage CRM. An RMA Entry button has
been added to the following locations:

e The menu that appears when you right-click the New button on the left side of the
screen
e The Company Summary Page

You must be in the context of a company to access RMA Entry.

Reorganized Main Menu

The Main menu in the Customer Relationship Management module has been
reordered. The tasks now appear in the order in which you access them to set up the
module.

CRM Country Cross Reference Maintenance Task Retired

Setting up records in CRM Country Cross Reference Maintenance is no longer
required because of changes to the Sage 100 Country file. The task has been
retired. For more information, see Preexisting Codes in Country Code Maintenance
on page 90.
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Changes in Product Update 2
The following changes were made in Product Update 2 (5.20.2).

Sage Payroll Services Integration

Sage 100 is now integrated with Sage Payroll Services (formerly known as
PayChoice). You can upload general ledger account numbers and bank codes to
Sage Payroll Services and download payroll transactions into Transaction Journal
Entry.

After setting up an account with Sage Payroll Services, use the tasks on the General
Ledger Payroll Services menu to set up the integration. For detailed steps, see
Integrate an Online Payroll Service with General Ledger in the help system.

This feature will not affect anyone using the previously existing online payroll
service, BenefitMall. A Payroll Service field has been added to Sage Payroll
Services Options, which allows you to select the online payroll service you are using.
However, the correct option will be automatically selected when you upgrade from a
system that was integrated with BenefitMall.

Changes in Product Update 1
The following changes were made in Product Update 1 (5.20.1).

Out-of-Balance Message on General Ledger Detail by Source Report

If an out-of-balance source journal is included in the General Ledger Detail by
Source Report, a not-in-balance message prints next to the journal number and near
the report totals.

Changes in Version 2015

The following changes were made in Sage 100 2015.

Out-Of-Balance Message on Detail Report

If the General Ledger Detail Report is out of balance, “The Detail Report is not in
balance” now prints next to the report totals.

Sort Report By Field for Account Audit Report

A Sort Report By field has been added to the Account Audit Report. You can now
sort the report by either the account number or the user logon.

One-Click Journal Reversals

A Journal Reversal button has been added to the Transactions tab in Account
Maintenance and to the Journal Drill Down window. Click this button to perform
one-click journal reversals. The reversing entry is created, and a journal comment is
added noting the reversal. You can then review the entry in General Journal Entry
before updating it.
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A security event, Allow Journal Reversal, has been added in Role Maintenance to
enable the button.

Print Full Comments Selection Retained When Printing Journals and
Registers

When printing the journals and registers listed below, your choice of selecting or
clearing the Print Full Comments check box will be retained. The same choice will be
made automatically the next time you print the journal or register.

General Journal

Recurring Journal
Transaction Journal

Daily Transaction Register
Allocation Journal

Inventory Management

Module Options for Transaction Types

In Transaction Entry, the options available in the Transaction Type field are now
based on the user’s security setup.

The following module options have been added to Role Maintenance:

Allow Transaction Entry Adjustments
Allow Transaction Entry Issues
Allow Transaction Entry Receipts
Allow Transaction Entry Sales

Allow Transaction Entry Transfers

For existing roles, the new module options are automatically selected so that the
transaction types are allowed by default.

If you create a role for which none of the transaction types are allowed, users
assigned to that role will not be able to access Transaction Entry.

Copy From Button in Product Line Maintenance

A Copy From button has been added to Product Line Maintenance. After entering a
new product line, you can now click Copy From to copy information from an existing
product line to the new one. The new Copy From window has a Copy Accounts
check box that allows you to specify whether to copy the general ledger account
information.

Copy From Options for ltems

When using the Copy From button in Item Maintenance, you can now specify
whether to include the vendor and alias item records of the item you are copying
from.
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The vendor and alias item information is copied by default, but you can exclude it by
clearing the following check boxes that have been added to the Copy From window:

e Copy Item Vendors
e Copy Alias Items

The check boxes have also been added to the Item Maintenance On-The-Fly
window.

Source Journal Zoom Button in Iltem Maintenance

A Source Journal Zoom button has been added to the Transactions tab in Item
Maintenance. You can click the button to view detailed journal information about the
selected transaction. The journal information is available only for transactions
entered after you have upgraded from your previous version of Sage 100.

Also, a Source Journal column has been added to the transactions grid to display
the source journal number.

Sort Report By Field for Item Audit Report

A Sort Report By field has been added to the Item Audit Report. You can now sort
the report by either the item code or the user logon.

Access Bill of Materials Maintenance from Item
Maintenance

You can now go directly from Item Maintenance to Bill of Materials Maintenance by
clicking the More drop-down button in the top-right corner of the window and then
clicking BOM Maintenance.

The BOM Maintenance option is available only if the currently selected item exists as
a bill in the Bill of Materials module.

Security Options for Item Vendor Maintenance

Security options for Item Vendor Maintenance have been added to Role
Maintenance; therefore, you can now maintain different levels of security for this task
and Item Maintenance.

Last Physical Count Date Added to Item Maintenance

You can now view the date of the last physical count for an item in Item Maintenance
and Item Inquiry. The Last Physical Count Date field displays the date that the
Physical Count Variance Register was last updated. The field is view-only and has
been added to the following locations:

e Additional Tab

e Quantity Tab

e Quantities grid on the Main tab
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Preexisting Codes in Country Code Maintenance

Country Code Maintenance is now pre-populated with country codes. The codes are
the ones used in Sage CRM, as well as additional codes defined by the International
Organization for Standardization (ISO).

An Alternate Country Code field has been added to the Country Code Maintenance
window. This field, along with the others will be pre-populated with values.

As a result of this enhancement, the CRM Country Cross Reference Maintenance
task is no longer necessary and has been retired. The alternate country code in
Country Code Maintenance will be referenced by the Sage CRM integration when
data is exchanged.

State Code Required Option

A State Code Required check box has been added to Country Code Maintenance. If
this check box is selected for a country, the State field in ZIP Code Maintenance will
be a required entry when adding a postal code for the country.

Paperless Office

Access Report Viewer Directly from Report Task Windows

You can now access the Report Viewer directly from report task windows. To access
the viewer, click the drop-down button in the top-right corner of the window, and then
click Report Viewer.

When the Report Viewer opens, the current company, module, and report will be
automatically entered in the applicable fields, and the existing PDFs will appear in
the list box.

The Report Viewer option is available only if the specific report is set up in Report
Maintenance, and you must have the appropriate security set up to access it.

Updated PDF Printer Driver

The PDF printer driver used to create Paperless Office documents has been
updated.

Paperless Office Feature Added to Reports and Registers

The following reports and registers can now be printed using Paperless Office.

Accounts Payable

e Vendor Contact Listing
e Repetitive Invoice Listing
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Accounts Receivable

e Repetitive Invoice Listing
e Customer Contact Listing

Custom Office

e Customizer Summary Report
e Customizer Detail Listing

General Ledger
e Sage Payroll Services Activity Log

Inventory Management

e Item Valuation Change Register
e Standard Cost Adjustment Register
e Missing Count Card Listing

Library Master

e Role Report

e User Report

e Activity Log Report

Purchase Order

e Vendor Purchase Address Listing

Return Merchandise Authorization

¢ RMA Receivers
e Generate Transactions Listing

Sales Order
e Customer Ship-To Address Listing

Visual Integrator

e Job Listing
e Data Dictionary Listing

Payroll

Changes in Product Update 1
The following changes were added in Product Update 1 (5.20.1).

ACA Menu

An ACA menu with three new tasks related to the Affordable Care Act has been

added to the Payroll module.

e Use ACA Employee Maintenance to enter information that will appear on Form

1095-C.

e Use ACA Employer Maintenance to enter information that will appear on Form

1094-C.
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e Use the ACA Applicable Large Employer Report to generate a count of your full
time and full time equivalent (FTE) employees.

The totals can then be updated to the ACA Employer file, and they will appear in the
ALE Member Information - Monthly window accessed from ACA Employer
Maintenance.

For more information, refer to the help for these tasks.

Seasonal Employee Check Box

A Seasonal Employee check box has been added to the Wages tab in Employee
Maintenance. When printing the ACA Applicable Large Employer Report, you have
the option to include seasonal employees.

1095-C Electronic Consent Signed Check Box

A 1095-C Electronic Consent Signed check box has been added to the Tax Status
window accessed through Employee Maintenance. If this check box is selected,
1095-C forms processed through Federal eFiling and Reporting will be sent as an
electronic copy.

Changes in Version 2015

The following changes were added in version 2015.

New Fields Added to Tax Status Window

Three new fields have been added to the Tax Status window accessed from
Employee Maintenance.

e The W2 Electronic Consent Signed check box, for use with Federal eFiling and
Reporting, determines whether the employee receives an electronic or paper
W-2 form.

e The MN Reporting Unit field, for use with State eFiling and Reporting for
Minnesota, appears when MN is selected in the State field.

e The PA PSD Code field, for use with State eFiling and Reporting for
Pennsylvania, appears when PA is selected in the State field.

Perpetual Payroll History Retained by Default

When a new company is created, the Retain Perpetual Payroll History check box in
Payroll Options is now selected by default.
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Changes in Product Update 1

The following changes were made in Product Update 1 (5.20.1).

Copy from History When Creating Return

A Copy From button has been added to the Return of Goods window. You can now
enter a new return number and then click Copy From to copy information from one of
the following:

e Purchase order history (if the Retain Purchase Order History check box is
selected in Purchase Order Options)

e Purchase order receipts, with the exception of invoice receipts (if Yes or Until
Period End is selected in the Retain Receipt History field in Purchase Order
Options)

e Accounts Payable invoices (if the Post Accounts Payable Invoices check box is
selected in Purchase Order Options and the Track Detailed Invoice/Payment
History check box is selected in Accounts Payable Options)

Changes in Version 2015

The following changes were made in version 2015.

Copy Purchase Order Information

A Copy from button has been added to the Purchase Order Entry window. After
entering a new purchase order number, you can now copy information from one of
the following:

e Purchase orders

e Purchase order history (if the Retain Purchase Order History check box is
selected in Purchase Order Options)

e Purchase order receipts (if Yes or Period End is selected in the Retain Receipt
History field in Purchase Order Options)

e Accounts Payable invoices (if the Post Accounts Payable Invoices check box is
selected in Purchase Order Options and the Track Detailed Invoice/Payment
History check box is selected in Accounts Payable Options)

Purchase Order History

The following fields have been added to the History tab in Purchase Order Options
and to the Purchase Order Setup Wizard.

e Retain Purchase Order History
e Retain Deleted Orders
o Retain Deleted Lines for Orders
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Select the Retain Purchase Order History check box to retain history. When the
check box is selected, you can select Yes, No, or Prompt to define how deleted
orders and lines are handled.

If the purchase order data entry files contain records and the purchase order history
files are empty when you select the Retain Purchase Order History check box, a
message appears asking if you want to create history records. Click Yes to create
records for any standard orders, drop-ship orders, and material requisitions that exist
in the purchase order data entry files.

Option to Create History During Data Conversion

If you are upgrading from a prior version of Sage 100, before converting data you will
see a window with the same fields that were added to Purchase Order Options. You
can enable the history feature and choose whether to create history at that time.

Create Purchase Order History Utility

If you do not choose to create history records when you first select the Retain
Purchase Order History check box, you can do so later using the Create Purchase
Order History utility. This new utility has been added to the Purchase Order Utilities
menu.

Purchase Order History Inquiry

A new task, Purchase Order History Inquiry, has been added to the Purchase Order
Inquiries menu. The task is available only if the Retain Purchase Order History check
box is selected in Purchase Order Options.

Purchase Order History Report

The Purchase Order History Report has been added to the Purchase Order Reports
menu. The report is available only if the Retain Purchase Order History check box is
selected in Purchase Order Options.

When generating the report, you can select which purchase order types to print and
choose from multiple sort options. The report can be further filtered using the
selections grid.

Cancel and Reason Code Maintenance

A new task, Cancel and Reason Code Maintenance, has been added to the
Purchase Order Setup menu. The task is available only if Prompt is selected in the
Retain Deleted Orders or Retain Deleted Lines for Orders field in Purchase Order
Options.

Use this task to create reason codes for tracking why purchase orders and purchase
orders lines are deleted. The codes can be flagged as inactive so that they will not
show up in lookup results.

Codes can also be created on they fly when deleting a purchase order or line.
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New Business Insights Views

Several views related to purchase order history have been added to Business
Insights Reporter, and one related view has been added to Business Insights
Explorer.

Sort Option for Auto-Generated Purchase Orders

A Sort Purchase Order Lines By field has been added to the Generate tab in
Purchase Order Options. Use this field to determine how purchase order lines are
sorted — either by item code or by sales order line number — on the Auto-Generate
from Sales Orders Listing and in Purchase Order Entry.

Use Data Entry Email Address for Paperless Office Delivery

A Use E-mail Address in Data Entry check box has been added to the Email tab in
the Paperless Office Delivery Options window accessed from Vendor Maintenance.
The check box is available when you select either P/O Order or P/O Return in the
Document field and the E-mail check box on the Main tab.

Select this check box to email purchase orders and return orders to the vendor email
address entered in Purchase Order Entry and Return Order Entry.

Option to Keep Window Open after Print or Preview

The following check boxes have been added to several task windows used for form
printing:

e Keep Window Open After Print

o Keep Window Open After Preview

If the check boxes are selected, the window will remain open after printing or
previewing the form.

If the form is part of a printing sequence, a Print Add’| Documents button will appear
on the window. Click this button to continue with the print sequence when you have
one or both check boxes selected.

For example, if you have the Keep Open After Print check box selected in Sales
Order Printing, after you print sales orders, the Print Add’| Documents button will be
enabled. You can then click the button to print picking sheets.

The check boxes were added to the following windows:

e Purchase Order Printing

e Purchase Order Printing (Quick Print)
e Return Order Printing

e Return Order Printing (Quick Print)
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New Vendor Memo Button

A Vendor Memo button has been added next to the Vendor button in the tasks listed
below. From any tab, you can click the button to view, create, or update memos for
the currently selected vendor.

Purchase Order Entry
Receipt of Goods Entry
Receipt of Invoice Entry
Return of Goods Entry

Receipt History Inquiry
The following fields have been added to the grid on the Receipt history Inquiry Lines
tab.

e Allocated Freight
e Allocated Landed Cost
e Allocated Tax

The fields listed below have been added to the Additional Fields window that
appears when you select a line and click the Additional Information button.

Item Type
Product Type
Product Line
Costing

Calculator Button for Landed Cost Amount Field

A Calculator button has been added to the Amount field in the Landed Cost Entry
window accessed through Receipt of Goods Entry.

Document and Batch Number Added to Purchase Order Entry
Message

The message that appears in Purchase Order Entry when you select an order that is
referenced in a receipt, return, or material requisition transaction will now include the
number of the referencing transaction. If you have batch processing enabled for data
entry tasks, the batch number is also included.
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Return Merchandise Authorization

Fields Added to Ship-To Address Maintenance
A warehouse field has been added in Ship-To Address Maintenance:

The warehouse code entered in this field will be used in the data entry tasks listed
below if you select a record and enter a ship-to address.

Material Requisition Issue Entry
Purchase Order Entry

Receipt of Goods Entry
Receipt of Invoice Entry

Return of Goods Entry

Print Full Comments Selection Retained When Printing Journals and
Registers

When printing the journals and registers listed below, your choice of selecting or
clearing the Print Full Comments check box will be retained. The same choice will be
made automatically the next time you print the journal or register.

Daily Receipts Registers
Daily Transaction Register
Material Requisition Register
Return Order Register

Redisplay Source Document After Quick Printing

On the Printing tab in Purchase Order Options, you can now select whether to
redisplay the source document after quick printing in Purchase Order Entry and
Return of Goods Entry.

Calculator Button Added to Purchase Order Entry Fields

A calculator button has been added to the Unit Cost and Extension fields in
Purchase Order Entry.

Renamed Tasks and Fields

The Purge Purchases History task has been renamed Purge Purchases History by
Item and Vendor.

In Purchase Order Options, the Years to Retain Purchase History field has been
renamed Years to Retain Purchase History by Item and Vendor.

Return Merchandise Authorization
Calculator Button Added to Multiple Fields

A calculator button has been added to the Unit Price and Restocking Charge fields in
RMA Entry and RMA Receipts Entry.
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Sage Intelligence Reporting

Sage Intelligence Reporting

Updated Version of Sage Intelligence Reporting

An updated version of Sage Intelligence Reporting provides the following benefits:

Improved performance for the Financial Report Designer
Missing accounts detection

Context-specific help

Inclusion of formula’s within distributed reports

Updated report templates

For details on these enhancements, see the What’s New document in the Sage
Intelligence Reporting online help.

Security Option for Report Viewer

You can now manage access to the Report Viewer through Role Maintenance. On
the Tasks tab, a Report Viewer check box has been added under Sage Intelligence
Reporting > Reports/Forms.

Installation Process
You can now install Sage 100 without installing Sage Intelligence Reporting.

Sales Order

Ability to Reauthorize Credit Card Transactions

The Fix button is now available on the Credit Card tab in Sales Order Entry and
Invoice Data Entry if there is an expired credit card authorization for the selected
order or invoice. You can click this button to reauthorize the credit card transaction.

The Fix button is available if the Allow to Override Credit Card Authorization security
event is selected for your role in Role Maintenance.

For more information on using this feature, see Reauthorize a Credit Card
Transaction in the help system.

New Customer Memo Button

A customer Memo button has been added next to the Customer button in Sales
Order Entry and Invoice Data Entry. From any tab, you can click the new Memo
button to view, create, or update memos for the currently selected customer.

Batch Number Added to Sales Order Entry Message

If you have batch processing enabled for Invoice Data Entry, the messages that
appear in Sales Order Entry when you select an order that is being invoiced or
shipped will now include the batch number.
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Sales Order

Ability to Omit Orders On Hold When Printing

A Print Orders On Hold check box has been added to the Sales Order Printing
window. The check box is selected by default, but you can clear it to omit orders on
hold when printing. A Print Order On Hold check box has also been added to the
quick print window.

Calendar Button Added to PO Req Date Field
A calendar button has been added to the PO Req Date field in Sales Order Entry.

Calculator Button Added to Tax Amount Field

A calculator button has been added to the Tax Amount field in the Tax Detail window
accessed through Sales Order Entry and Invoice Data Entry.

Message Appears if Quantity Packed Does Not Match
Quantity Shipped

A message now appears in Shipping Data Entry and ltem Package Maintenance if
the quantity packed does not match the quantity shipped for one or more items.

Changes to Additional Fields Information

The following changes have been made for the information that is displayed in the
Additional Fields window accessed from Sales Order and Quote History Inquiry:

e Information will now appear in the Product Type, Product Line, and Price Code
fields.

e The information in the Costing field is now formatted correctly.
e Bill options now appear as they do in Sales Order Entry.

e The user logon of the person who created the sales order now appears in the
upper-right corner of the window.

Option to Keep Window Open after Print or Preview
The following check boxes have been added to several task windows used for form
printing:

o Keep Window Open After Print
e Keep Window Open After Preview

If the check boxes are selected, the window will remain open after printing or
previewing the form.

If the form is part of a printing sequence, a Print Add’'| Documents button will appear
on the window. Click this button to continue with the print sequence when you have
one or both check boxes selected.
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Sales Order

For example, if you have the Keep Open After Print check box selected in Sales
Order Printing, after you print sales orders, the Print Add’| Documents button will be

enabled. You can then click the button to print picking sheets.

The check boxes were added to the following windows:

Additional Packing List Printing

Additional Packing List Printing (Quick Print)

COD Label Printing

COD Label Printing (Quick Print)
Invoice Printing

Invoice Printing (Quick Print)
Packing List Printing

Packing List Printing (Quick Print)
Picking Sheets Printing

Picking Sheets Printing (Quick Print)
Sales Order Printing

Sales Order Printing (Quick Print)
Shipping Entry Label Printing
Shipping Label Printing

Shipping Label Printing (Quick Print)
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Chapter 8

Changes in 2014

This chapter describes the changes incorporated into the product for the 2014
release that you should be aware of. Installation and global changes are listed first
followed by module changes and retirements.

Global
Auto-Complete

An auto-complete feature has been added for customer number, vendor number,
and item code entry fields. You can now locate records by entering the customer
name, vendor name, or item description in the respective field. As you type, a list of
records matching your entry appears, and you can select a record from the list.

For example, if you have vendors named United Airways, United Paper, and United
Parcel Service, when you type united in the vendor number field, all three vendors
will appear in a list, and you can select the one that you want.

You can still select records by entering the customer number, vendor number, and
item code.

This feature is automatically enabled for all users. To disable the feature for all users,
clear the Enable Auto-Complete check box in Library Master > System
Configuration. You can also disable the feature for individual users in Library Master
> User Maintenance.

Custom Reports
The following check boxes will now appear on custom report windows:

o Keep Window Open After Print
o Keep Window Open After Preview

You can select these check boxes so that the windows do not automatically close
after printing or previewing reports.

Default Column Name in Search Grid Window
To make searching easier when using the Search Grid window, the default value in

the Column Name field is now the first column in the grid.

For example, in Check, Deposit and Adjustment Entry, when you click the Find Row
button to open the Search Grid window, Check No. is now the default value in the
Column Name field.
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Accounts Payable

MAS Office Button

The MAS Office button has been removed from the Job Cost, Payroll, Material
Requirements Planning, and Work Order modules.

Accounts Payable

Invoice List Button in Invoice Data Entry

An Invoice List button has been added to the Invoice Data Entry window. You can
now click that button to view a list of all invoices in the data entry table.

Repetitive Invoice List Button in Repetitive Invoice Entry

A Repetitive Invoice List button has been added to the Repetitive Invoice Entry
window. You can now click that button to view a list of all invoices in the data entry
table.

Form 1099 Filing

The Form 1099 eFiling and Reporting task, which is located on the Reports menu, is
now the only option available for electronic filing of 1099 forms. The Electronic
Reporting module has been retired.

Accounts Receivable

Repetitive Invoice List Button in Repetitive Invoice Entry

You no longer have to select a customer before selecting a repetitive invoice in
Repetitive Invoice Entry. You can now click the Repetitive Invoices button to view
and select from a list of repetitive invoices.

General Ledger

Keep Financial Reports Window Open

A Keep Window Open check box has been added to the Financial Reports window.
If you select that check box, the Financial Reports window will no longer
automatically close after clicking Proceed and then closing the Print Financial
Reports window.

Two check boxes have been added to the Print Financial Reports window:
o Keep Window Open After Print
o Keep Window Open After Preview

You can now select these check boxes so that the window does not automatically
close after printing or previewing reports.
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Library Master

é NOTE
The Payroll
module is not
available for
Sage 100
Premium.

Library Master

Report Manager

The following fields have been removed from the New Report window that appears
when creating a new report in Report Manager:

e Report Type

e Report Master Name

By default, Crystal Report is the only available report type.

System Configuration
The Web Services tab has been renamed; it is now the Preferences tab.

User Maintenance
Two fields, Email and Job Title, have been added to the User Maintenance window.

Payroll

Employer Medical Assistance Contribution (MAC) fields

Employer Medical Assistance Contribution (MAC) fields have been added to P/R Tax
Table Maintenance. The fields appear when Massachusetts is entered in the State
field. You can enter a rate for the Employer MAC, but the accrual account, limit, and
limit type fields display what you have entered for the unemployment tax and can
only be viewed.

The Employer MAC amount is included with the unemployment tax on the
Employer’s Expense Summary, but it is separated into its own column on the
Quarterly Tax Report.

Electronic Form Filing

The Federal eFiling and Reporting and State eFiling and Reporting tasks, located on
the Payroll Period End menu, are now the only options available for electronically
filing payroll tax forms. The Electronic Reporting module has been retired.

W2 Puerto Rico Mapping E/D Codes

The W2 Puerto Rico Mapping E/D Codes task has been renamed W2 Puerto Rico
Mapping Maintenance. Also, the task has been relocated to the Payroll Setup menu.
The task was previously part of the Electronic Reporting module.
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Sage Intelligence Reporting

Sage Intelligence Reporting

Installation

The Sage Intelligence Reporting installation program is now part of the Sage 100
Workstation Setup program. Sage Intelligence Reporting is automatically installed
when you run Workstation Setup and select the Typical installation option.

Access within Sage 100

Sage Intelligence Reporting is now accessed from the Sage 100 Module Menus
toolbar and the Tasks tab.

Excel 2010 and Excel 2013 64-Bit Support

Sage Intelligence Reporting is now compatible with the 64-bit version of Excel 2010.

.NET Framework 4.0

Sage Intelligence Reporting has been upgraded to .NET Framework 4.0, resulting in
smoother integration with Excel and faster installation time if NET Framework 4.0 is
already installed.

User Interface and Usability Improvements

Numerous enhancements were made to Sage Intelligence Reporting to make the
product more efficient and easy to use. These improvements include the following:

User Interface

e Report Manager menu items have been reorganized to make commonly used
features easier to find. The most commonly used items are grouped on the
Home and Help tabs. Less frequently used items are grouped on the File and
Tools tabs.

e Connector menu items have been reorganized; more commonly used items are
now available on the File, Home, and Help tabs. Less commonly used features
are now on the Tools tab.

e The locked report screen and the Unlock on Copy screen have been updated to
display information in a more user-friendly manner.

Report Designer

e The new Report Designer Add-in gives you better control over reporting layouts.
You can now break reports into reusable pieces and reassemble them in different
configurations to create new reports.

e You can now maximize the Report Designer window.

e Rows and columns are now ordered alphabetically, and they are easier to
rearrange. Also, larger fonts are now used, and the row and column placeholder
bars within the selected row and column layout are now wider to accommodate
longer field names.
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Sage CRM

e You can now insert column or row fields at a specific location within your layout
instead of inserting it at the end of the column or row and then moving it.

e Text columns added to a layout are now automatically resized based on their
content.

e You can now add and delete row reporting groups from within the Mapping Tool.

Report Manager

e The columns that appear in Report Manager when a report is selected are now
automatically resized so that all text with the columns is visible.

e When importing a report that includes a container with the same name as an
existing container, you can now rename the container to avoid having two
containers with the same name.

e The right-click menus have been simplified and more intuitive labels have been
added. The options that have been removed are still available on the Report
Manager Ribbon.

Report Viewer
e The Report Viewer now remains open after running a report.

e A minimum window size has been set for the Report viewer so that all available
reports are visible.

Sage CRM

Sage CRM customization has been enhanced to take advantage of the new features
in Sage CRM 7.2. For more information, review the Sage CRM 7.2 Installation and
Upgrade Guide.

Retired Modules

The Electronic Reporting module has been retired.
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Chapter 9

Changes in 2013

This chapter describes the changes incorporated into the product for the 2013
release that you should be aware of. Installation and global changes are listed first
followed by module changes and retirements.

Global Changes

64-Bit ODBC Driver

A 64-bit ODBC driver, which allows third-party 64-bit applications to access
Sage 100 data, is now available. The installation program for the driver can be run
from the Sage 100 — Applications installation program.

ALE Lookups in Data Entry Windows

You can now select whether to display or hide inactive customers and vendors in
some ALE lookups. These options can be selected in Company Maintenance.

Feedback Form in Help System

A feedback form has been added to all Help System topics. You can now indicate
whether a topic is helpful and provide anonymous feedback that will be used to
improve product documentation.

Installation Changes

When uninstalling Sage 100, your company data is no longer deleted. To remove
the data, you must manually delete it from the MAS90 folder.

Native SData Provider

You can now use SData, an HTTP-based communication protocol, to communicate
with the workstation, server, and web-based applications, as well as third-party
applications and the World Wide Web.

SData is enabled in System Configuration, and security is assigned by role for each
user in Role Maintenance.

Report Changes

You can no longer e-mail report data when selecting the Export option in the
Printer/Output field in report windows. For information on e-mailing a report using
Paperless Office functionality, see E-mail, Fax, or Print a Report as a PDF in the
Help system.
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Accounts Payable Changes

SAP® Crystal Reports®

SAP Crystal Reports 2011 is now included with Sage 100. Enhancements in version
2011 include a .NET runtime engine component, the ability to export directly to an
Excel .xIsx file, Adobe Flash integration, built-in bar code support, and enhanced
SAP Crystal Reports Designer features.

Sage Advisor Update

You can now keep your Sage products up to date with the latest releases and
updates. Sage Advisor Update reviews the Sage products you have installed on
your server and lists the online updates available for download.

Sage Advisor Update is automatically installed and can be launched from your
Program Files > Sage folder, and from the icon located in the system tray. For more
information, see the Sage 100 Installation and System Administrators Guide.

Installing with Microsoft Windows Installer (MSI)

Sage 100 is now installed using Microsoft Windows Installer (MSI). MSI will provide
a single installation per version on your system; multiple instances cannot be
installed.

Verify Account Information

You no longer have to enter information in the Verify Account Information window
when verifying information for the following tasks:

e 1099 eFiling and Reporting
e Federal eFiling and Reporting
e State eFiling and Reporting

The required information will automatically be transmitted when you click OK.

Accounts Payable Changes

Expanded Accounts Payable Invoice Number

e The invoice number field is now expanded to 20 characters, from 10 characters
in previous releases.

e Reports and listings now display the full invoice number while retaining the
portrait orientation. Journals, register, updates, inquiries, lookups, explorer
views, and data entry programs will also display the full invoice number.

e The 20-character invoice number can be viewed in the Job Cost and General
Ledger comments on reports.

e The full invoice number will be printed on the check stubs.
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Accounts Payable Changes

Inactive Vendors

In Vendor Maintenance, the Temporary check box has been replaced with a
Vendor Status drop-down list that contains Active, Inactive, and Temporary
statuses. The Inactive option allows you to prevent users from selecting inactive
vendors in the following tasks:

AP from AR Clearing Entry

Check and Electronic Payment Maintenance
A/P Invoice Data Entry

Manual Check and Payment Entry

A/P Repetitive Invoice Entry

Salesperson Maintenance

Item Maintenance

Job Masterfile Maintenance (for cost codes only)
Job Posting Entry (for direct costs only)
Purchase Order Entry

Receipt of Goods Entry

Receipt of Invoice Entry

Return of Goods Entry

RMA Entry

RMA Receipts Entry

Sales Order Entry

S/0 Invoice Data Entry

Work Order Transaction Entry (for outside processing charges only)

O O 0O OO OO0 OO OO0 O O O OO0

A new field, Inactive Reason, has been added to the Additional tab in Vendor
Maintenance. Use this field to add a reason code for an inactive vendor.

A new Inactive Status Exception List window allows you to view and print a list of
reasons why the vendor status cannot be changed to Inactive. You can also drill
down to the source document, if applicable. This window appears after clicking
Details if a message dialog box warns you that the vendor status cannot be
changed.

A change to a vendor’s status will appear on the Vendor Audit Report if All or
Changes is selected in the Vendor Changes to Track field on the History tab in
Accounts Payable Options.

A security event has been added to allow the selection of inactive vendors in
Check and Electronic Payment Maintenance and to allow the selection of
inactive vendors’ invoices in Invoice Payment Selection.

You can now select to include or exclude inactive vendors from Vendor Listing,
Vendor Listing with Balances, and Vendor Mailing Labels.

A new column, Status, has been added to some ALE vendor lookups. This field
allows you to group and filter inactive, temporary, and active vendors.
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Accounts Receivable Changes

A new task, Inactive Reason Code Maintenance, has been added to the Setup
menu. This task allows you to create reason codes for inactive vendors. A
pre-defined reason code, OUTOB (Out of Business), has been added and
cannot be deleted.

These reason codes are shared with the Accounts Receivable module for use
with inactive customer records. The Inactive Reason Code Maintenance task is
also available on the Accounts Receivable Setup menu and the Common
Information Main menu.

A new utility, Remove Inactive Vendors, has been added to the Utilities menu.
This utility allows you to delete inactive vendors.

In Vendor Maintenance, the Temporary Vendor check box has been replaced
with a Vendor Status drop-down list and moved to the Additional tab. You can
now select a status of Active, Inactive, or Temporary.

Active has now replaced Permanent as a vendor status. Any permanent vendors
are converted to active vendors during data conversion.

View Cleared Checks in Vendor Maintenance

Two new fields have been added in Vendor Maintenance that will allow you to
view check status information on checks that have cleared the bank in Bank
Reconciliation. The ability to view the cleared checks in Vendor Maintenance can
be enabled on the Main tab in Accounts Payable Options if the Accounts Payable
module is integrated with Bank Reconciliation. Viewing cleared checks in Vendor
Maintenance applies only to checks processed in version 2013 or higher.

You can now post ACH electronic payments in detail to the Bank Reconciliation
module. This feature is enabled in Accounts Payable Options if Accounts
Payable is integrated with Bank Reconciliation.

Accounts Receivable Changes

Inactive Customers

In Customer Maintenance, the Temporary check box has been replaced with a
Customer Status drop-down list that contains Active, Inactive, and Temporary
statuses. The Inactive option allows you to prevent users from selecting inactive
customers in the following tasks:

AP from AR Clearing Entry

Cash Receipts Entry

Finance Charge Entry

A/R Invoice Data Entry

Repetitive Invoice Entry

User ID Maintenance

Job Billing Data Entry

Job Estimate Maintenance

Job Masterfile Maintenance (for open jobs only)

O 0O 0O OO O O OO
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Accounts Receivable Changes

Material Requirements Planning
Maintain Projected Demands
RMA Entry

RMA Receipts Entry

S/0 Invoice Data Entry

Sales Order Entry

O O 0O 0 0O

A new field, Inactive Reason, has been added to the Additional tab in Customer
Maintenance that allows you to add a reason code for the inactive customer.

A new Inactive Status Exception List window allows you to view and print a list of
reasons why the customer status cannot be changed to Inactive. You can also
drill down to the source document, if applicable. This window appears after
clicking Details if a message dialog box warns you that the customer status
cannot be changed.

A change to a customer’s status will appear on the Customer Audit Report if All
or Changes is selected in the Customer Changes to Track field on the History tab
in Accounts Receivable Options.

A security event as been added to allow the entry of an inactive customer when
adding a line in Cash Receipts Entry.

You can now select to include or exclude inactive customers from Statement
Printing, Customer Listing, Customer Listing with Balances, and Customer
Mailing Labels.

A new column, Status, has been added to some ALE customer lookups. This
field allows you to group and filter inactive, temporary, and active customers.

A new task, Inactive Reason Code Maintenance, has been added to the Setup
menu. This task allows you to create reason codes for inactive customers.
Additionally, an OUTOB (Out of Business) pre-defined reason code has been
added and cannot be deleted.

These reason codes are shared with the Accounts Payable module for use with
inactive vendor records. The Inactive Reason Code Maintenance task is also
available on the Accounts Payable Setup menu and the Common Information
Main menu.

A new utility, Remove Inactive Customers, has been added to the Utilities menu.
This utility allows you to delete inactive customers.

In Customer Maintenance, the Temporary Customer check box has been
replaced with a Customer Status drop-down list and moved to the Additional tab.
You can now select a status of Active, Inactive, or Temporary.

Active has now replaced Permanent as a customer status. Any permanent
customers are converted to active customers during data conversion.

Sage 100 2020 Customer Upgrade Guide Page 110



Accounts Receivable Changes

Credit Card Processing

You can now integrate with Sage Exchange to secure your customers’ credit card
numbers in a Sage Exchange Vault account, which is a PCl-compliant location for
storing sensitive credit card and banking information.

For an overview of this enhancement, see Credit Card Processing Changes on
page 113.

Included in the numerous Accounts Receivable changes:
e You can now process credit card transactions in A/R Invoice Data Entry.

e In Repetitive Invoice Entry, you can store credit card transactions to be
processed when the invoice is processed.

e You can swipe credit cards for payment acceptance.
e You can process credit card transactions in a batch.

e You can view credit card payment information in the Payment Information
window for a selected invoice.

e Printed invoices now reflect credit card payments.

e Because credit card numbers are no longer stored in Sage 100, the following
fields have been removed:

o The Purge Credit Card Data field in A/R Period End Processing

o The Days to Retain Credit Card History field in Accounts Receivable Options
(previously used in conjunction with the purging of credit card data during
period end processing)

The following sections list additional changes separated by task.

Payment Type Maintenance

e The Show Validation Code Verification and Show Address Verification check
boxes have been combined and renamed Show Address and CVV Verification.

e The Merchant ID field has been renamed Merchant Account.

e The following fields have been added for entering Sage Exchange account
information.

o Virtual Terminal ID
o Merchant Key

e The following fields have been removed; the settings are now defined in Sage
Exchange.

o Validation Code Length
o Require Validation Code
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Accounts Receivable Changes

The following PCCharge related fields have been removed:

o Credit Card Processor Code
o Processor Type

Customer Maintenance

In Customer Maintenance, a Card ID field has been added to the Additional tab

for entering a unique card ID number to identify credit card records. You can now
add a credit card on the fly by typing a new card ID number in this field to launch
Customer Credit Card Maintenance.

The CC Number field has been removed. Credit card numbers are now entered
in the Sage Exchange Vault window, accessed from Customer Credit Card
Maintenance.

The CC Pymt Type field has been renamed Payment Type.

Customer Credit Card Maintenance

The Add New Card button has been added to open the Sage Exchange Vault
window for adding a credit card number and expiration date.

The Edit Card button has been added to open the Sage Exchange Vault window
for editing the expiration date of the current credit card record.

The CC Pymt Type field has been renamed Payment Type.
The Card Number field has been removed.

A Card ID field has been added, which allows you to enter a card ID number to
identify a credit card.

The following view-only fields have been added; they display information for
credit cards entered in the Sage Exchange Vault.

o Card Type
o Last Four Digits

The Expiration Date is now a view-only field; it displays the expiration date for the
credit card number entered in the Sage Exchange Vault window.

The following fields have been added:

o Address (second line)
o Country
o E-mail Address

Reports

The Print Formatted Credit Card check box has been removed from the following
Accounts Receivable report windows. The last four digits of the credit card number
will still appear on the reports.
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Bank Reconciliation Changes

e Customer Listing
e Customer Credit Card Listing

e Deposit Transaction Report

Bank Reconciliation Changes

e A new field, Cleared Date, has been added to all data entry tasks in this module.
You can enter a date when the check has cleared the bank if the date is different
than the module default date. The cleared date can be viewed in registers and
reports when reconciling the bank statement. The field is available for inclusion in
Auto Check Reconciliation check settings.

e ACH electronic payments can now be listed in Reconcile Bank and Check,
Deposit and Adjustment Entry based on the selection made in Accounts Payable
Options. If the option is selected, ACH payments will be listed on the Checks tab.
If the option is cleared, one posting will be listed on the Dep/Adjust tab.

Common Information Changes

A new task, Inactive Reason Code Maintenance, has been added to the Main menu.
This task allows you to create reason codes for inactive customers and vendors.
Additionally, an OUTOB (Out of Business) pre-defined reason code has been added
and cannot be deleted.

Credit Card Processing Changes

Integrated credit card processing is now available exclusively through Sage
Payment Solutions via Sage Exchange. PCCharge is no longer integrated with
Sage 100.

With Sage Exchange, credit card numbers are stored in the Sage Exchange Vault.
Credit card numbers are no longer stored in Sage 100; only the last 4 digits are
stored. Therefore, credit card encryption is no longer required in Sage 100.

If credit card numbers were stored in the prior version of your software, and you
were not processing transactions using Sage Exchange, the credit card numbers will
be transferred into a Sage Exchange Vault-only account, which cannot be used for
processing transactions. The Vault-only account is automatically created during data
conversion, and it can be converted to a processing account. To convert the
account, contact your Sage Payment Solutions account executive or your Sage
business partner.

For information on Accounts Receivable changes related to this enhancement, see
Credit Card Processing on page 111.

For information on Library Master changes related to this enhancement, see Credit
Card Processing on page 116.

For information on Sales Order changes related to this enhancement, see Credit
Card Processing on page 117.
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Customer Relationship Management Changes

AWARNING

Verify that any
existing
PCCharge credit
card transactions
have been
updated to the
general ledger.

PCCharge

The Sage Payment Solutions Gateway does not recognize outstanding
pre-authorizations performed with other processors that previously used PCCharge
Payment Server. Sales are processed through Sage Exchange as though no
pre-authorization was performed. The available credit for your customers is reduced
by the pending pre-authorization amount until the date of pre-authorization
expiration.

If you have existing PCCharge credit card transactions, verify that all transactions
entered in Accounts Receivable Cash Receipts Entry and Sales Order Invoice Data
Entry have been updated to the general ledger.

If you have existing PCCharge credit card transactions, print the Accounts
Receivable Credit Card Settlement Report to balance the settlement batches for the
PCCharge processor. PCCharge settlement data will no longer be included in the
Credit Card Settlement Report.

Customer Relationship Management Changes

Automatic Installation of Module

The Customer Relationship Management module is now automatically installed with
Library Master and no longer has to be activated. Previously, you were required to
install the module separately and activate it in Company Maintenance.

Use of Sage 100 License

Launching a Sage 100 task from Sage CRM no longer uses a Sage 100 license.

Multiple-company Integration with Sage CRM

You can now integrate multiple Sage 100 companies with one instance of Sage
CRM, or you can continue using multiple instances of Sage CRM. If you were
previously using multiple instances of Sage CRM for integration with multiple
Sage 100 companies, see the Installing Sage CRM chapter in the Sage 100
Installation and System Administrator’s Guide.

The following changes related to that enhancement have been made in the
Customer Relationship Management module.

e The CRM Options task as been replaced with two new tasks on the Customer
Relationship Management Main menu: CRM Server Options and CRM Company
Options.

o Use CRM Server Options to define settings for each instance of Sage CRM.

o Use CRM Company Options to define company-specific settings for each
company linked to Sage CRM.

e CRM Activity Log data can now be sorted and filtered by the Sage 100 company
code and Sage CRM instance ID.
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Inventory Management Changes

e When running the Purge CRM Activity Log utility, you can now purge data for a
specified Sage 100 company and Sage CRM instance ID or for all companies
and instance IDs.

e When running the Purge CRM Order/Quote Tracking utility, you can now purge
data for a specified Sage 100 company code or for all companies.

e When generating the CRM Activity Log, you can now select data based on the
Sage 100 company code and Sage CRM instance ID.

e A Sage 100 Company Code field has been added to the following windows,
which are accessed from Sage CRM.

Create New Sage CRM Quote
Create New Sage CRM Order
Create Relationship

Maintain Relationship

Promote Company to Customer

O O 0 0 O°

e The CRM Country Maintenance task has been renamed CRM Country Cross
Reference Maintenance.

e When creating a sales order or quote within Sage CRM, a Sage 100 company
must now be selected.

Quick Order Entry

In Sage 100 Advanced and Premium, you can now install and use Quick Order Entry
to enter and edit sales orders and quotes in Sage CRM. This task has the essential
fields and functionality available in Sales Order Entry. Some fields and functionality
have been omitted to streamline the data entry process.

Orders and quotes can be printed to PDF and sent as e-mail attachments from
Quick Order Entry. The location for storing the PDF files and the URL for viewing
them are entered in the Reports Folder and Reports Portal fields in CRM Company
Options.

You can elect to use either Quick Order Entry or the standard Sales Order Entry
window by selecting an option in the Default Form for Quotes/Orders field on the
Sage 100 Preferences tab in Sage CRM. You must have the appropriate security set
up in Sage 100 to access the new window.

For information on installing Quick Order Entry, see the Installing Sage CRM chapter
in the Sage 100 Installation and System Administrator’s Guide.

Inventory Management Changes

In Item Maintenance, a Quantities grid has been added to the Main tab. The grid
allows you to view the quantity detail information for the selected item and all
warehouses. You can click the Quantity Recap button to view a recap for all
warehouses or the selected warehouse. Additionally, the following fields have been
moved to the Additional tab to accommodate the Quantities grid.
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Library Master Changes

o Allow Back Orders
e Allow Trade Discounts
e Allocate Landed Cost

e Inactive Item

Library Master Changes

Web Reports Server

The Web Reports Server Name field and the Web Reports Virtual Directory field
have been removed from Company Maintenance. Web Reports Server is no longer
supported.

Credit Card Processing

Several changes were made as part of the credit card enhancements. The following
sections list these changes separated by task.

Company Maintenance

The following credit card related changes have been made in Company
Maintenance:

e The Servers tab has been renamed to Credit Cards tab.

e The Enable Credit Card Payment Server field has been replaced with the Enable
Credit Card Processing check box; selecting this check box enables credit card
processing through Sage Exchange.

e The Enable Batch Authorizations check box has been replaced with the Default
Transactions to Process in Batch check box. If this check box is selected, credit
cards are batch processed by default in Accounts Receivable and Sales Order.

e The following PCCharge related fields have been removed:

o Use Default Server Settings

IP Address

Port

Path

Force Reconnect for Each Authorization

O O O o

e Two new fields, Vault-Only ID and Vault-Only Key, will appear on the Credit
Cards tab if a Vault-Only account is created to store credit card numbers. The ID
and key will automatically be entered in these fields.

e The Credit Card Encryption button has been removed.

User Maintenance
The following check boxes have been removed from the Preferences tab:
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Paperless Office Changes

e Display Formatted Credit Card
e Print Formatted Credit Card

Role Maintenance

e A security event has been added to allow users to override the credit card
information for Accounts Receivable and Sales Order credit memos.

e A module option has been added that allows users to add new credit card
numbers and edit the expiration date for existing credit card numbers on file.

The following security events have been removed:

e Allow Access to Credit Card Encryption in Company Maintenance
e Allow Deleting of Public Key

e Allow Purging of Credit Card Audit Log

Credit Card Audit Log
Credit Card Audit Log has been removed from the Library Master Reports menu.

Administrative Tools

The Change Credit Card Encryption Key Phrase button has been removed from the
Administrative Tools window.

Paperless Office Changes

You can now use Simple Mail Transfer Protocol (SMTP) authentication to send
e-mail messages. This includes Transport Layer Security (TLS) and Secure Sockets
Layer (SSL) mail services to encrypt the communication between the client and
server and protect sensitive company information. This option can be enabled in
Company Maintenance.

Sales Order Changes
Credit Card Processing

You can now integrate with Sage Exchange to secure your customers’ credit card
numbers in a Sage Exchange Vault account, which is a PCl-compliant location for
storing sensitive credit card and banking information.

For an overview of this enhancement, see Credit Card Processing Changes on
page 113.

The following changes were made as part of the credit card processing
enhancement:

e You can now swipe credit cards for payment acceptance.
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Visual Integrator Changes

e Credit cards transactions can now be processed in a batch.
e Printed sales orders and invoices now reflect credit card payments.

The following sections describe additional changes separated by task.

Sales Order Entry

e You can now obtain a pre-authorization for an amount that is greater or less than
the order amount.

e The Payment Type field on the Totals tab has been renamed Deposit Payment
Type to avoid confusion with the Payment Type field on the Credit Card tab.

e The Deposit check box, Credit Card Number field, and Credit Card Information
button have been removed from the Totals tab.

S/O Invoice Data Entry

e The Payment Type field on the Totals tab has been renamed Deposit Payment
Type to avoid confusion with the Payment Type field on the Credit Card tab.

e The Deposit check box, Credit Card Number field, and Credit Card Information
button have been removed from the Totals tab.

Visual Integrator Changes

The option to export fully formatted credit card numbers has been removed from the
Export Job window.

Visual Process Flows

Visual process flows are interactive workflow diagrams that show the steps to
complete a task or process. Elements on the process flows are linked to Sage 100
tasks; clicking an element starts the linked task. Other actions, such as showing or
hiding objects on the process flow, can also be assigned to elements.

Seven predefined process flows are available on the Visual Process Flows
submenus. You can use these predefined process flows as templates to create your
own customized process flows, which appear on the Custom Process Flows menu in
the applicable modules.

The Visual Process Flows Manager task, located on the Visual Process Flows Setup
menu, allows you to create, copy, and delete custom process flows, modify their
settings, and open them in the Visual Process Flow Designer.

Internet Explorer version 8 or higher and Adobe Flash Player are required to use the
process flows.

Retired Modules

The Business Alerts Professional module has been retired as of version 2013.
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Module PDFs

Module PDFs

The Module PDFs that contained the overview topics for Sage 100 tasks are no
longer accessed in the Help system; they are now accessed through the Resources
page on the Desktop.
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Chapter 10

Changes in 4.50

This chapter describes the changes incorporated into the product for the 4.50
release that you should be aware of. Installation and global changes are listed first
followed by module changes and retirements.

Global Changes

Choose an Installation Option

You now have the option to perform an in-place or parallel upgrade installation. If you
select to perform a parallel upgrade, use the Parallel Migration wizard to move your
data. An in-place installation can only be performed for version 4.40.

The following products are now available on one DVD:

Sage 100 Standard

Sage 100 Advanced

Sage 100 Premium

Sage CRM

eBusiness Manager

eBusiness Web Services

Federal and State eFiling and Reporting
SAP Crystal Reports® Designer

Security Requirement

You are now required to set up security for your Sage 100 system. When installing
the software, you are now required to create an Administrator password. Each user
must have a user logon created in User Maintenance in order to access the system.

Participate in the Product Enhancement Program

You can now participate in the Product Enhancement Program (PEP). Through PEP,
Sage collects information that will help Sage identify trends and usage patterns to
improve the quality of the products and services we offer. Sage will not collect
sensitive information such as financial information or information on individual
transactions.

When installing or upgrading to a new version of Sage 100, you will be automatically
enrolled in PEP. You can opt out at any time using the Product Enhancement
Program window accessed through the Administrative Tools window.
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Accounts Receivable Changes

Retain Report and Form Printer Information Setting

You can now retain report and form printer information by workstation ID and form
code. This new functionality enables multiple users to save the printer information
specific to their workstation ID when selecting a form code or report setting.
Previously, the printer used by the last user of a form code or report setting was
saved for the next user.

Manage Your System Window

The Manage Your System Window no longer appears when starting your Sage 100
system. The tasks that were available through this window, Company Maintenance,
Role Maintenance, and User Maintenance, can be accessed from the Library Master
Main menu or through the Administrative Tools window, which appears when you log
on using the Administrator account.

Accounts Receivable Changes

Create National Accounts

A new feature has been added that allows you to create national accounts. National
accounts allow you to create relationships between a bill-to account and its sold-to
customers. Various fields have been added to Accounts Receivable Options that
enable the use of national accounts.

e Use the new Bill To Customer Maintenance task on the Accounts Receivable
Setup menu to set up relationships between a national account and its sold-to
customers. Any customer can be a national account or be a member of a
national account.

e Use the new Bill To/Sold To Maintenance task accessed from the Customer
Maintenance window to create tiers of bill-to and sold-to customers.

e You now have the option to print bill-to/sold-to information on various reports and
forms. Additionally, bill-to/sold-to information can be printed in Statement
Printing.

Define Default Price Levels by Customer and Product Line

A new feature has been added that allows you to define default price levels by
customer and product line. Default price levels for the customer can be set up by
product line only, a combination of product line and price code, or product line and
ship-to code. Two fields have been added to Sales Order Options that enable the
default price level by customer and product line feature based on price codes or
ship-to codes.

e A new task, Price Level by Customer Maintenance, accessed from either the
Accounts Receivable Setup menu, from Customer Maintenance, or from Product
Line Maintenance, allows you to establish default price levels to use when
entering sales orders and one-step sales order invoices.
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Bar Code Changes

e You can copy all or specific product line/price level records from a customer to
one or multiple customers using the new task, Price Level by Customer Copy, on
the Accounts Receivable Setup menu, or by using the Copy button in Price Level
by Customer Maintenance. You can also copy from a customer with existing
records to a single customer by selecting Price Level from the drop-down menu
in Customer Maintenance to open Price Level by Customer Maintenance and
clicking Copy From.

e A new report, Customer Pricing Report, has been added to the Accounts
Receivable Reports menu that allows you to produce a list of customers’ special
pricing and discounts, including customers that have been set up with product
line/price level records.

Purge Credit Card Data During Period-End Processing

You can now define what credit card data is purged during Accounts Receivable
period-end processing and year-end processing. A new field in the Period End
Processing window allows you to purge either data for expired credit cards only,
credit card history only, expired credit card data and credit card history, or you can
choose to not purge any credit card information.

Define Split Commissions by Customer

You can now define default percentage values for distributing sales order and
invoice commissions among salespersons on a per-customer basis. Clicking the
new Split Comm button in Customer Maintenance opens the Customer Split
Commission Maintenance window, which allows you to distribute commissions
among a maximum of five salespersons. The default values defined in this window
appear in the Split Commission Entry window accessed through Sales Order Entry
and Sales Order Invoice Data Entry, but they can be changed.

The Split Comm button is available in Customer Maintenance if the Split
Commissions Between Salespersons check box is selected in Sales Order Options.

Recalculate Open Order Amounts

The Recalculate Open Order Amounts utility has been added to the Accounts
Receivable Utilities menu. This utility allows you to recalculate the open order
amounts from the Customer file for all customers based on open orders in the Sales
Order data entry tasks.

Bar Code Changes

Print Lot/Serial Distribution Information

New fields in Sales Order Options allows you to enable lot/serial distribution for
sales orders. When enabled, you now have the option to print the lot/serial number
and distribution on sales orders and picking sheets.
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Inventory Management Changes

Inventory Management Changes

Inactive Iltems

In ltem Maintenance, an Inactive Item check box has been added that allows you to
prevent users from selecting inactive items in certain data entry tasks. The following
data entry tasks check for inactive items as noted:

e In Sales Order Entry, Sales Order Invoice Data Entry, Purchase Order Entry,
Receipt of Goods Entry, Receipt of Invoice Entry, and Material Requisition Issue
Entry, an inactive item cannot be entered when adding a new line.

e In Return of Goods Entry and Inventory Management Transaction Entry, an
inactive item cannot be entered when adding a new line without the appropriate
security setup.

e In RMA Entry and RMA Receipts Entry, an inactive item cannot be selected as a
replacement item.

e In Shipping Data Entry, an inactive item cannot be selected as an alternate item.

An Inactive Item check box has also been added to the Product Line Maintenance
window, which allows you to have the Inactive Item check box in ltem Maintenance
selected by default for new items added to a product line. You can also use the
Apply Product Line Information window to apply the Inactive ltem check box
selection to existing items in Iltem Maintenance.

You can now elect to include or exclude inactive items from most Inventory
Management reports.

View Lot/Serial Distribution Information

e In Item Maintenance/ltem Inquiry, on the Cost Detail tab, you can now view the
committed quantities to various data entry tasks as well as the quantity available
if the Lot/Serial Distribution feature in Sales Order Options is enabled.
Additionally, on the Orders tab, you can now view the order detail by lot/serial
number when clicking the View/Lot Serial button.

e A new Lot/Serial Order Detail window has been added to the drop-down menu in
Item Maintenance/ltem Inquiry. This window displays the lot/serial distribution
(including available quantities) for the selected item as well as the distribution
already assigned to sales orders and the sales order items still waiting to be
distributed.

e You now have the option to print lot and serial distributions from sales orders on

the Stock Status Report, Open Sales Order Report, Open Orders by Item Report,
Open Orders by Promise Date Report, and Open Orders by Job Report.
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Library Master Changes

é NOTE

The alternate
directory feature
is not available
for Sage 100
Premium.

& NOTE
The Payroll
module is not
available for
Sage 100
Premium.
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Library Master Changes

Define Credit Card Security Options

Two new preferences have been added in User Maintenance to allow you to
designate users that can print or display fully formatted credit card numbers.
Users without those preferences will see only the masked credit card number.

Two new security event roles have been added in Role Maintenance to allow you
to designate which roles can change or delete the key used to encrypt credit card
numbers. Industry standards recommend that you change this key at least
annually to enhance security of the encrypted credit card numbers stored in your
system.

The key used to encrypt the credit card information is now stored separately from
your company data. By using the alternate directory feature, your key will be
stored in a different physical location than your company data; thereby,
increasing the security of the credit card information.

A Credit Card Audit Log has been created. This log will show the following:
o All credit card transaction requests sent to the payment server

o Each time credit card numbers are encrypted or decrypted

o Each time a user's print or display credit card preferences is changed

o Each time a credit card key is changed or deleted

Payroll Changes

Recalculate Deductions in Payroll Data Entry

You now have multiple options for recalculating deductions that are based on
earnings in Payroll Data Entry after changing, adding, or deleting data entry lines.

Click the new Recalc Deductions button in Payroll Data Entry.

Select Prompt at the new Recalc Deductions in Data Entry field in Payroll
Options. When clicking Accept after changing, adding, or deleting a line in
Payroll Data Entry, a message dialog box will appear asking if you want to
recalculate deductions for the selected employee.

Select Yes at the Recalc Deductions in Data Entry field in Payroll Options.
Deductions will be automatically recalculated when clicking Accept after
changing, adding, or deleting a line in Payroll Data Entry. You cannot manually
overwrite a deduction if you select this option.

Define Deduction Code Options

Five new calculation methods are available in Deduction Code Maintenance;
deductions can now be calculated as follows:
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Payroll Changes

e A percentage of another deduction (for employer contributions)
e An amount multiplied by the total number of regular and overtime hours

e An amount multiplied by the total hours worked multiplied by the pay rate
multiplier

e A percentage of the pay rate multiplied by the total hours worked
e An amount multiplied by the pay rate

You can now set up a deduction that is calculated based on selected earnings types.

Recalculate All Option for Payroll Imports

A Recalc All button has been added to the message dialog box that appears when
importing payroll data through Visual Integrator. Click the button to recalculate
automatic deductions for all records in the Payroll Data Entry file regardless of
whether they exist in the current import. If you click the button, any previously
calculated automatic deduction amounts will be removed.

Select Preconfigured Payroll Import Jobs

Five preconfigured import jobs are now available to select when importing payroll
data using the Visual Integrator module.

e PR_ADP is configured to import delimited files in the ADP Paydata format.

¢ PR _FORMAT_2 is configured to import ASCII files that use a fixed field format
and include a job number.

¢ PR _KRONOS is configured to import ASCII files in the Kronos Connect and
Time Bank format.

e PR_KRONOS_NO_DP is configured to import ASCII files in the Kronos Connect
and Time Bank format.

¢ PR _TIMETRAK is configured to import ASCII files in the Timetrak version 8.0
format.

To make the jobs available in Import Job Maintenance, use the Job Import task to
import the PayrollDataEntrylmports.exp file, which is available in the \MAS90\PR
folder. For more information, see Import Preconfigured Payroll Import Jobs in the
Help system.

Define Minimum Hours for Benefit Accrual

A new field, Min Hrs/Check, has been added to Benefit Schedule Maintenance. This
field allows you to define a minimum number of hours that must be worked per check
before benefits will accrue.
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Purchase Order Changes

Identify Business Type

A new field, Kind of Employer, has been added to the Federal eFiling and Reporting
and State eFiling and Reporting tasks in the Payroll module, and the W2 Electronic
Reporting task in the Electronic Reporting module. This new field allows you to
identify your company’s type of business.

Purchase Order Changes

Renamed Task

The Auto Generate Orders Selection task on the Main menu has been renamed
Auto Generate from Sales Orders. The task has been redesigned to facilitate the
auto generation process.

View Sales Orders from Purchase Order Entry

In Purchase Order Entry, you can now click the new Sales Order button on the Lines
tab to access and view the sales order for the purchase order without having to
return to the Desktop to open Sales Order Entry.

Set Up Additional Purchase Order/Auto Generate Options

A new Generate tab has been added to Purchase Order Options. The tab features
additional options for automatically generating purchase orders from sales orders.
You now have the following options:

o Combine multiple sales orders for a vendor into one purchase order

e Use the sales order number as the purchase order number when automatically
generating purchase orders from sales orders

e Increment the purchase order number at the beginning or end when using the
sales order number as the purchase order number

e Select whether to base the purchase order header required date on the system
date, purchase order date, sales order ship date, sales order date, or to be
prompted for a date prior to generating the purchase order

e Select whether to base the purchase order line required date on the system date,
purchase order date, sales order promise date, or to be prompted for a date prior
to generating the purchase order

e Print the Auto Generate from Sales Order Listing by customer number and print
the Purchase Order Number Assignment Listing after generating the purchase
orders

e Automatically open the Purchase Order Entry window after generating the orders
or print the purchase orders after generating the orders

e Enable generating purchase orders from Sales Order Entry and elect to be
prompted to generate purchase orders from Sales Order Entry for new sales
orders
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Sales Order Changes

e Elect to include the sales order ship-to address, ship via, FOB, confirm to, e-mail
address, line item’s cost of goods sold (COGS) account, and alias item number
for general alias item types on the purchase orders during generation.

Sales Order Changes

Set Up Additional Options for Job Cost

A new Job Cost tab has been added to Sales Order Options. The tab features
additional options for integrating the Job Cost module with Sales Order. You now
have the following options:

e Update invoice costs to job estimates
e Post costs for drop-ship lines to the Job Cost module

e If the Purchase Order module is set up and integrated with Job Cost, you can
post costs for drop-ship lines in Purchase Order

e Have the job status automatically set to complete when the Sales Journal is
updated

e Elect to relieve job costs from the work in process account and post them to the
cost of sales account

e Have the quantity entered in Sales Order Entry update the quantity on sales
order and quantity on hand values used in the Inventory Management module

e Include the job number and description in the general ledger posting comment

e Define how exploded kit component items and costs are updated to the Job
Transaction Detail file

e Define how the system handles a discrepancy between the currently selected
customer number and the job number entered in Sales Order Entry and Invoice
Data Entry

e Define which cost of goods sold account and sales revenue account are used for
line items in Sales Order Entry and Invoice Data Entry

Also, the following fields have been relocated to the Job Cost tab:

Post Invoice Costs to Job Cost
Require Job Number

Allow Jobs to be Created Automatically
Require Cost Code

Calculate Sales Commissions by Line Item

A new task, Line Item Commission Maintenance, has been added to the Sales Order
Setup menu. The task allows you to set up salesperson commission rates and
amounts by combinations of salespersons, customers, inventory items, and effective
dates.
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Calculate Item Pricing by Total Quantity

New fields in Sales Order Options allow you to combine the ordered quantity for
multiple sales order and invoice lines when calculating quantity pricing discounts.
You can elect to use the total ordered quantity for all lines, or you can combine lines
by product line or by the item categories defined in Inventory Management.

You can define which unit of measure to use for totaling the quantity ordered, and
you can specify whether you want the item pricing by quantity applied automatically,
when prompted, or for new entries only. Additionally, an ltem Price button has been
added to Sales Order Entry and Invoice Data Entry, which you can click to apply item
pricing by quantity to the current order or invoice.

The rules that you set up for sales orders and Sales Order invoices will also be
applied to eBusiness Manager shopping cart orders when they are accepted into
Sales Order.

Distribute Lot/Serial Iltems from Sales Order Entry

Two new fields have been added to Sales Order Options that allow you to enable
lot/serial distribution for sales orders and require that the sales order lines be fully
distributed.

e You now have the option to distribute lot and serial numbers when creating sales
orders, similar to S/O Invoice Data Entry, and print the lot and serial numbers on
sales orders and picking sheets. This feature allows you to specify a lot and
serial number and commit the item at the sales order level so they cannot be
used by other tasks. The lot/serial distribution can then be pulled into Invoice
Data Entry when the sales orders are invoiced.

e The new Lot/Serial Search button in Sales Order Entry allows you to find sales
orders that are referencing specific lot/serial numbers. This feature allows you to
easily select the lot/serial number and order for adjustments.

You can now elect to include or exclude lot and serial distribution from all Open
Sales Order reports and the Inventory Stock Status Report. Additionally, you now
have the option to print the lot/serial number and distribution on sales orders and
picking sheets.

Generate Purchase Orders from Sales Orders

e You can now click the new Purchase Order button on the Lines tab to access and
view the purchase order for the sales order without having to return to the
Desktop to open Purchase Order Entry. Additionally, you can now generate a
purchase order by clicking the Generate PO button on the Totals tab.

e You can now use a security event in Role Maintenance to prevent users from
overriding the bill-to customer number during order entry.
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Retired Modules

Assign Vendors to Miscellaneous/Special Items

e You can now select a vendor number for miscellaneous and special items so that
a purchase order can be automatically generated for these item types. For
regular inventory items, this field defaults to the items primary vendor but can be
changed. For previously entered sales orders, the Vendor Number field will be
blank.

e You can now use a security module option in Role Maintenance to allow users to
view the vendor number during order entry.

Retired Modules

The following modules have been retired as of version 4.50:

StarShip (Freight and Parcel)
FRx Reporting

F9

Business Alerts Select
Report Master
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Appendix A

Checklists

These checklists provide instructions for migrating your data from your older Sage
100 installation and then upgrading the data to version 2020.

If you haven'’t already, follow the instructions in the Sage 100 2020 Installation and
System Administrator’s Guide to install and set up Sage 100 2020. The guide is in
the Documents folder accessible within the installation program, and it’s also
available online:
http://cdn.na.sage.com/docs/en/customer/100erp/Documentation.htm

The upgrade process consists of three steps:
1 Preparing your data for upgrading

2 Upgrading your data to version 2020

3 Converting your data to version 2020

This appendix contains the information you will need to upgrade and convert your
data based on the version of your data. Proceed to the applicable section as follows:

e Upgrading from Version 2019 to Version 2020 on page 131

e Upgrading from Version 2018 to Version 2020 on page 140

Upgrading from Version 2017 to Version 2020 on page 149

Upgrading from Version 2016 to Version 2020 on page 160

Upgrading from Version 2015 to Version 2020 on page 170

Upgrading from Version 2014 to Version 2020 on page 181

Upgrading from Version 2013 to Version 2020 on page 191

Upgrading from Version 4.50 to Version 2020 on page 201

e Upgrading from Version 4.45 to Sage 100 Premium Version 2020 on page 210
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Upgrading from Version 2019 to Version 2020

é NoOTE

You must print
and update all
journals and
registers to
prevent possible
data loss during
data upgrade.

Upgrading from Version 2019 to Version 2020

When upgrading to version 2020, you must perform a parallel installation, and use
the Pre-Migration and Parallel Migration utilities from the Library Master Utilities
menu to upgrade your data. For more information, consult with your Sage business
partner.

If you have custom modules or modifications to any of your modules, consult your
Sage business partner or development partner prior to beginning the upgrade
process.

If your system is integrated with Sage CRM, you must follow the instructions for
upgrading Sage CRM in the Sage 100 Installation and System Administrators Guide.
You can find the guide on the Sage 100 documents page:
http://cdn.na.sage.com/docs/en/customer/100erp/Documentation.htm

Pre-Upgrade Checklist

You must prepare your version 2019 data for upgrading. This should be done for
each company you plan to upgrade.

Complete these steps in your version 2019 installation.

1 Process all pending credit card transactions.

2 Print and update all journals and registers. Failure to do so may result in
loss of data.

3 If you use the Payroll module:

e Update the Payroll Check Register.
e Complete and purge all direct deposit transactions.

Note that you must install the Payroll module in addition to installing
Sage 100. Payroll is not part of the Sage 100 installation program. To
avoid the need to run a separate data conversion for Payroll, install the
module before proceeding to the Upgrade Checklist.

For more information, see the Sage 100 Payroll Installation and
Upgrade Guide available online at:
http://cdn.na.sage.com/docs/en/customer/100erp/Documentation.htm

4 Create a backup of your version 2019 MAS90 folder, which includes data for
all of your companies. Perform this step following your usual backup
process. For specific support on how to back up your data, refer to manuals
for your backup software or contact the vendor from whom you purchased
that product.
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Upgrading from Version 2019 to Version 2020

é NoTE

If you're going to
convert data for the
Payroll module,
you'll need access
to Tax Profile
Maintenance. If you
use Payroll
departments, you
must have access
to all departments in
each company.

5 Rebuild all data files.

e [f you are upgrading from Sage 100 Standard or Advanced, use the
Rebuild Key Files and Rebuild Sort File utilities.

e If you are upgrading from Sage 100 Premium, use the Rebuild Sort File
utility.

You must answer Yes to all recalculation questions.
6 Print all customized form definitions.

7 If you are using eBusiness Manager, back up any templates, .htm files, and
the IW folder before uninstalling the previous version of the Web Engine.

8 Run the Pre-Migration Utility on the Library Master Utilities menu. The utility
examines your data and displays a list of tasks that you should run before
migrating your data. For more information, see the Pre-Migration Utility help.

9 If you are upgrading Sage 100 Premium, configure your firewall to allow
access to port number 1433 on the server with your version 2019
installation. Port 1433 is the default SQL Server port.

Upgrade Checklist

After completing the Pre-Upgrade Checklist on page 131, you are ready to migrate
your data to your version 2020 system.

Complete these steps in your version 2020 installation.
e For Sage 100 Standard or Advanced, use the checklist below.

e For Sage 100 Premium, see the checklist on page 133.

Upgrade Checklist for Sage 100 Standard and Advanced

1____ Create a backup of your version 2020 MAS90 folder. Creating a backup
now will save time if you need to revert to the folder’s original sate.

2 Log into Sage 100 2020 as the Administrator. From the Administrative Tools
window:

a Start Role Maintenance and create a role that you’ll use to run the
Parallel Migration Wizard.

On the Tasks tab, expand Library Master > Miscellaneous Tasks, and
then select the Parallel Migration check box.

b Start User Maintenance, create a logon, and select the role that you
created.

3 Log in to Sage 100 2020, and select Library Master > Utilities > Parallel
Migration. Follow the steps in the wizard to migrate your data.
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Upgrading from Version 2019 to Version 2020

A WARNING

You must have
administrator
rights for the
server with your
prior version of
Sage 100 and the
server with your
version 2020
installation.

After the migration is complete, log into Sage 100 2020 as the
Administrator. Use the tasks available from the Administrative Tools window
to review user security and set up and assign the appropriate roles to your
users.

Review security tasks for new features in version 2020. Review ODBC
security if it is used.

If you are using Unified Logon and you upgraded your system files, you
must add the following statement on one workstation SOTA.ini: Logon=Yes.

If you customized your Desktop, review the customizations.

Upgrade Checklist for Sage 100 Premium

Use this checklist to migrate your Sage 100 Premium data.

For your Sage 100 2020 installation, create a backup of the following:
e The Sage 100 MAS90 folder
e The MAS_System SQL Server database

Creating backups now will save time if you need to revert to the installation’s
original state.

Verify that the required rights and permissions are set up on the server(s)
where SQL Server is installed. If the instance of SQL Server for Sage 100
2020 is installed on a different server than the instance used for your prior
version, you must complete these steps on both servers.

a Open the Control Panel, select Administrative Tools, and the select
Services.

b Inthe Services window, locate the SQL Server instance used for Sage
100 Premium, right click it, and select Properties.

¢ In the Properties window, click the Log On tab and select an option.

e If the SQL Server instance that you’re using for version 2020 is
installed on the same server as the instance used for your prior
version of Sage 100 Premium, select Local System Account.

e If the SQL Server instance that you're using for version 2020 is
installed on a different server than the one used for your prior version
of Sage 100 Premium, select This Account.

In the account field, enter: \\ServerName\Administrator

Replace "ServerName" with the name of the server. Sage strongly
recommends using the actual Administrator or Domain Administrator
account.

Enter the password for the account.
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d Apply your changes and then stop and restart the services.

e If you're working with more than one server, make sure that all servers
can access each other through hidden shares.

For example: \\ServerName\C$, \\ServerName\D$

Start the Parallel Migration Wizard using one of the methods below, and
follow the steps in the Wizard.

e [f you are using Windows Server 2008, start the Parallel Migration
Wizard from the Sage program group on the Start menu.

e If you are using Windows Server 2012 or later, start the Parallel
Migration Wizard from the Start window.

The Migration Wizard creates .bak files in the ..\DATA folders for the two
SQL Server locations. The hidden shares are used to access the source
databases to create the .back files. For example:

\\ServerName\c$\Program Files\Microsoft SQL
Server\MSSQL12.MSSQLSERVER\MSSQL\Data

After the .bak files are created, the wizard copies them to the hidden share
of the destination ..\DATA SQL Server folders.

To complete the process, the wizard then restores the databases into the
new SQL Server location and removes the .bak files from both the source
and destination locations.

If permissions were not set correctly on both servers, you may receive the
following error: "Error Number : 0x80040e14 Description: Access Denied 5
or Access Denied 2 Setup will now terminate”

If this error occurs, see article number 76993 in the Sage Knowledgebase.

After the migration is complete, log into Sage 100 2020 as the
Administrator. Use the tasks available from the Administrative Tools window
to review user security and set up and assign the appropriate roles to your
users.

Review security tasks for new features in version 2020. Review ODBC
security if it is used.

If you are using Unified Logon and you upgraded your system files, you
must add the following statement on one workstation SOTA.ini: Logon=Yes.

If you customized your Desktop, review the customizations.
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Data Conversion Checklist

After completing the steps in the Pre-Upgrade Checklist on page 131 and the
Upgrade Checklist on page 132, you are now ready to convert your data to version
2020.

1___ If your company data contains credit card information, install the latest
version of Sage Exchange and verify that the workstation you are using has
a working internet connection. This is necessary so that credit card records
can be transferred to a Sage Exchange Vault account during conversion.
Credit card records must be transferred to a Sage Exchange Vault account
before company data can be converted.

To install Sage Exchange:

a Start the Sage 100 installation program.

b Select your edition of Sage 100.

¢ Click Productivity Applications.

d Click Install Sage Exchange Desktop to start the installation wizard.
e Proceed through the wizard to install the program.

2 Select Library Master Main menu > Company Maintenance. Select a
company, and then click Convert to convert your data. You must convert
data for each of your companies.

In addition, you can select one or more of the following options:

e Convert Data for All Companies: Select this check box to convert data
for all of your companies instead of doing it one-by-one. This check box
may be unavailable if you’re converting Payroll data, depending on
which version of Payroll you're upgrading from.

e Convert SAP Crystal Reports: Select this check box to convert all of
your custom reports and forms. The time required to convert your
reports and forms depends on how many of them you have that need to
be converted. The process runs in the background, and you can
continue working in Sage 100 while it’s running.

You can convert custom forms and reports later by running the Sage
100 Crystal Report Conversion Wizard.

e Update Custom Office Panels to Current Level: Select this check box to
run the Custom Office panel update for any customized panels for the
companies being converted. This update runs without any prompts.

You can update custom panels later by running the Update Customized
Panels to Current Level utility on the Custom Office Utilities menu.
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3 If you were not processing transactions through Sage Payment Solutions
but plan to start doing so, contact your Sage Payment Solutions account
executive to convert the Sage Exchange Vault-only account created during
conversion to a processing account.

4 If your system is integrated with Sage CRM, go into CRM Server Options,
and update the following information as needed.

e |Integration server port ID
e Sage CRM SQL server name
e Sage CRM SQL database name

The server name and database name should reference the mirror
installation that you created for integration with Sage 100 2020. For more
information on this process, refer to the Installing Sage CRM chapter in the
Sage 100 Installation and System Administrator’s Guide.

After updating the information, load the Sage CRM data.

5 If you synchronize payroll data between your General Ledger module and
Sage Payroll Services, verify that your Sage 100 company or companies
are still linked to the service.

a Select General Ledger > Payroll Services > Payroll Services
Synchronization Wizard.

b Sign in to Sage Payroll Services.
¢ Proceed through the wizard.

d Review the status messages shown in the Synchronizing Data with
Sage Payroll Services window.

If you see a "Synchronization Complete" message, no further action is
required.

If you see a "Synchronization failed" message, contact Sage Payroll
Services Support for assistance with resetting the link.

6 Update customized panels by selecting Custom Office Utilities menu >
Update Customized Panels to Current Level. Review the placement of all
user-defined fields.

7 If you have customized Advanced Lookup Engine (ALE) lookups, after
converting to the new version of the software and prior to accessing other
modules, select Library Master Utilities menu > Lookup Conversion to
convert your lookups.
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Verify that all module links are functional by selecting Library Master Utilities
menu > Link Maintenance Utility. Links that appear in red are broken and
will need to be fixed using the Relink button in Link Maintenance Ultility. For
more information on relinking files, see Copy/Move/Relink Files in your Help
system.

If you are also upgrading your Payroll Module, review the list of
enhancements and upgrade instructions in the Sage 100 Payroll What's
New guide, available here:
http://cdn.na.sage.com/docs/en/customer/100erp/2018n/open/Payroll_Upgr
ade.pdf

Test your customized Crystal reports and forms.

If you need to troubleshoot issues with customized reports and forms, run
the Crystal Form Comparison Report utility to compare your customized
reports and forms to the standard ones in version 2020.

To run the utility, select File menu > Run, and then type SYWFCU. The
utility tells you which tables, if any, have been added to a report or form. It
does not provide information about formatting changes, such as those
affecting fonts, logos, and so forth.

If you were previously using non-graphical forms, you will need to set them
up using SAP Crystal Reports.

If you are using Sage 100 Standard or Sage 100 Advanced, use the Crystal
Reports Conversion Wizard to convert your Crystal reports and forms. For
more information, see SAP Crystal Reports FAQs in the Help system. If you
do not run the wizard now, it will automatically run the first time that
someone runs a form or report.

If you are using Sage 100 Premium, refer to the Converting Reports for
Sage 100 Premium section in the Sage 7100 Installation and System
Administrators’ Guide for more information.

If Sage 100 2020 is installed on the same computer as an earlier version of
Sage 100, complete this step to avoid errors when printing forms and
reports in the earlier version:

Copy the pvxwin32.exe.config file from the ..\MAS90\Home folder in your
2018 installation to the same folder in the earlier installation. You must
complete this step on both the server and the workstation.

If your system has custom reports, review the Custom Reports menus to
make sure they are available. If they are not, add them using Report
Manager.

If you use Sage Intelligence Reporting, create a new repository for use with
Sage 100 2020 and import any custom reports into it. For detailed
instructions, see Upgrading Sage Intelligence Reporting on page 216.
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Review the Paperless Office module configuration for e-mailing statements,
reports, journals, registers, and other forms. For more information, see Set
Up Paperless Office in the Help system.

Review your Business Insights Dashboard pages. For more information,
see Set Up Business Insights Dashboard in the Help system.

To use the eBusiness Manager module, restore the copied templates back
to the IW folder after re-installing the Web Engine.

Copy the poweredby.gif image from the MAS90\Images folder to the IIS
Inetpup\wwwroot\images folder and restart the [IS Web service.

If you use Custom Financials Reporting, you must unhide the menu and
tasks. Select File menu > Run and type *unhidegl in the Run Program
window.

Print all customized form definitions and compare them to the ones
previously printed. Default forms may be erased in the upgrade process.

If you purchased the Return Merchandise Authorization module, after
setting up the data files for the first time, select Return Merchandise
Authorization Setup menu > Create Customer Invoice Search Records to
create customer invoice search records in RMA.

To run Microsoft Script links, you must have the Microsoft Windows Script
Host processor on your system. For information on installing the Microsoft
Windows Script Host processor, refer to the Microsoft Download Center
Web site.

If you use Automatic Update or Task Scheduler, review your scheduled
automatic updates and reschedule those updates by selecting Library
Master Main menu > Automatic Update or Task Scheduler, as applicable.

If you had task folders in your My Tasks area, re-create your Public and
Private task folders.

Test all printers, including Device Configurator printers, that you normally
use for printing forms and reports. Each workstation must have a default
printer defined.

To use the auto-complete feature with enhanced search, run the Build
Search Index utility to index your existing customer, vendor, and item
records.

To run the utility, select Library Master > Utilities > Build Search Index.

Install Sage Exchange Desktop on each workstation for each Windows user
who needs to access credit card and ACH payment information in
Sage 100.

To install Sage Exchange Desktop for Sage 100 Standard:

a Use Windows Explorer to browse to the MAS90\Wksetup folder.
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If you are installing Sage Exchange Desktop on a workstation that
connects to a Sage 100 Standard installation on a server, browser to
the MAS90\Wksetup folder on the server.

Double-click Autorun.exe to open the Workstation Setup program; it
takes a few seconds to launch.

Click Install Sage Exchange Desktop.

Proceed through the steps in the Sage Exchange Desktop installation
wizard to install the program.

To install Sage Exchange Desktop for Sage 100 Advanced and
Premium:

a

Use Windows Explorer to browse to the server where Sage 100 is
installed, and locate the MAS90\Wksetup folder.

Double-click Autorun.exe to open the Workstation Setup program; it
takes a few seconds to launch.

Click Install Sage Exchange Desktop.

Proceed through the steps in the Sage Exchange Desktop installation
wizard to install the program.

For information on what is new in this release, see What's New in Version 2020 on

page 3.
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Upgrading from Version 2018 to Version 2020

When upgrading to version 2020, you must perform a parallel installation, and use
the Pre-Migration and Parallel Migration utilities from the Library Master Utilities
menu to upgrade your data. For more information, consult with your Sage business
partner.

If you have custom modules or modifications to any of your modules, consult your
Sage business partner or development partner prior to beginning the upgrade
process.

If your system is integrated with Sage CRM, you must follow the instructions for
upgrading Sage CRM in the Sage 100 Installation and System Administrators Guide.
You can find the guide on the Sage 100 documents page:
http://cdn.na.sage.com/docs/en/customer/100erp/Documentation.htm

Pre-Upgrade Checklist

You must prepare your version 2018 data for upgrading. This should be done for
each company you plan to upgrade.

1___ Process all pending credit card transactions.
& NoTE
You must print 2 Printand update all journals and registers. Failure to do so may result in
and update all loss of data.
journals and
registers to 3___ Ifyou use the Payroll module:

prevent possible
data loss during

e Update the Payroll Check Register.
data upgrade.

e Complete and purge all direct deposit transactions.

Note that you must install the Payroll module in addition to installing
Sage 100. Payroll is not part of the Sage 100 installation program. To
avoid the need to run a separate data conversion for Payroll, install the
module before proceeding to the Upgrade Checklist.

For more information, see the Sage 100 Payroll Installation and
Upgrade Guide available online at:
http://cdn.na.sage.com/docs/en/customer/100erp/Documentation.htm

4 Create a backup of your version 2018 MAS90 folder, which includes data for
all of your companies. Perform this step following your usual backup
process. For specific support on how to back up your data, refer to manuals
for your backup software or contact the vendor from whom you purchased
that product.
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5 Rebuild all data files.

e [f you are upgrading from Sage 100 Standard or Advanced, use the
Rebuild Key Files and Rebuild Sort File utilities.

e If you are upgrading from Sage 100 Premium, use the Rebuild Sort File
utility.

You must answer Yes to all recalculation questions.
6 Print all customized form definitions.

7 If you are using eBusiness Manager, back up any templates, .htm files, and
the IW folder before uninstalling the previous version of the Web Engine.

8 Run the Pre-Migration Utility on the Library Master Utilities menu. The utility
examines your data and displays a list of tasks that you should run before
migrating your data. For more information, see the Pre-Migration Utility help.

9 If you are upgrading Sage 100 Premium, configure your firewall to allow
access to port number 1433 on the server with your version 2018
installation. Port 1433 is the default SQL Server port.

Upgrade Checklist

After completing the Pre-Upgrade Checklist on page 140, you are ready to migrate
your data to your version 2020 system.

e For Sage 100 Standard or Advanced, use the checklist below.

e For Sage 100 Premium, see the checklist on page 142.

Upgrade Checklist for Sage 100 Standard and Advanced

1 Create a backup of your version 2020 MAS90 folder. Creating a backup
now will save time if you need to revert to the folder’s original sate.

2 Log in to Sage 100 2020, and select Library Master > Utilities > Parallel
Migration. Follow the steps in the wizard to migrate your data.

3 After the migration is complete, log into Sage 100 2020 as the
Administrator. Use the tasks available from the Administrative Tools window
to review user security and set up and assign the appropriate roles to your
users.

4 Review security tasks for new features in version 2020. Review ODBC
security if it is used.

5 If you are using Unified Logon and you upgraded your system files, you
must add the following statement on one workstation SOTA.ini: Logon=Yes.

6 If you customized your Desktop, review the customizations.
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Upgrade Checklist for Sage 100 Premium

Use this check
1 Foryo
e Th

e Th

list to migrate your Sage 100 Premium data.
ur Sage 100 2020 installation, create a backup of the following:
e Sage 100 MAS9O0 folder

e MAS_System SQL Server database

Creating backups now will save time if you need to revert to the installation’s
original state.

2____ Verify that the required rights and permissions are set up on the server(s)
AWARMNG where SQL Server is installed. If the instance of SQL Server for Sage 100
You must have 2020 is installed on a different server than the instance used for your prior
administrator version, you must complete these steps on both servers.
rights for the

server with your
prior version of
Sage 100 and the Se
server with your

a Open the Control Panel, select Administrative Tools, and the select

rvices.

version 2020 b In the Services window, locate the SQL Server instance used for Sage
installation. 100 Premium, right click it, and select Properties.

¢ In the Properties window, click the Log On tab and select an option.

If the SQL Server instance that you're using for version 2020 is
installed on the same server as the instance used for your prior
version of Sage 100 Premium, select Local System Account.

If the SQL Server instance that you’re using for version 2020 is
installed on a different server than the one used for your prior version
of Sage 100 Premium, select This Account.

In the account field, enter: \ServerName\Administrator
Replace "ServerName" with the name of the server. Sage strongly
recommends using the actual Administrator or Domain Administrator

account.

Enter the password for the account.

d Apply your changes and then stop and restart the services.

e If you're working with more than one server, make sure that all servers
can access each other through hidden shares.

For example: \\ServerName\C$, \\ServerName\D$

3___ Start the Parallel Migration Wizard using one of the methods below, and
follow the steps in the Wizard.

o Ify

ou are using Windows Server 2008, start the Parallel Migration

Wizard from the Sage program group on the Start menu.
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e [f you are using Windows Server 2012 or later, start the Parallel
Migration Wizard from the Start window.

The Migration Wizard creates .bak files in the ..\DATA folders for the two
SQL Server locations. The hidden shares are used to access the source
databases to create the .back files. For example:

\\ServerName\c$\Program Files\Microsoft SQL
Server\MSSQL12.MSSQLSERVER\MSSQL\Data

After the .bak files are created, the wizard copies them to the hidden share
of the destination .\DATA SQL Server folders.

To complete the process, the wizard then restores the databases into the
new SQL Server location and removes the .bak files from both the source
and destination locations.

If permissions were not set correctly on both servers, you may receive the
following error: "Error Number : 0x80040e14 Description: Access Denied 5
or Access Denied 2 Setup will now terminate”

If this error occurs, see article number 76993 in the Sage Knowledgebase.

After the migration is complete, log into Sage 100 2020 as the
Administrator. Use the tasks available from the Administrative Tools window
to review user security and set up and assign the appropriate roles to your
users.

Review security tasks for new features in version 2020. Review ODBC
security if it is used.

If you are using Unified Logon and you upgraded your system files, you
must add the following statement on one workstation SOTA.ini: Logon=Yes.

If you customized your Desktop, review the customizations.
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Data Conversion Checklist

After completing the steps in the Pre-Upgrade Checklist on page 140 and the
Upgrade Checklist on page 141, you are now ready to convert your data to version
2020.

1___ If your company data contains credit card information, install the latest
version of Sage Exchange and verify that the workstation you are using has
a working internet connection. This is necessary so that credit card records
can be transferred to a Sage Exchange Vault account during conversion.
Credit card records must be transferred to a Sage Exchange Vault account
before company data can be converted.

To install Sage Exchange:

a Start the Sage 100 installation program.

b Select your edition of Sage 100.

¢ Click Productivity Applications.

d Click Install Sage Exchange Desktop to start the installation wizard.
e Proceed through the wizard to install the program.

2 Select Library Master Main menu > Company Maintenance. Select a
company, and then click Convert to convert your data. You must convert
data for each of your companies.

In addition, you can select one or more of the following options:

e Convert Data for All Companies: Select this check box to convert data
for all of your companies instead of doing it one-by-one. This check box
may be unavailable if you’re converting Payroll data, depending on
which version of Payroll you're upgrading from.

e Convert SAP Crystal Reports: Select this check box to convert all of
your custom reports and forms. The time required to convert your
reports and forms depends on how many of them you have that need to
be converted. The process runs in the background, and you can
continue working in Sage 100 while it’s running.

You can convert custom forms and reports later by running the Sage
100 Crystal Report Conversion Wizard.

e Update Custom Office Panels to Current Level: Select this check box to
run the Custom Office panel update for any customized panels for the
companies being converted. This update runs without any prompts.

You can update custom panels later by running the Update Customized
Panels to Current Level utility on the Custom Office Utilities menu.
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3 If you are converting Payroll Data, the Payroll Data Conversion Wizard
automatically opens. Companies that include Payroll data must be
converted one by one. You'll be guided through the following tasks:

e Mapping department numbers. If you use payroll departments and any
of the departments numbers contain special characters, you must enter
new department numbers containing only alphanumeric characters to
replace them.

e Selecting tax groups from the payroll tax database to replace your
existing tax codes. If you are using local tax codes, each state and local
tax code combination will be replaced by one tax group. Depending on
which tax codes you're using, the wizard offers suggestions for you to
review and update as needed.

e Adding tax groups to tax profiles. Tax profiles are collections of tax
groups that you assign to employees to determine how their taxes are
calculated. You can access Tax Profile Maintenance from the wizard to
create tax profiles.

e Selecting filing statuses from the payroll tax database to replace your
existing ones. The filing statuses in the database may differ from the
ones that you are using. The wizard offers suggestions when possible
for you to review and update as needed.

4 If you were not processing transactions through Sage Payment Solutions
but plan to start doing so, contact your Sage Payment Solutions account
executive to convert the Sage Exchange Vault-only account created during
conversion to a processing account.

5 If your system is integrated with Sage CRM, go into CRM Server Options,
and update the following information as needed.

e Integration server port ID
e Sage CRM SQL server name
e Sage CRM SQL database name

The server name and database name should reference the mirror
installation that you created for integration with Sage 100 2020. For more
information on this process, refer to the Installing Sage CRM chapter in the
Sage 100 Installation and System Administrator’s Guide.

After updating the information, load the Sage CRM data.

6 If you synchronize payroll data between your General Ledger module and
Sage Payroll Services, verify that your Sage 100 company or companies
are still linked to the service.

a Select General Ledger > Payroll Services > Payroll Services
Synchronization Wizard.

b Sign in to Sage Payroll Services.
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¢ Proceed through the wizard.

d Review the status messages shown in the Synchronizing Data with
Sage Payroll Services window.

If you see a "Synchronization Complete" message, no further action is
required.

If you see a "Synchronization failed" message, contact Sage Payroll
Services Support for assistance with resetting the link.

Update customized panels by selecting Custom Office Utilities menu >
Update Customized Panels to Current Level. Review the placement of all
user-defined fields.

If you have customized Advanced Lookup Engine (ALE) lookups, after
converting to the new version of the software and prior to accessing other
modules, select Library Master Utilities menu > Lookup Conversion to
convert your lookups.

Verify that all module links are functional by selecting Library Master Utilities
menu > Link Maintenance Utility. Links that appear in red are broken and
will need to be fixed using the Relink button in Link Maintenance Ultility. For
more information on relinking files, see Copy/Move/Relink Files in your Help
system.

If you are also upgrading your Payroll Module, review the list of
enhancements and upgrade instructions in the Sage 100 Payroll What's
New guide, available here:
http://cdn.na.sage.com/docs/en/customer/100erp/2018n/open/Payroll_Upgr
ade.pdf

Test your customized Crystal reports and forms.

If you need to troubleshoot issues with customized reports and forms, run
the Crystal Form Comparison Report utility to compare your customized
reports and forms to the standard ones in version 2020.

To run the utility, select File menu > Run, and then type SYWFCU. The
utility tells you which tables, if any, have been added to a report or form. It
does not provide information about formatting changes, such as those
affecting fonts, logos, and so forth.

If you were previously using non-graphical forms, you will need to set them
up using SAP Crystal Reports.

If you are using Sage 100 Standard or Sage 100 Advanced, use the Crystal
Reports Conversion Wizard to convert your Crystal reports and forms. For
more information, see SAP Crystal Reports FAQs in the Help system. If you
do not run the wizard now, it will automatically run the first time that
someone runs a form or report.
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If you are using Sage 100 Premium, refer to the Converting Reports for
Sage 100 Premium section in the Sage 700 Installation and System
Administrators’ Guide for more information.

If Sage 100 2020 is installed on the same computer as an earlier version of
Sage 100, complete this step to avoid errors when printing forms and
reports in the earlier version:

Copy the pvxwin32.exe.config file from the ..\MAS90\Home folder in your
2018 installation to the same folder in the earlier installation. You must
complete this step on both the server and the workstation.

If your system has custom reports, review the Custom Reports menus to
make sure they are available. If they are not, add them using Report
Manager.

If you use Sage Intelligence Reporting, create a new repository for use with
Sage 100 2020 and import any custom reports into it. For detailed
instructions, see Upgrading Sage Intelligence Reporting on page 216.

Review the Paperless Office module configuration for e-mailing statements,
reports, journals, registers, and other forms. For more information, see Set
Up Paperless Office in the Help system.

Review your Business Insights Dashboard pages. For more information,
see Set Up Business Insights Dashboard in the Help system.

To use the eBusiness Manager module, restore the copied templates back
to the IW folder after re-installing the Web Engine.

Copy the poweredby.gif image from the MAS90\Images folder to the IIS
Inetpup\wwwroot\images folder and restart the [IS Web service.

If you use Custom Financials Reporting, you must unhide the menu and
tasks. Select File menu > Run and type *unhidegl in the Run Program
window.

Print all customized form definitions and compare them to the ones
previously printed. Default forms may be erased in the upgrade process.

If you purchased the Return Merchandise Authorization module, after
setting up the data files for the first time, select Return Merchandise
Authorization Setup menu > Create Customer Invoice Search Records to
create customer invoice search records in RMA.

To run Microsoft Script links, you must have the Microsoft Windows Script
Host processor on your system. For information on installing the Microsoft
Windows Script Host processor, refer to the Microsoft Download Center
Web site.

If you use Automatic Update or Task Scheduler, review your scheduled
automatic updates and reschedule those updates by selecting Library
Master Main menu > Automatic Update or Task Scheduler, as applicable.
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23 If you had task folders in your My Tasks area, re-create your Public and
Private task folders.

24 Test all printers, including Device Configurator printers, that you normally
use for printing forms and reports. Each workstation must have a default
printer defined.

25 To use the auto-complete feature with enhanced search, run the Build
Search Index utility to index your existing customer, vendor, and item
records.

To run the utility, select Library Master > Utilities > Build Search Index.

26 Install Sage Exchange Desktop on each workstation for each Windows user
who needs to access credit card and ACH payment information in
Sage 100.

To install Sage Exchange Desktop for Sage 100 Standard:
a Use Windows Explorer to browse to the MAS90\Wksetup folder.

If you are installing Sage Exchange Desktop on a workstation that
connects to a Sage 100 Standard installation on a server, browser to
the MAS90\Wksetup folder on the server.

b Double-click Autorun.exe to open the Workstation Setup program; it
takes a few seconds to launch.

¢ Click Install Sage Exchange Desktop.

d Proceed through the steps in the Sage Exchange Desktop installation
wizard to install the program.

To install Sage Exchange Desktop for Sage 100 Advanced and
Premium:

a Use Windows Explorer to browse to the server where Sage 100 is
installed, and locate the MAS90\Wksetup folder.

b Double-click Autorun.exe to open the Workstation Setup program; it
takes a few seconds to launch.

¢ Click Install Sage Exchange Desktop.

d Proceed through the steps in the Sage Exchange Desktop installation
wizard to install the program.

For information on what is new in this release, see What's New in Version 2020 on
page 3.
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Upgrading from Version 2017 to Version 2020

When upgrading to version 2020, you must perform a parallel installation, and use
the Pre-Migration and Parallel Migration utilities from the Library Master Utilities
menu to upgrade your data. For more information, consult with your Sage business
partner.

If you have custom modules or modifications to any of your modules, consult your
Sage business partner or development partner prior to beginning the upgrade
process.

If your system is integrated with Sage CRM, you must follow the instructions for
upgrading Sage CRM in the Sage 100 Installation and System Administrators Guide.
You can find the guide on the Sage 100 documents page:
http://cdn.na.sage.com/docs/en/customer/100erp/Documentation.htm

Pre-Upgrade Checklist

You must prepare your version 2017 data for upgrading. This should be done for
each company you plan to upgrade.

1 Process all pending credit card transactions.

2 Print and update all journals and registers. Failure to do so may result in
loss of data.

3 If you use the Payroll module:

e Update the Payroll Check Register.
e Complete and purge all direct deposit transactions.

e If you have set up departments, you must have a user account set up
with access to all departments in all companies. Department access
must be assigned to individual user logon ID, not by groups. Groups are
no longer used to manage department access.

Note that you must install the Payroll module in addition to installing Sage
100. Payroll is not part of the Sage 100 installation program. To avoid the
need to run a separate data conversion for Payroll, install the module before
proceeding to the Upgrade Checklist.

For more information, see the Sage 100 Payroll Installation and Upgrade
Guide available online at:
http://cdn.na.sage.com/docs/en/customer/100erp/Documentation.htm

4 Create a backup of your version 2017 MAS90 folder, which includes data for
all of your companies. Perform this step following your usual backup
process. For specific support on how to back up your data, refer to manuals
for your backup software or contact the vendor from whom you purchased
that product.
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5 Rebuild all data files.

e [f you are upgrading from Sage 100 Standard or Advanced, use the
Rebuild Key Files and Rebuild Sort File utilities.

e If you are upgrading from Sage 100 Premium, use the Rebuild Sort File
utility.

You must answer Yes to all recalculation questions.
6 Print all customized form definitions.

7 If you are using eBusiness Manager, back up any templates, .htm files, and
the IW folder before uninstalling the previous version of the Web Engine.

8 Run the Pre-Migration Utility on the Library Master Utilities menu. The utility
examines your data and displays a list of tasks that you should run before
migrating your data. For more information, see the Pre-Migration Utility help.

9 If you are upgrading Sage 100 Premium, configure your firewall to allow
access to port number 1433 on the server with your version 2017
installation. Port 1433 is the default SQL Server port.

Upgrade Checklist

After completing the Pre-Upgrade Checklist on page 149, you are ready to migrate
your data to your version 2020 system.

e For Sage 100 Standard or Advanced, use the checklist below.

e For Sage 100 Premium, see the checklist on page 151.

Upgrade Checklist for Sage 100 Standard and Advanced

1 Create a backup of your version 2020 MAS90 folder. Creating a backup
now will save time if you need to revert to the folder’s original sate.

2 Log in to Sage 100 2020, and select Library Master > Utilities > Parallel
Migration. Follow the steps in the wizard to migrate your data.

3 After the migration is complete, log into Sage 100 2020 as the
Administrator. Use the tasks available from the Administrative Tools window
to review user security and set up and assign the appropriate roles to your
users.

4 Review security tasks for new features in version 2020. Review ODBC
security if it is used.

5 If you are using Unified Logon and you upgraded your system files, you
must add the following statement on one workstation SOTA.ini: Logon=Yes.

6 If you customized your Desktop, review the customizations.
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Upgrade Checklist for Sage 100 Premium

Use this checklist to migrate your Sage 100 Premium data.

1___ For your Sage 100 2020 installation, create a backup of the following:

e The Sage 100 MAS90 folder

e The MAS_System SQL Server database

Creating backups now will save time if you need to revert to the installation’s
original state.

2____ Verify that the required rights and permissions are set up on the server(s)
where SQL Server is installed. If the instance of SQL Server for Sage 100
2020 is installed on a different server than the instance used for your prior
version, you must complete these steps on both servers.

a

Open the Control Panel, select Administrative Tools, and the select
Services.

In the Services window, locate the SQL Server instance used for Sage
100 Premium, right click it, and select Properties.

In the Properties window, click the Log On tab and select an option.

If the SQL Server instance that you're using for version 2020 is
installed on the same server as the instance used for your prior
version of Sage 100 Premium, select Local System Account.

If the SQL Server instance that you’re using for version 2020 is
installed on a different server than the one used for your prior version
of Sage 100 Premium, select This Account.

In the account field, enter: \ServerName\Administrator
Replace "ServerName" with the name of the server. Sage strongly
recommends using the actual Administrator or Domain Administrator

account.

Enter the password for the account.

Apply your changes and then stop and restart the services.

If you're working with more than one server, make sure that all servers
can access each other through hidden shares.

For example: \\ServerName\C$, \\ServerName\D$

3___ Start the Parallel Migration Wizard using one of the methods below, and
follow the steps in the Wizard.

e [f you are using Windows Server 2008, start the Parallel Migration
Wizard from the Sage program group on the Start menu.
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e [f you are using Windows Server 2012 or later, start the Parallel
Migration Wizard from the Start window.

The Migration Wizard creates .bak files in the ..\DATA folders for the two
SQL Server locations. The hidden shares are used to access the source
databases to create the .back files. For example:

\\ServerName\c$\Program Files\Microsoft SQL
Server\MSSQL12.MSSQLSERVER\MSSQL\Data

After the .bak files are created, the wizard copies them to the hidden share
of the destination .\DATA SQL Server folders.

To complete the process, the wizard then restores the databases into the
new SQL Server location and removes the .bak files from both the source
and destination locations.

If permissions were not set correctly on both servers, you may receive the
following error: "Error Number : 0x80040e14 Description: Access Denied 5
or Access Denied 2 Setup will now terminate”

If this error occurs, see article number 76993 in the Sage Knowledgebase.

After the migration is complete, log into Sage 100 2020 as the
Administrator. Use the tasks available from the Administrative Tools window
to review user security and set up and assign the appropriate roles to your
users.

Review security tasks for new features in version 2020. Review ODBC
security if it is used.

If you are using Unified Logon and you upgraded your system files, you
must add the following statement on one workstation SOTA.ini: Logon=Yes.

If you customized your Desktop, review the customizations.
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Data Conversion Checklist

After completing the steps in the Pre-Upgrade Checklist on page 149 and the
Upgrade Checklist on page 150, you are now ready to convert your data to version
2020.

1___ If your company data contains credit card information, install the latest
version of Sage Exchange and verify that the workstation you are using has
a working internet connection. This is necessary so that credit card records
can be transferred to a Sage Exchange Vault account during conversion.
Credit card records must be transferred to a Sage Exchange Vault account
before company data can be converted.

To install Sage Exchange:

a Start the Sage 100 installation program.

b Select your edition of Sage 100.

¢ Click Productivity Applications.

d Click Install Sage Exchange Desktop to start the installation wizard.
e Proceed through the wizard to install the program.

2 Select Library Master Main menu > Company Maintenance. Select a
company, and then click Convert to convert your data. You must convert
data for each of your companies.

In addition, you can select one or more of the following options:

e Convert Data for All Companies: Select this check box to convert data
for all of your companies instead of doing it one-by-one. This check box
may be unavailable if you’re converting Payroll data, depending on
which version of Payroll you're upgrading from.

e Convert SAP Crystal Reports: Select this check box to convert all of
your custom reports and forms. The time required to convert your
reports and forms depends on how many of them you have that need to
be converted. The process runs in the background, and you can
continue working in Sage 100 while it’s running.

You can convert custom forms and reports later by running the Sage
100 Crystal Report Conversion Wizard.

e Update Custom Office Panels to Current Level: Select this check box to
run the Custom Office panel update for any customized panels for the
companies being converted. This update runs without any prompts.

You can update custom panels later by running the Update Customized
Panels to Current Level utility on the Custom Office Utilities menu.
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3 If you are converting Payroll Data, the Payroll Data Conversion Wizard
automatically opens. Companies that include Payroll data must be
converted one by one. You'll be guided through the following tasks:

e Mapping department numbers. If you use payroll departments and any
of the departments numbers contain special characters, you must enter
new department numbers containing only alphanumeric characters to
replace them.

e Selecting tax groups from the payroll tax database to replace your
existing tax codes. If you are using local tax codes, each state and local
tax code combination will be replaced by one tax group. Depending on
which tax codes you're using, the wizard offers suggestions for you to
review and update as needed.

e Adding tax groups to tax profiles. Tax profiles are collections of tax
groups that you assign to employees to determine how their taxes are
calculated. You can access Tax Profile Maintenance from the wizard to
create tax profiles.

e Selecting filing statuses from the payroll tax database to replace your
existing ones. The filing statuses in the database may differ from the
ones that you are using. The wizard offers suggestions when possible
for you to review and update as needed.

4 If you were not processing transactions through Sage Payment Solutions
but plan to start doing so, contact your Sage Payment Solutions account
executive to convert the Sage Exchange Vault-only account created during
conversion to a processing account.

5 If your system is integrated with Sage CRM, go into CRM Server Options,
and update the following information as needed.

e Integration server port ID
e Sage CRM SQL server name
e Sage CRM SQL database name

The server name and database name should reference the mirror
installation that you created for integration with Sage 100 2020. For more
information on this process, refer to the Installing Sage CRM chapter in the
Sage 100 Installation and System Administrator’s Guide.

After updating the information, load the Sage CRM data.

6 If you synchronize payroll data between your General Ledger module and
Sage Payroll Services, verify that your Sage 100 company or companies
are still linked to the service.

a Select General Ledger > Payroll Services > Payroll Services
Synchronization Wizard.

b Sign in to Sage Payroll Services.
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10

¢ Proceed through the wizard.

d Review the status messages shown in the Synchronizing Data with
Sage Payroll Services window.

If you see a "Synchronization Complete" message, no further action is
required.

If you see a "Synchronization failed" message, contact Sage Payroll
Services Support for assistance with resetting the link.

Update customized panels by selecting Custom Office Utilities menu >
Update Customized Panels to Current Level. Review the placement of all
user-defined fields.

For the Job Cost and Payroll modules, you must manually recreate all of
your customized panels. User defined fields will be automatically converted.

If you have customized Advanced Lookup Engine (ALE) lookups, after
converting to the new version of the software and prior to accessing other
modules, select Library Master Utilities menu > Lookup Conversion to
convert your lookups.

For the Job Cost and Payroll Modules, you must manually recreate all
custom lookups.

Verify that all module links are functional by selecting Library Master Utilities
menu > Link Maintenance Utility. Links that appear in red are broken and
will need to be fixed using the Relink button in Link Maintenance Utility. For
more information on relinking files, see Copy/Move/Relink Files in your Help
system.

If you use the Payroll Module, review the list of enhancements in the Sage
100 Payroll What’s New guide, available here:
http://cdn.na.sage.com/docs/en/customer/100erp/2018n/open/Payroll_Upgr
ade.pdf

After reviewing the guide, complete the following tasks:

e Select Payroll > Setup > Earnings Code Maintenance. For each
earnings code, select a tax rule.

e Select Payroll > Setup > Deduction Code Maintenance. For each
pension or cafeteria plan deduction code, select a tax rule.

e Select Payroll > Setup > Company Tax Group Setup. For each tax group
that you are using:

o Enter the tax ID number for state and local tax groups. For the
Federal tax group, the tax ID number entered in Company
Maintenance appears and can only be viewed.

o Enter the general ledger account numbers to credit with the tax
amounts withheld from employees’ pay.
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o On the Main tab, enter any tax rates that are specific to your
company and the associated effective dates.

o On the Taxes tab, in the Tax field, select the tax(es) for the selected
tax group. The taxes available are based on the selected tax group.
Note: There may be more than one tax that needs to be set up.

e Select Payroll > Setup > Tax Profile Maintenance. Review the tax
profiles that were created when converting payroll data, and make
changes if needed.

e Select Payroll > Main > Employee Maintenance. On the Taxes tab, enter
at least one tax profile for each employee. Depending on the tax groups,
you may need to enter a filing status, a Workers’ Compensation code, or
other information.

e Also in Employee Maintenance, on the Additional tab, verify that the
correct selection appears in the Ethnicity/Race field.

e If you are using the security feature in Department Maintenance, you
must recreate the lists of users who can access each department.
Select Payroll > Setup > Department Maintenance, and click the
Security tab.

e To ensure that your system can communicate with the tax calculation
engine, add the following URL to your browser's trusted sites list:
spa.na.sage.com

Complete this step on all workstations that will be used to process
payroll, and also on the server where Sage 100 is installed if the
Process Tax Calculation on the Server check box is selected in System
Configuration.

Test your customized Crystal reports and forms.

If you need to troubleshoot issues with customized reports and forms, run
the Crystal Form Comparison Report utility to compare your customized
reports and forms to the standard ones in version 2020.

To run the utility, select File menu > Run, and then type SYWFCU. The
utility tells you which tables, if any, have been added to a report or form. It
does not provide information about formatting changes, such as those
affecting fonts, logos, and so forth.

If you were previously using non-graphical forms, you will need to set them
up using SAP Crystal Reports.

If you are using Sage 100 Standard or Sage 100 Advanced, use the Crystal
Reports Conversion Wizard to convert your Crystal reports and forms. For
more information, see SAP Crystal Reports FAQs in the Help system. If you
do not run the wizard now, it will automatically run the first time that
someone runs a form or report.
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If you are using Sage 100 Premium, refer to the Converting Reports for
Sage 100 Premium section in the Sage 700 Installation and System
Administrators’ Guide for more information.

For the Job Cost and Payroll modules, the Crystal Reports Conversion
Wizard might partially convert your customized forms and reports. Test all of
your customized forms and reports, and use Crystal Reports Designer to
manually update or recreate them as needed.

If Sage 100 2018 is installed on the same computer as an earlier version of
Sage 100, complete this step to avoid errors when printing forms and
reports in the earlier version:

Copy the pvxwin32.exe.config file from the ..\MAS90\Home folder in your
2018 installation to the same folder in the earlier installation. You must
complete this step on both the server and the workstation.

If your system has custom reports, review the Custom Reports menus to
make sure they are available. If they are not, add them using Report
Manager.

If you use Sage Intelligence Reporting, create a new repository for use with
Sage 100 2020 and import any custom reports into it. For detailed
instructions, see Upgrading Sage Intelligence Reporting on page 216.

For the Job Cost and Payroll modules, recreate all Visual Integrator import
and export jobs.

Review the Paperless Office module configuration for e-mailing statements,
reports, journals, registers, and other forms. For more information, see Set
Up Paperless Office in the Help system.

Review your Business Insights Dashboard pages. For more information,
see Set Up Business Insights Dashboard in the Help system.

To use the eBusiness Manager module, restore the copied templates back
to the IW folder after re-installing the Web Engine.

Copy the poweredby.gif image from the MAS90\Images folder to the IIS
Inetpup\wwwroot\images folder and restart the [IS Web service.

If you use Custom Financials Reporting, you must unhide the menu and
tasks. Select File menu > Run and type *unhidegl in the Run Program
window.

Print all customized form definitions and compare them to the ones
previously printed. Default forms may be erased in the upgrade process.

If you purchased the Return Merchandise Authorization module, after
setting up the data files for the first time, select Return Merchandise
Authorization Setup menu > Create Customer Invoice Search Records to
create customer invoice search records in RMA.
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To run Microsoft Script links, you must have the Microsoft Windows Script
Host processor on your system. For information on installing the Microsoft
Windows Script Host processor, refer to the Microsoft Download Center
Web site.

If you use Automatic Update or Task Scheduler, review your scheduled
automatic updates and reschedule those updates by selecting Library
Master Main menu > Automatic Update or Task Scheduler, as applicable.

If you had task folders in your My Tasks area, re-create your Public and
Private task folders.

Test all printers, including Device Configurator printers, that you normally
use for printing forms and reports. Each workstation must have a default
printer defined.

To use the auto-complete feature with enhanced search, run the Build
Search Index utility to index your existing customer, vendor, and item
records.

To run the utility, select Library Master > Utilities > Build Search Index.

Install Sage Exchange Desktop on each workstation for each Windows user
who needs to access credit card and ACH payment information in
Sage 100.

To install Sage Exchange Desktop for Sage 100 Standard:
a Use Windows Explorer to browse to the MAS90\Wksetup folder.

If you are installing Sage Exchange Desktop on a workstation that
connects to a Sage 100 Standard installation on a server, browser to
the MAS90\Wksetup folder on the server.

b Double-click Autorun.exe to open the Workstation Setup program; it
takes a few seconds to launch.

¢ Click Install Sage Exchange Desktop.

d Proceed through the steps in the Sage Exchange Desktop installation
wizard to install the program.

To install Sage Exchange Desktop for Sage 100 Advanced and
Premium:

a Use Windows Explorer to browse to the server where Sage 100 is
installed, and locate the MAS90\Wksetup folder.

b Double-click Autorun.exe to open the Workstation Setup program; it
takes a few seconds to launch.

¢ Click Install Sage Exchange Desktop.
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d Proceed through the steps in the Sage Exchange Desktop installation
wizard to install the program.

For information on what is new in this release, see What's New in Version 2020 on
page 3.
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Upgrading from Version 2016 to Version 2020

When upgrading to version 2020, you must perform a parallel installation, and use
the Pre-Migration and Parallel Migration utilities from the Library Master Utilities
menu to upgrade your data. For more information, consult with your Sage business
partner.

If you have custom modules or modifications to any of your modules, consult your
Sage business partner or development partner prior to beginning the upgrade
process.

If your system is integrated with Sage CRM, you must follow the instructions for
upgrading Sage CRM in the Sage 100 Installation and System Administrators Guide.
You can find the guide on the Sage 100 documents page:
http://cdn.na.sage.com/docs/en/customer/100erp/Documentation.htm

Pre-Upgrade Checklist

You must prepare your version 2016 data for upgrading. This should be done for
each company you plan to upgrade.

1 Process all pending credit card transactions.

2 Print and update all journals and registers. Failure to do so may result in
loss of data.

3 If you use the Payroll module:

e Update the Payroll Check Register.
e Complete and purge all direct deposit transactions.

e If you have set up departments, you must have a user account set up
with access to all departments in all companies. Department access
must be assigned to individual user logon ID, not by groups. Groups are
no longer used to manage department access.

Note that you must install the Payroll module in addition to installing Sage
100. Payroll is not part of the Sage 100 installation program. To avoid the
need to run a separate data conversion for Payroll, install the module before
proceeding to the Upgrade Checklist.

For more information, see the Sage 100 Payroll Installation and Upgrade
Guide available online at:
http://cdn.na.sage.com/docs/en/customer/100erp/Documentation.htm

4 Create a backup of your version 2016 MAS90 folder, which includes data for
all of your companies. Perform this step following your usual backup
process. For specific support on how to back up your data, refer to manuals
for your backup software or contact the vendor from whom you purchased
that product.

5 Rebuild all data files.
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e [f you are upgrading from Sage 100 Standard or Advanced, use the
Rebuild Key Files and Rebuild Sort File utilities.

e [f you are upgrading from Sage 100 Premium, use the Rebuild Sort File
utility.

You must answer Yes to all recalculation questions.
Print all customized form definitions.

If you are using eBusiness Manager, back up any templates, .htm files, and
the IW folder before uninstalling the previous version of the Web Engine.

Run the Pre-Migration Utility on the Library Master Utilities menu. The utility
examines your data and displays a list of tasks that you should run before
migrating your data. For more information, see the Pre-Migration Utility help.

If you are upgrading Sage 100 Premium, configure your firewall to allow
access to port number 1433 on the server with your version 2016
installation. Port 1433 is the default SQL Server port.

Upgrade Checklist

After completing the Pre-Upgrade Checklist on page 160, you are ready to migrate
your data to your version 2020 system.

e For Sage 100 Standard or Advanced, use the checklist below.

e For Sage 100 Premium, see the checklist on page 162.

Upgrade Checklist for Sage 100 Standard and Advanced

1

Create a backup of your version 2020 MAS90 folder. Creating a backup
now will save time if you need to revert to the folder’s original sate.

Log in to Sage 100 2020, and select Library Master > Ultilities > Parallel
Migration. Follow the steps in the wizard to migrate your data.

After the migration is complete, log into Sage 100 2020 as the
Administrator. Use the tasks available from the Administrative Tools window
to review user security and set up and assign the appropriate roles to your
users.

Review security tasks for new features in version 2020. Review ODBC
security if it is used.

If you are using Unified Logon and you upgraded your system files, you
must add the following statement on one workstation SOTA.ini: Logon=Yes.

If you customized your Desktop, review the customizations on the Custom
toolbar.
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Upgrade Checklist for Sage 100 Premium

Use this check
1 Foryo
e Th

e Th

list to migrate your Sage 100 Premium data.
ur Sage 100 2020 installation, create a backup of the following:
e Sage 100 MAS9O0 folder

e MAS_System SQL Server database

Creating backups now will save time if you need to revert to the installation’s
original state.

2____ Verify that the required rights and permissions are set up on the server(s)
AWARMNG where SQL Server is installed. If the instance of SQL Server for Sage 100
You must have 2020 is installed on a different server than the instance used for your prior
administrator version, you must complete these steps on both servers.
rights for the

server with your
prior version of
Sage 100 and the Se
server with your

a Open the Control Panel, select Administrative Tools, and the select

rvices.

version 2020 b In the Services window, locate the SQL Server instance used for Sage
installation. 100 Premium, right click it, and select Properties.

¢ In the Properties window, click the Log On tab and select an option.

If the SQL Server instance that you're using for version 2020 is
installed on the same server as the instance used for your prior
version of Sage 100 Premium, select Local System Account.

If the SQL Server instance that you’re using for version 2020 is
installed on a different server than the one used for your prior version
of Sage 100 Premium, select This Account.

In the account field, enter: \ServerName\Administrator
Replace "ServerName" with the name of the server. Sage strongly
recommends using the actual Administrator or Domain Administrator

account.

Enter the password for the account.

d Apply your changes and then stop and restart the services.

e If you're working with more than one server, make sure that all servers
can access each other through hidden shares.

For example: \\ServerName\C$, \\ServerName\D$

3___ Start the Parallel Migration Wizard using one of the methods below, and
follow the steps in the Wizard.

o Ify

ou are using Windows Server 2008, start the Parallel Migration

Wizard from the Sage program group on the Start menu.
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e [f you are using Windows Server 2012 or later, start the Parallel
Migration Wizard from the Start window.

The Migration Wizard creates .bak files in the ..\DATA folders for the two
SQL Server locations. The hidden shares are used to access the source
databases to create the .back files. For example:

\\ServerName\c$\Program Files\Microsoft SQL
Server\MSSQL12.MSSQLSERVER\MSSQL\Data

After the .bak files are created, the wizard copies them to the hidden share
of the destination .\DATA SQL Server folders.

To complete the process, the wizard then restores the databases into the
new SQL Server location and removes the .bak files from both the source
and destination locations.

If permissions were not set correctly on both servers, you may receive the
following error: "Error Number : 0x80040e14 Description: Access Denied 5
or Access Denied 2 Setup will now terminate”

If this error occurs, see article number 76993 in the Sage Knowledgebase.

4 After the migration is complete, log into Sage 100 2020 as the
Administrator. Use the tasks available from the Administrative Tools window
to review user security and set up and assign the appropriate roles to your
users.

5 Review security tasks for new features in version 2020. Review ODBC
security if it is used.

6 If you are using Unified Logon and you upgraded your system files, you
must add the following statement on one workstation SOTA.ini: Logon=Yes.

7 If you customized your Desktop, review the customizations.

Data Conversion Checklist

After completing the steps in the Pre-Upgrade Checklist on page 160 and the
Upgrade Checklist on page 161, you are now ready to convert your data to version
2020.

1___ If your company data contains credit card information, install the latest
version of Sage Exchange and verify that the workstation you are using has
a working internet connection. This is necessary so that credit card records
can be transferred to a Sage Exchange Vault account during conversion.
Credit card records must be transferred to a Sage Exchange Vault account
before company data can be converted.

To install Sage Exchange:
a Start the Sage 100 installation program.

b Select your edition of Sage 100.
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¢ Click Productivity Applications.
d Click Install Sage Exchange Desktop to start the installation wizard.
e Proceed through the wizard to install the program.

2 Select Library Master Main menu > Company Maintenance. Select a
company, and then click Convert to convert your data. You must convert
data for each of your companies.

In addition, you can select one or more of the following options:

e Convert Data for All Companies: Select this check box to convert data
for all of your companies instead of doing it one-by-one. This check box
may be unavailable if you’re converting Payroll data, depending on
which version of Payroll you're upgrading from.

e Convert SAP Crystal Reports: Select this check box to convert all of
your custom reports and forms. The time required to convert your
reports and forms depends on how many of them you have that need to
be converted. The process runs in the background, and you can
continue working in Sage 100 while it’s running.

You can convert custom forms and reports later by running the Sage
100 Crystal Report Conversion Wizard.

e Update Custom Office Panels to Current Level: Select this check box to
run the Custom Office panel update for any customized panels for the
companies being converted. This update runs without any prompts.

You can update custom panels later by running the Update Customized
Panels to Current Level utility on the Custom Office Utilities menu.

3 If you are converting Payroll Data, the Payroll Data Conversion Wizard
automatically opens. Companies that include Payroll data must be
converted one by one. You'll be guided through the following tasks:

e Mapping department numbers. If you use payroll departments and any
of the departments numbers contain special characters, you must enter
new department numbers containing only alphanumeric characters to
replace them.

e Selecting tax groups from the payroll tax database to replace your
existing tax codes. If you are using local tax codes, each state and local
tax code combination will be replaced by one tax group. Depending on
which tax codes you're using, the wizard offers suggestions for you to
review and update as needed.

e Adding tax groups to tax profiles. Tax profiles are collections of tax
groups that you assign to employees to determine how their taxes are
calculated. You can access Tax Profile Maintenance from the wizard to
create tax profiles.
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e Selecting filing statuses from the payroll tax database to replace your
existing ones. The filing statuses in the database may differ from the
ones that you are using. The wizard offers suggestions when possible
for you to review and update as needed.

4 If you were not processing transactions through Sage Payment Solutions
but plan to start doing so, contact your Sage Payment Solutions account
executive to convert the Sage Exchange Vault-only account created during
conversion to a processing account.

5 If your system is integrated with Sage CRM, go into CRM Server Options,
and update the following information as needed.

e Integration server port ID
e Sage CRM SQL server name
e Sage CRM SQL database name

The server name and database name should reference the mirror
installation that you created for integration with Sage 100 2020. For more
information on this process, refer to the Installing Sage CRM chapter in the
Sage 100 Installation and System Administrator’s Guide.

After updating the information, load the Sage CRM data.

6 If you synchronize payroll data between your General Ledger module and
Sage Payroll Services, verify that your Sage 100 company or companies
are still linked to the service.

a Select General Ledger > Payroll Services > Payroll Services
Synchronization Wizard.

b Sign in to Sage Payroll Services.
¢ Proceed through the wizard.

d Review the status messages shown in the Synchronizing Data with
Sage Payroll Services window.

If you see a "Synchronization Complete" message, no further action is
required.

If you see a "Synchronization failed" message, contact Sage Payroll
Services Support for assistance with resetting the link.

7 Update customized panels by selecting Custom Office Utilities menu >
Update Customized Panels to Current Level. Review the placement of all
user-defined fields.

For the Job Cost and Payroll modules, you must manually recreate all of
your customized panels. User defined fields will be automatically converted.
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If you have customized Advanced Lookup Engine (ALE) lookups, after
converting to the new version of the software and prior to accessing other
modules, select Library Master Utilities menu > Lookup Conversion to
convert your lookups.

For the Job Cost and Payroll Modules, you must manually recreate all
custom lookups.

Verify that all module links are functional by selecting Library Master Utilities
menu > Link Maintenance Utility. Links that appear in red are broken and
will need to be fixed using the Relink button in Link Maintenance Utility. For
more information on relinking files, see Copy/Move/Relink Files in your Help
system.

If you use the Payroll Module, review the list of enhancements in the Sage
100 Payroll What’s New guide, available here:
http://cdn.na.sage.com/docs/en/customer/100erp/2018n/open/Payroll_Upgr
ade.pdf

After reviewing the guide, complete the following tasks:

e Select Payroll > Setup > Earnings Code Maintenance. For each
earnings code, select a tax rule.

e Select Payroll > Setup > Deduction Code Maintenance. For each
pension or cafeteria plan deduction code, select a tax rule.

e Select Payroll > Setup > Company Tax Group Setup. For each tax group
that you are using:

o Enter the tax ID number for state and local tax groups. For the
Federal tax group, the tax ID number entered in Company
Maintenance appears and can only be viewed.

o Enter the general ledger account numbers to credit with the tax
amounts withheld from employees’ pay.

o On the Main tab, enter any tax rates that are specific to your
company and the associated effective dates.

o On the Taxes tab, in the Tax field, select the tax(es) for the selected
tax group. The taxes available are based on the selected tax group.
Note: There may be more than one tax that needs to be set up.

e Select Payroll > Setup > Tax Profile Maintenance. Review the tax
profiles that were created when converting payroll data, and make
changes if needed.

e Select Payroll > Main > Employee Maintenance. On the Taxes tab, enter
at least one tax profile for each employee. Depending on the tax groups,
you may need to enter a filing status, a Workers’ Compensation code, or
other information.
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e Also in Employee Maintenance, on the Additional tab, verify that the
correct selection appears in the Ethnicity/Race field.

e [f you are using the security feature in Department Maintenance, you
must recreate the lists of users who can access each department.
Select Payroll > Setup > Department Maintenance, and click the
Security tab.

e To ensure that your system can communicate with the tax calculation
engine, add the following URL to your browser's trusted sites list:
spa.na.sage.com

Complete this step on all workstations that will be used to process
payroll, and also on the server where Sage 100 is installed if the
Process Tax Calculation on the Server check box is selected in System
Configuration.

Test your customized Crystal reports and forms.

If you need to troubleshoot issues with customized reports and forms, run
the Crystal Form Comparison Report utility to compare your customized
reports and forms to the standard ones in version 2020.

To run the utility, select File menu > Run, and then type SYWFCU. The
utility tells you which tables, if any, have been added to a report or form. It
does not provide information about formatting changes, such as those
affecting fonts, logos, and so forth.

If you were previously using non-graphical forms, you will need to set them
up using SAP Crystal Reports.

If you are using Sage 100 Standard or Sage 100 Advanced, use the Crystal
Reports Conversion Wizard to convert your Crystal reports and forms. For
more information, see SAP Crystal Reports FAQs in the Help system. If you
do not run the wizard now, it will automatically run the first time that
someone runs a form or report.

If you are using Sage 100 Premium, refer to the Converting Reports for
Sage 100 Premium section in the Sage 700 Installation and System
Administrators’ Guide for more information.

For the Job Cost and Payroll modules, the Crystal Reports Conversion
Wizard might partially convert your customized forms and reports. Test all of
your customized forms and reports, and use Crystal Reports Designer to
manually update or recreate them as needed.

If Sage 100 2018 is installed on the same computer as an earlier version of
Sage 100, complete this step to avoid errors when printing forms and
reports in the earlier version:

Copy the pvxwin32.exe.config file from the ..\MAS90\Home folder in your
2018 installation to the same folder in the earlier installation. You must
complete this step on both the server and the workstation.
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14 If your system has custom reports, review the Custom Reports menus to
make sure they are available. If they are not, add them using Report
Manager.

15 If you use Sage Intelligence Reporting, create a new repository for use with

Sage 100 2020 and import any custom reports into it. For detailed
instructions, see Upgrading Sage Intelligence Reporting on page 216.

16 For the Job Cost and Payroll modules, recreate all Visual Integrator import
and export jobs.

17 Review the Paperless Office module configuration for e-mailing statements,
reports, journals, registers, and other forms. For more information, see Set
Up Paperless Office in the Help system.

18 Review your Business Insights Dashboard pages. For more information,
see Set Up Business Insights Dashboard in the Help system.

19 To use the eBusiness Manager module, restore the copied templates back
to the IW folder after re-installing the Web Engine.

Copy the poweredby.gif image from the MAS90\Images folder to the IIS
Inetpup\wwwroot\images folder and restart the [IS Web service.

20 If you use Custom Financials Reporting, you must unhide the menu and
tasks. Select File menu > Run and type *unhidegl in the Run Program
window.

21 Print all customized form definitions and compare them to the ones

previously printed. Default forms may be erased in the upgrade process.

22 If you purchased the Return Merchandise Authorization module, after
setting up the data files for the first time, select Return Merchandise
Authorization Setup menu > Create Customer Invoice Search Records to
create customer invoice search records in RMA.

23___ To run Microsoft Script links, you must have the Microsoft Windows Script
Host processor on your system. For information on installing the Microsoft
Windows Script Host processor, refer to the Microsoft Download Center
Web site.

24 If you use Automatic Update or Task Scheduler, review your scheduled
automatic updates and reschedule those updates by selecting Library
Master Main menu > Automatic Update or Task Scheduler, as applicable.

25 If you had task folders in your My Tasks area, re-create your Public and
Private task folders.

26 Test all printers, including Device Configurator printers, that you normally
use for printing forms and reports. Each workstation must have a default
printer defined.
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27 To use the auto-complete feature with enhanced search, run the Build
Search Index utility to index your existing customer, vendor, and item
records.

To run the utility, select Library Master > Utilities > Build Search Index.

28 Install Sage Exchange Desktop on each workstation for each Windows user
who needs to access credit card and ACH payment information in
Sage 100.

To install Sage Exchange Desktop for Sage 100 Standard:

a

Use Windows Explorer to browse to the MAS90\Wksetup folder.

If you are installing Sage Exchange Desktop on a workstation that
connects to a Sage 100 Standard installation on a server, browser to
the MAS90\Wksetup folder on the server.

Double-click Autorun.exe to open the Workstation Setup program; it
takes a few seconds to launch.

Click Install Sage Exchange Desktop.

Proceed through the steps in the Sage Exchange Desktop installation
wizard to install the program.

To install Sage Exchange Desktop for Sage 100 Advanced and
Premium:

a

Use Windows Explorer to browse to the server where Sage 100 is
installed, and locate the MAS90\WKksetup folder.

Double-click Autorun.exe to open the Workstation Setup program; it
takes a few seconds to launch.

Click Install Sage Exchange Desktop.

Proceed through the steps in the Sage Exchange Desktop installation
wizard to install the program.

For information on what is new in this release, see What's New in Version 2020 on

page 3.
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When upgrading to version 2020, you must perform a parallel installation, and use
the Pre-Migration and Parallel Migration utilities from the Library Master Utilities
menu to upgrade your data. For more information, consult with your Sage business
partner.

If you have custom modules or modifications to any of your modules, consult your
Sage business partner or development partner prior to beginning the upgrade
process.

If your system is integrated with Sage CRM, you must follow the instructions for
upgrading Sage CRM in the Sage 100 Installation and System Administrators Guide.
You can find the guide on the Sage 100 documents page:
http://cdn.na.sage.com/docs/en/customer/100erp/Documentation.htm

Pre-Upgrade Checklist

You must prepare your version 2015 data for upgrading. This should be done for
each company you plan to upgrade.

1 Process all pending credit card transactions.

2 Print and update all journals and registers. Failure to do so may result in
loss of data.

3 If you use the Payroll module:

e Update the Payroll Check Register.
e Complete and purge all direct deposit transactions.

e If you have set up departments, you must have a user account set up
with access to all departments in all companies. Department access
must be assigned to individual user logon ID, not by groups. Groups are
no longer used to manage department access.

Note that you must install the Payroll module in addition to installing Sage
100. Payroll is not part of the Sage 100 installation program. To avoid the
need to run a separate data conversion for Payroll, install the module before
proceeding to the Upgrade Checklist.

For more information, see the Sage 100 Payroll Installation and Upgrade
Guide available online at:
http://cdn.na.sage.com/docs/en/customer/100erp/Documentation.htm

4 Create a backup of your version 2015 MAS90 folder, which includes data for
all of your companies. Perform this step following your usual backup
process. For specific support on how to back up your data, refer to manuals
for your backup software or contact the vendor from whom you purchased
that product.
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5 Rebuild all data files.

e [f you are upgrading from Sage 100 Standard or Advanced, use the
Rebuild Key Files and Rebuild Sort File utilities.

e If you are upgrading from Sage 100 Premium, use the Rebuild Sort File
utility.

You must answer Yes to all recalculation questions.
6 Print all customized form definitions.

7 If you are using eBusiness Manager, back up any templates, .htm files, and
the IW folder before uninstalling the previous version of the Web Engine.

8 Run the Pre-Migration Utility on the Library Master Utilities menu. The utility
examines your data and displays a list of tasks that you should run before
migrating your data. For more information, see the Pre-Migration Utility help.

9 If you are upgrading Sage 100 Premium, configure your firewall to allow
access to port number 1433 on the server with your version 2015
installation. Port 1433 is the default SQL Server port.

Upgrade Checklist

After completing the Pre-Upgrade Checklist on page 170, you are now ready to
migrate your data to your version 2020 system.

For Sage 100 Standard or Advanced, use the checklist below. For Sage 100
Premium, skip to the next section.
Upgrade Checklist for Sage 100 Standard and Advanced

1 Create a backup of your version 2020 MAS90 folder. Creating a backup
now will save time if you need to revert to the folder’s original sate.

2 Log in to Sage 100 2020, and select Library Master > Ultilities > Parallel
Migration. Follow the steps in the wizard to migrate your data.

3 After the migration is complete, log into Sage 100 2020 as the
Administrator. Use the tasks available from the Administrative Tools window
to review user security and set up and assign the appropriate roles to your
users.

4 Review security tasks for new features in version 2020. Review ODBC
security if it is used.

5 If you are using Unified Logon and you upgraded your system files, you
must add the following statement on one workstation SOTA.ini: Logon=Yes.

6 If you customized your Desktop, review the customizations.
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Upgrade Checklist for Sage 100 Premium

Use this check
1 Foryo
e Th

e Th

list to migrate your Sage 100 Premium data.
ur Sage 100 2020 installation, create a backup of the following:
e Sage 100 MAS9O0 folder

e MAS_System SQL Server database

Creating backups now will save time if you need to revert to the installation’s
original state.

2____ Verify that the required rights and permissions are set up on the server(s)
AWARMNG where SQL Server is installed. If the instance of SQL Server for Sage 100
You must have 2020 is installed on a different server than the instance used for your prior
administrator version, you must complete these steps on both servers.
rights for the

server with your
prior version of
Sage 100 and the Se
server with your

a Open the Control Panel, select Administrative Tools, and the select

rvices.

version 2020 b In the Services window, locate the SQL Server instance used for Sage
installation. 100 Premium, right click it, and select Properties.

¢ In the Properties window, click the Log On tab and select an option.

If the SQL Server instance that you're using for version 2020 is
installed on the same server as the instance used for your prior
version of Sage 100 Premium, select Local System Account.

If the SQL Server instance that you’re using for version 2020 is
installed on a different server than the one used for your prior version
of Sage 100 Premium, select This Account.

In the account field, enter: \ServerName\Administrator
Replace "ServerName" with the name of the server. Sage strongly
recommends using the actual Administrator or Domain Administrator

account.

Enter the password for the account.

d Apply your changes and then stop and restart the services.

e If you're working with more than one server, make sure that all servers
can access each other through hidden shares.

For example: \\ServerName\C$, \\ServerName\D$

3___ Start the Parallel Migration Wizard using one of the methods below, and
follow the steps in the Wizard.

o Ify

ou are using Windows Server 2008, start the Parallel Migration

Wizard from the Sage program group on the Start menu.
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e [f you are using Windows Server 2012 or later, start the Parallel
Migration Wizard from the Start window.

The Migration Wizard creates .bak files in the ..\DATA folders for the two
SQL Server locations. The hidden shares are used to access the source
databases to create the .back files. For example:

\\ServerName\c$\Program Files\Microsoft SQL
Server\MSSQL12.MSSQLSERVER\MSSQL\Data

After the .bak files are created, the wizard copies them to the hidden share
of the destination .\DATA SQL Server folders.

To complete the process, the wizard then restores the databases into the
new SQL Server location and removes the .bak files from both the source
and destination locations.

If permissions were not set correctly on both servers, you may receive the
following error: "Error Number : 0x80040e14 Description: Access Denied 5
or Access Denied 2 Setup will now terminate”

If this error occurs, see article number 76993 in the Sage Knowledgebase.

After the migration is complete, log into Sage 100 2020 as the
Administrator. Use the tasks available from the Administrative Tools window
to review user security and set up and assign the appropriate roles to your
users.

Review security tasks for new features in version 2020. Review ODBC
security if it is used.

If you are using Unified Logon and you upgraded your system files, you
must add the following statement on one workstation SOTA.ini: Logon=Yes.

If you customized your Desktop, review the customizations.
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Data Conversion Checklist

After completing the steps in the Pre-Upgrade Checklist on page 170 and the
Upgrade Checklist on page 171, you are now ready to convert your data to version
2020.

1___ If your company data contains credit card information, install the latest
version of Sage Exchange and verify that the workstation you are using has
a working internet connection. This is necessary so that credit card records
can be transferred to a Sage Exchange Vault account during conversion.
Credit card records must be transferred to a Sage Exchange Vault account
before company data can be converted.

To install Sage Exchange:

a Start the Sage 100 installation program.

b Select your edition of Sage 100.

¢ Click Productivity Applications.

d Click Install Sage Exchange Desktop to start the installation wizard.
e Proceed through the wizard to install the program.

2 Select Library Master Main menu > Company Maintenance. Select a
company, and then click Convert to convert your data. You must convert
data for each of your companies.

In addition, you can select one or more of the following options:

e Convert Data for All Companies: Select this check box to convert data
for all of your companies instead of doing it one-by-one. This check box
may be unavailable if you’re converting Payroll data, depending on
which version of Payroll you're upgrading from.

e Convert SAP Crystal Reports: Select this check box to convert all of
your custom reports and forms. The time required to convert your
reports and forms depends on how many of them you have that need to
be converted. The process runs in the background, and you can
continue working in Sage 100 while it’s running.

You can convert custom forms and reports later by running the Sage
100 Crystal Report Conversion Wizard.

e Update Custom Office Panels to Current Level: Select this check box to
run the Custom Office panel update for any customized panels for the
companies being converted. This update runs without any prompts.

You can update custom panels later by running the Update Customized
Panels to Current Level utility on the Custom Office Utilities menu.
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3 If you are converting Payroll Data, the Payroll Data Conversion Wizard
automatically opens. Companies that include Payroll data must be
converted one by one. You'll be guided through the following tasks:

e Mapping department numbers. If you use payroll departments and any
of the departments numbers contain special characters, you must enter
new department numbers containing only alphanumeric characters to
replace them.

e Selecting tax groups from the payroll tax database to replace your
existing tax codes. If you are using local tax codes, each state and local
tax code combination will be replaced by one tax group. Depending on
which tax codes you're using, the wizard offers suggestions for you to
review and update as needed.

e Adding tax groups to tax profiles. Tax profiles are collections of tax
groups that you assign to employees to determine how their taxes are
calculated. You can access Tax Profile Maintenance from the wizard to
create tax profiles.

e Selecting filing statuses from the payroll tax database to replace your
existing ones. The filing statuses in the database may differ from the
ones that you are using. The wizard offers suggestions when possible
for you to review and update as needed.

4 If you were not processing transactions through Sage Payment Solutions
but plan to start doing so, contact your Sage Payment Solutions account
executive to convert the Sage Exchange Vault-only account created during
conversion to a processing account.

5 If your system is integrated with Sage CRM, go into CRM Server Options,
and update the following information as needed.

e Integration server port ID
e Sage CRM SQL server name
e Sage CRM SQL database name

The server name and database name should reference the mirror
installation that you created for integration with Sage 100 2020. For more
information on this process, refer to the Installing Sage CRM chapter in the
Sage 100 Installation and System Administrator’s Guide.

After updating the information, load the Sage CRM data.

6 If you synchronize payroll data between your General Ledger module and
Sage Payroll Services, verify that your Sage 100 company or companies
are still linked to the service.

a Select General Ledger > Payroll Services > Payroll Services
Synchronization Wizard.

b Sign in to Sage Payroll Services.
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10

¢ Proceed through the wizard.

d Review the status messages shown in the Synchronizing Data with
Sage Payroll Services window.

If you see a "Synchronization Complete" message, no further action is
required.

If you see a "Synchronization failed" message, contact Sage Payroll
Services Support for assistance with resetting the link.

Update customized panels by selecting Custom Office Utilities menu >
Update Customized Panels to Current Level. Review the placement of all
user-defined fields.

For the Job Cost and Payroll modules, you must manually recreate all of
your customized panels. User defined fields will be automatically converted.

If you have customized Advanced Lookup Engine (ALE) lookups, after
converting to the new version of the software and prior to accessing other
modules, select Library Master Utilities menu > Lookup Conversion to
convert your lookups.

For the Job Cost and Payroll Modules, you must manually recreate all
custom lookups.

Verify that all module links are functional by selecting Library Master Utilities
menu > Link Maintenance Utility. Links that appear in red are broken and
will need to be fixed using the Relink button in Link Maintenance Utility. For
more information on relinking files, see Copy/Move/Relink Files in your Help
system.

If you use the Payroll Module, review the list of enhancements in the Sage
100 Payroll What’s New guide, available here:
http://cdn.na.sage.com/docs/en/customer/100erp/2018n/open/Payroll_Upgr
ade.pdf

After reviewing the guide, complete the following tasks:

e Select Payroll > Setup > Earnings Code Maintenance. For each
earnings code, select a tax rule.

e Select Payroll > Setup > Deduction Code Maintenance. For each
pension or cafeteria plan deduction code, select a tax rule.

e Select Payroll > Setup > Company Tax Group Setup. For each tax group
that you are using:

o Enter the tax ID number for state and local tax groups. For the
Federal tax group, the tax ID number entered in Company
Maintenance appears and can only be viewed.

o Enter the general ledger account numbers to credit with the tax
amounts withheld from employees’ pay.
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o On the Main tab, enter any tax rates that are specific to your
company and the associated effective dates.

o On the Taxes tab, in the Tax field, select the tax(es) for the selected
tax group. The taxes available are based on the selected tax group.
Note: There may be more than one tax that needs to be set up.

e Select Payroll > Setup > Tax Profile Maintenance. Review the tax
profiles that were created when converting payroll data, and make
changes if needed.

e Select Payroll > Main > Employee Maintenance. On the Taxes tab, enter
at least one tax profile for each employee. Depending on the tax groups,
you may need to enter a filing status, a Workers’ Compensation code, or
other information.

e Also in Employee Maintenance, on the Additional tab, verify that the
correct selection appears in the Ethnicity/Race field.

e If you are using the security feature in Department Maintenance, you
must recreate the lists of users who can access each department.
Select Payroll > Setup > Department Maintenance, and click the
Security tab.

e To ensure that your system can communicate with the tax calculation
engine, add the following URL to your browser's trusted sites list:
spa.na.sage.com

Complete this step on all workstations that will be used to process
payroll, and also on the server where Sage 100 is installed if the
Process Tax Calculation on the Server check box is selected in System
Configuration.

Test your customized Crystal reports and forms.

If you need to troubleshoot issues with customized reports and forms, run
the Crystal Form Comparison Report utility to compare your customized
reports and forms to the standard ones in version 2020.

To run the utility, select File menu > Run, and then type SYWFCU. The
utility tells you which tables, if any, have been added to a report or form. It
does not provide information about formatting changes, such as those
affecting fonts, logos, and so forth.

If you were previously using non-graphical forms, you will need to set them
up using SAP Crystal Reports.

If you are using Sage 100 Standard or Sage 100 Advanced, use the Crystal
Reports Conversion Wizard to convert your Crystal reports and forms. For
more information, see SAP Crystal Reports FAQs in the Help system. If you
do not run the wizard now, it will automatically run the first time that
someone runs a form or report.
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If you are using Sage 100 Premium, refer to the Converting Reports for
Sage 100 Premium section in the Sage 700 Installation and System
Administrators’ Guide for more information.

For the Job Cost and Payroll modules, the Crystal Reports Conversion
Wizard might partially convert your customized forms and reports. Test all of
your customized forms and reports, and use Crystal Reports Designer to
manually update or recreate them as needed.

If Sage 100 2018 is installed on the same computer as an earlier version of
Sage 100, complete this step to avoid errors when printing forms and
reports in the earlier version:

Copy the pvxwin32.exe.config file from the ..\MAS90\Home folder in your
2018 installation to the same folder in the earlier installation. You must
complete this step on both the server and the workstation.

If your system has custom reports, review the Custom Reports menus to
make sure they are available. If they are not, add them using Report
Manager.

If you use Sage Intelligence Reporting, create a new repository for use with
Sage 100 2020 and import any custom reports into it. For detailed
instructions, see Upgrading Sage Intelligence Reporting on page 216.

For the Job Cost and Payroll modules, recreate all Visual Integrator import
and export jobs.

Review the Paperless Office module configuration for e-mailing statements,
reports, journals, registers, and other forms. For more information, see Set
Up Paperless Office in the Help system.

Review your Business Insights Dashboard pages. For more information,
see Set Up Business Insights Dashboard in the Help system.

To use the eBusiness Manager module, restore the copied templates back
to the IW folder after re-installing the Web Engine.

Copy the poweredby.gif image from the MAS90\Images folder to the IIS
Inetpup\wwwroot\images folder and restart the [IS Web service.

If you use Custom Financials Reporting, you must unhide the menu and
tasks. Select File menu > Run and type *unhidegl in the Run Program
window.

Print all customized form definitions and compare them to the ones
previously printed. Default forms may be erased in the upgrade process.

If you purchased the Return Merchandise Authorization module, after
setting up the data files for the first time, select Return Merchandise
Authorization Setup menu > Create Customer Invoice Search Records to
create customer invoice search records in RMA.
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To run Microsoft Script links, you must have the Microsoft Windows Script
Host processor on your system. For information on installing the Microsoft
Windows Script Host processor, refer to the Microsoft Download Center
Web site.

If you use Automatic Update or Task Scheduler, review your scheduled
automatic updates and reschedule those updates by selecting Library
Master Main menu > Automatic Update or Task Scheduler, as applicable.

If you had task folders in your My Tasks area, re-create your Public and
Private task folders.

Test all printers, including Device Configurator printers, that you normally
use for printing forms and reports. Each workstation must have a default
printer defined.

To use the auto-complete feature with enhanced search, run the Build
Search Index utility to index your existing customer, vendor, and item
records.

To run the utility, select Library Master > Utilities > Build Search Index.

Install Sage Exchange Desktop on each workstation for each Windows user
who needs to access credit card and ACH payment information in
Sage 100.

To install Sage Exchange Desktop for Sage 100 Standard:
a Use Windows Explorer to browse to the MAS90\Wksetup folder.

If you are installing Sage Exchange Desktop on a workstation that
connects to a Sage 100 Standard installation on a server, browser to
the MAS90\Wksetup folder on the server.

b Double-click Autorun.exe to open the Workstation Setup program; it
takes a few seconds to launch.

¢ Click Install Sage Exchange Desktop.

d Proceed through the steps in the Sage Exchange Desktop installation
wizard to install the program.

To install Sage Exchange Desktop for Sage 100 Advanced and
Premium:

a Use Windows Explorer to browse to the server where Sage 100 is
installed, and locate the MAS90\Wksetup folder.

b Double-click Autorun.exe to open the Workstation Setup program; it
takes a few seconds to launch.

¢ Click Install Sage Exchange Desktop.
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d Proceed through the steps in the Sage Exchange Desktop installation
wizard to install the program.

For information on what is new in this release, see What's New in Version 2020 on
page 3.
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Upgrading from Version 2014 to Version 2020

When upgrading to version 2020, you must perform a parallel installation, and use
the Pre-Migration and Parallel Migration utilities from the Library Master Utilities
menu to upgrade your data. For more information, consult with your Sage business
partner.

If you have custom modules or modifications to any of your modules, consult your
Sage business partner or development partner prior to beginning the upgrade
process.

If your system is integrated with Sage CRM, you must follow the instructions for
upgrading Sage CRM in the Sage 100 Installation and System Administrators Guide.
You can find the guide on the Sage 100 documents page:
http://cdn.na.sage.com/docs/en/customer/100erp/Documentation.htm

Pre-Upgrade Checklist

You must prepare your version 2014 data for upgrading. This should be done for
each company you plan to upgrade.

1 Process all pending credit card transactions.

2 Print and update all journals and registers. Failure to do so may result in
loss of data.

3 If you use the Payroll module:

e Update the Payroll Check Register.
e Complete and purge all direct deposit transactions.

e If you have set up departments, you must have a user account set up
with access to all departments in all companies. Department access
must be assigned to individual user logon ID, not by groups. Groups are
no longer used to manage department access.

Note that you must install the Payroll module in addition to installing Sage
100. Payroll is not part of the Sage 100 installation program. To avoid the
need to run a separate data conversion for Payroll, install the module before
proceeding to the Upgrade Checklist.

For more information, see the Sage 100 Payroll Installation and Upgrade
Guide available online at:
http://cdn.na.sage.com/docs/en/customer/100erp/Documentation.htm

4 Create a backup of your version 2014 MAS90 folder, which includes data for
all of your companies. Perform this step following your usual backup
process. For specific support on how to back up your data, refer to manuals
for your backup software or contact the vendor from whom you purchased
that product.
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5 If you use the Purchase Order module, you will have the option to start
retaining purchase order history and to create history using records in your
Purchase Order data entry files.

If you plan to create history, consider running the following utilities to clear
out records that you do not want to include:

e Purge Completed Purchase Orders
e Purge Obsolete Purchase Orders

For more information on retaining history, see Purchase Order History on
page 93. For more information on the utilities, see the help system.

6 Rebuild all data files.

e [f you are upgrading from Sage 100 Standard or Advanced, use the
Rebuild Key Files and Rebuild Sort File utilities.

e [f you are upgrading from Sage 100 Premium, use the Rebuild Sort File
utility.

You must answer Yes to all recalculation questions.
7 Print all customized form definitions.

8 If you are using eBusiness Manager, back up any templates, .htm files, and
the IW folder before uninstalling the previous version of the Web Engine.

9 Run the Pre-Migration Utility on the Library Master Utilities menu. The utility
examines your data and displays a list of tasks that you should run before
migrating your data. For more information, see the Pre-Migration Utility help.

10 If you are upgrading Sage 100 Premium, configure your firewall to allow
access to port number 1433 on the server with your version 2014
installation. Port 1433 is the default SQL Server port.

Upgrade Checklist

After completing the Pre-Upgrade Checklist on page 181, you are ready to migrate
your data to your version 2020 system.

For Sage 100 Standard or Advanced, use the checklist below. For Sage 100
Premium, skip to the next section.

Upgrade Checklist for Sage 100 Standard and Advanced

1 Create a backup of your version 2020 MAS90 folder. Creating a backup
now will save time if you need to revert to the folder’s original sate.

2 Log in to Sage 100 2020, and select Library Master > Ultilities > Parallel
Migration. Follow the steps in the wizard to migrate your data.
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After the migration is complete, log into Sage 100 2020 as the
Administrator. Use the tasks available from the Administrative Tools window
to review user security and set up and assign the appropriate roles to your
users.

Review security tasks for new features in version 2020. Review ODBC
security if it is used.

If you are using Unified Logon and you upgraded your system files, you
must add the following statement on one workstation SOTA.ini: Logon=Yes.

If you customized your Desktop, review the customizations.

Upgrade Checklist for Sage 100 Premium

Use this checklist to migrate your Sage 100 Premium data.

For your Sage 100 2020 installation, create a backup of the following:
e The Sage 100 MAS90 folder
e The MAS_System SQL Server database

Creating backups now will save time if you need to revert to the installation’s
original state.

Verify that the required rights and permissions are set up on the server(s)
where SQL Server is installed. If the instance of SQL Server for Sage 100
2020 is installed on a different server than the instance used for your prior
version, you must complete these steps on both servers.

a Open the Control Panel, select Administrative Tools, and the select
Services.

b Inthe Services window, locate the SQL Server instance used for Sage
100 Premium, right click it, and select Properties.

¢ In the Properties window, click the Log On tab and select an option.

e If the SQL Server instance that you’re using for version 2020 is
installed on the same server as the instance used for your prior
version of Sage 100 Premium, select Local System Account.

e If the SQL Server instance that you're using for version 2020 is
installed on a different server than the one used for your prior version
of Sage 100 Premium, select This Account.

In the account field, enter: \\ServerName\Administrator

Replace "ServerName" with the name of the server. Sage strongly
recommends using the actual Administrator or Domain Administrator
account.

Enter the password for the account.
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d Apply your changes and then stop and restart the services.

e If you're working with more than one server, make sure that all servers
can access each other through hidden shares.

For example: \\ServerName\C$, \\ServerName\D$

Start the Parallel Migration Wizard using one of the methods below, and
follow the steps in the Wizard.

e [f you are using Windows Server 2008, start the Parallel Migration
Wizard from the Sage program group on the Start menu.

e If you are using Windows Server 2012 or later, start the Parallel
Migration Wizard from the Start window.

The Migration Wizard creates .bak files in the ..\DATA folders for the two
SQL Server locations. The hidden shares are used to access the source
databases to create the .back files. For example:

\\ServerName\c$\Program Files\Microsoft SQL
Server\MSSQL12.MSSQLSERVER\MSSQL\Data

After the .bak files are created, the wizard copies them to the hidden share
of the destination ..\DATA SQL Server folders.

To complete the process, the wizard then restores the databases into the
new SQL Server location and removes the .bak files from both the source
and destination locations.

If permissions were not set correctly on both servers, you may receive the
following error: "Error Number : 0x80040e14 Description: Access Denied 5
or Access Denied 2 Setup will now terminate”

If this error occurs, see article number 76993 in the Sage Knowledgebase.

After the migration is complete, log into Sage 100 2020 as the
Administrator. Use the tasks available from the Administrative Tools window
to review user security and set up and assign the appropriate roles to your
users.

Review security tasks for new features in version 2020. Review ODBC
security if it is used.

If you are using Unified Logon and you upgraded your system files, you
must add the following statement on one workstation SOTA.ini: Logon=Yes.

If you customized your Desktop, review the customizations.
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Data Conversion Checklist

After completing the steps in the Pre-Upgrade Checklist on page 181 and the
Upgrade Checklist on page 182, you are now ready to convert your data to version
2020.

1___ If your company data contains credit card information, install the latest
version of Sage Exchange and verify that the workstation you are using has
a working internet connection. This is necessary so that credit card records
can be transferred to a Sage Exchange Vault account during conversion.
Credit card records must be transferred to a Sage Exchange Vault account
before company data can be converted.

To install Sage Exchange:

a Start the Sage 100 installation program.

b Select your edition of Sage 100.

¢ Click Productivity Applications.

d Click Install Sage Exchange Desktop to start the installation wizard.
e Proceed through the wizard to install the program.

2 Select Library Master Main menu > Company Maintenance. Select a
company, and then click Convert to convert your data. You must convert
data for each of your companies.

In addition, you can select one or more of the following options:

e Convert Data for All Companies: Select this check box to convert data
for all of your companies instead of doing it one-by-one. This check box
may be unavailable if you’re converting Payroll data, depending on
which version of Payroll you're upgrading from.

e Convert SAP Crystal Reports: Select this check box to convert all of
your custom reports and forms. The time required to convert your
reports and forms depends on how many of them you have that need to
be converted. The process runs in the background, and you can
continue working in Sage 100 while it’s running.

You can convert custom forms and reports later by running the Sage
100 Crystal Report Conversion Wizard.

e Update Custom Office Panels to Current Level: Select this check box to
run the Custom Office panel update for any customized panels for the
companies being converted. This update runs without any prompts.

You can update custom panels later by running the Update Customized
Panels to Current Level utility on the Custom Office Utilities menu.
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If the Purchase Order module is set up for a company, a window with
options for retaining purchase order history appears. You can set up the
feature and create history during data conversion or you can do so at a later
time. For more information, see Purchase Order History on page 93.

3 If you are converting Payroll Data, the Payroll Data Conversion Wizard
automatically opens. Companies that include Payroll data must be
converted one by one. You'll be guided through the following tasks:

e Mapping department numbers. If you use payroll departments and any
of the departments numbers contain special characters, you must enter
new department numbers containing only alphanumeric characters to
replace them.

e Selecting tax groups from the payroll tax database to replace your
existing tax codes. If you are using local tax codes, each state and local
tax code combination will be replaced by one tax group. Depending on
which tax codes you're using, the wizard offers suggestions for you to
review and update as needed.

e Adding tax groups to tax profiles. Tax profiles are collections of tax
groups that you assign to employees to determine how their taxes are
calculated. You can access Tax Profile Maintenance from the wizard to
create tax profiles.

e Selecting filing statuses from the payroll tax database to replace your
existing ones. The filing statuses in the database may differ from the
ones that you are using. The wizard offers suggestions when possible
for you to review and update as needed.

4 If you were not processing transactions through Sage Payment Solutions
but plan to start doing so, contact your Sage Payment Solutions account
executive to convert the Sage Exchange Vault-only account created during
conversion to a processing account.

5 If your system is integrated with Sage CRM, go into CRM Server Options,
and update the following information as needed.

e Integration server port ID
e Sage CRM SQL server name
e Sage CRM SQL database name

The server name and database name should reference the mirror
installation that you created for integration with Sage 100 2020. For more
information on this process, refer to the Installing Sage CRM chapter in the
Sage 100 Installation and System Administrator’s Guide.

After updating the information, load the Sage CRM data.

6 Update customized panels by selecting Custom Office Utilities menu >
Update Customized Panels to Current Level. Review the placement of all
user-defined fields.
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For the Job Cost and Payroll modules, you must manually recreate all of
your customized panels. User defined fields will be automatically converted.

7 If you have customized Advanced Lookup Engine (ALE) lookups, after
converting to the new version of the software and prior to accessing other
modules, select Library Master Utilities menu > Lookup Conversion to
convert your lookups.

For the Job Cost and Payroll Modules, you must manually recreate all
custom lookups.

8 Verify that all module links are functional by selecting Library Master Utilities
menu > Link Maintenance Utility. Links that appear in red are broken and
will need to be fixed using the Relink button in Link Maintenance Ultility. For
more information on relinking files, see Copy/Move/Relink Files in your Help
system.

9 If you use the Payroll Module, review the list of enhancements in the Sage
100 Payroll What’s New guide, available here:
http://cdn.na.sage.com/docs/en/customer/100erp/2018n/open/Payroll_Upgr
ade.pdf

Atfter reviewing the guide, complete the following tasks:

e Select Payroll > Setup > Earnings Code Maintenance. For each
earnings code, select a tax rule.

e Select Payroll > Setup > Deduction Code Maintenance. For each
pension or cafeteria plan deduction code, select a tax rule.

e Select Payroll > Setup > Company Tax Group Setup. For each tax group
that you are using:

o Enter the tax ID number for state and local tax groups. For the
Federal tax group, the tax ID number entered in Company
Maintenance appears and can only be viewed.

o Enter the general ledger account numbers to credit with the tax
amounts withheld from employees’ pay.

o On the Main tab, enter any tax rates that are specific to your
company and the associated effective dates.

o On the Taxes tab, in the Tax field, select the tax(es) for the selected
tax group. The taxes available are based on the selected tax group.
Note: There may be more than one tax that needs to be set up.

e Select Payroll > Setup > Tax Profile Maintenance. Review the tax
profiles that were created when converting payroll data, and make
changes if needed.
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e Select Payroll > Main > Employee Maintenance. On the Taxes tab, enter
at least one tax profile for each employee. Depending on the tax groups,
you may need to enter a filing status, a Workers’ Compensation code, or
other information.

e Also in Employee Maintenance, on the Additional tab, verify that the
correct selection appears in the Ethnicity/Race field.

e If you are using the security feature in Department Maintenance, you
must recreate the lists of users who can access each department.
Select Payroll > Setup > Department Maintenance, and click the
Security tab.

e To ensure that your system can communicate with the tax calculation
engine, add the following URL to your browser's trusted sites list:
spa.na.sage.com

Complete this step on all workstations that will be used to process
payroll, and also on the server where Sage 100 is installed if the
Process Tax Calculation on the Server check box is selected in System
Configuration.

Test your customized Crystal reports and forms.

If you need to troubleshoot issues with customized reports and forms, run
the Crystal Form Comparison Report utility to compare your customized
reports and forms to the standard ones in version 2020.

To run the utility, select File menu > Run, and then type SYWFCU. The
utility tells you which tables, if any, have been added to a report or form. It
does not provide information about formatting changes, such as those
affecting fonts, logos, and so forth.

If you were previously using non-graphical forms, you will need to set them
up using SAP Crystal Reports.

If you are using Sage 100 Standard or Sage 100 Advanced, use the Crystal
Reports Conversion Wizard to convert your Crystal reports and forms. For
more information, see SAP Crystal Reports FAQs in the Help system. If you
do not run the wizard now, it will automatically run the first time that
someone runs a form or report.

If you are using Sage 100 Premium, refer to the Converting Reports for
Sage 100 Premium section in the Sage 7100 Installation and System
Administrators’ Guide for more information.

For the Job Cost and Payroll modules, the Crystal Reports Conversion
Wizard might partially convert your customized forms and reports. Test all of
your customized forms and reports, and use Crystal Reports Designer to
manually update or recreate them as needed.
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If Sage 100 2018 is installed on the same computer as an earlier version of
Sage 100, complete this step to avoid errors when printing forms and
reports in the earlier version:

Copy the pvxwin32.exe.config file from the ..\MAS90\Home folder in your
2018 installation to the same folder in the earlier installation. You must
complete this step on both the server and the workstation.

If your system has custom reports, review the Custom Reports menus to
make sure they are available. If they are not, add them using Report
Manager.

If you use Sage Intelligence Reporting, create a new repository for use with
Sage 100 2020 and import any custom reports into it. For detailed
instructions, see Upgrading Sage Intelligence Reporting on page 216.

For the Job Cost and Payroll modules, recreate all Visual Integrator import
and export jobs.

Review the Paperless Office module configuration for e-mailing statements,
reports, journals, registers, and other forms. For more information, see Set
Up Paperless Office in the Help system.

Review your Business Insights Dashboard pages. For more information,
see Set Up Business Insights Dashboard in the Help system.

To use the eBusiness Manager module, restore the copied templates back
to the IW folder after re-installing the Web Engine.

Copy the poweredby.gif image from the MAS90\Images folder to the IIS
Inetpup\wwwroot\images folder and restart the IIS Web service.

If you use Custom Financials Reporting, you must unhide the menu and
tasks. Select File menu > Run and type *unhidegl in the Run Program
window.

Print all customized form definitions and compare them to the ones
previously printed. Default forms may be erased in the upgrade process.

If you purchased the Return Merchandise Authorization module, after
setting up the data files for the first time, select Return Merchandise
Authorization Setup menu > Create Customer Invoice Search Records to
create customer invoice search records in RMA.

To run Microsoft Script links, you must have the Microsoft Windows Script
Host processor on your system. For information on installing the Microsoft
Windows Script Host processor, refer to the Microsoft Download Center
Web site.

If you use Automatic Update or Task Scheduler, review your scheduled
automatic updates and reschedule those updates by selecting Library
Master Main menu > Automatic Update or Task Scheduler, as applicable.
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24 If you had task folders in your My Tasks area, re-create your Public and
Private task folders.

25 Test all printers, including Device Configurator printers, that you normally
use for printing forms and reports. Each workstation must have a default
printer defined.

26 To use the auto-complete feature with enhanced search, run the Build
Search Index utility to index your existing customer, vendor, and item
records.

To run the utility, select Library Master > Utilities > Build Search Index.

27 Install Sage Exchange Desktop on each workstation for each Windows user
who needs to access credit card and ACH payment information in
Sage 100.

To install Sage Exchange Desktop for Sage 100 Standard:
a Use Windows Explorer to browse to the MAS90\Wksetup folder.

If you are installing Sage Exchange Desktop on a workstation that
connects to a Sage 100 Standard installation on a server, browser to
the MAS90\Wksetup folder on the server.

b Double-click Autorun.exe to open the Workstation Setup program; it
takes a few seconds to launch.

¢ Click Install Sage Exchange Desktop.

d Proceed through the steps in the Sage Exchange Desktop installation
wizard to install the program.

To install Sage Exchange Desktop for Sage 100 Advanced and
Premium:

a Use Windows Explorer to browse to the server where Sage 100 is
installed, and locate the MAS90\Wksetup folder.

b Double-click Autorun.exe to open the Workstation Setup program; it
takes a few seconds to launch.

¢ Click Install Sage Exchange Desktop.

d Proceed through the steps in the Sage Exchange Desktop installation
wizard to install the program.

For information on what is new in this release, see What's New in Version 2020 on
page 3.
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Upgrading from Version 2013 to Version 2020

When upgrading to version 2020, you must perform a parallel installation. Use the
Pre-Migration and Parallel Migration utilities from the Library Master Utilities menu to
upgrade your data. For more information, consult with your Sage business partner.

If you have custom modules or modifications to any of your modules, consult your
Sage business partner or development partner prior to beginning the upgrade
process.

If your system is integrated with Sage CRM, you must follow the instructions for
upgrading Sage CRM in the Sage 100 Installation and System Administrators Guide.
You can find the guide on the Sage 100 documents page:
http://cdn.na.sage.com/docs/en/customer/100erp/Documentation.htm

Pre-Upgrade Checklist

You must prepare your version 2013 data for upgrading. This should be done for
each company you plan to upgrade.

1 Process all pending credit card transactions.

2 Print and update all journals and registers. Failure to do so may result in
loss of data.

3 If you use the Payroll module:

e Update the Payroll Check Register.
e Complete and purge all direct deposit transactions.

e If you have set up departments, you must have a user account set up
with access to all departments in all companies. Department access
must be assigned to individual user logon ID, not by groups. Groups are
no longer used to manage department access.

Note that you must install the Payroll module in addition to installing Sage
100. Payroll is not part of the Sage 100 installation program. To avoid the
need to run a separate data conversion for Payroll, install the module before
proceeding to the Upgrade Checklist.

For more information, see the Sage 100 Payroll Installation and Upgrade
Guide available online at:
http://cdn.na.sage.com/docs/en/customer/100erp/Documentation.htm

4 Create a backup of your version 2013 MAS90 folder, which includes data for
all of your companies. Perform this step following your usual backup
process. For specific support on how to back up your data, refer to manuals
for your backup software or contact the vendor from whom you purchased
that product.
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5 If you use the Purchase Order module, you will have the option to start
retaining purchase order history and to create history using records in your
Purchase Order data entry files.

If you plan to create history, consider running the following utilities to clear
out records that you do not want to include:

e Purge Completed Purchase Orders
e Purge Obsolete Purchase Orders

For more information on retaining history, see Purchase Order History on
page 93. For more information on the utilities, see the help system.

6 Rebuild all data files.

e [f you are upgrading from Sage 100 Standard or Advanced, use the
Rebuild Key Files and Rebuild Sort File utilities.

e [f you are upgrading from Sage 100 Premium, use the Rebuild Sort File
utility.

You must answer Yes to all recalculation questions.
7 Print all customized form definitions.

8 If you are using eBusiness Manager, back up any templates, .htm files, and
the IW folder before uninstalling the previous version of the Web Engine.

9 Run the Pre-Migration Utility on the Library Master Utilities menu. The utility
examines your data and displays a list of tasks that you should run before
migrating your data. For more information, see the Pre-Migration Utility help.

10 If you are upgrading Sage 100 Premium, configure your firewall to allow
access to port number 1433 on the server with your version 2013
installation. Port 1433 is the default SQL Server port.

Upgrade Checklist

After completing the Pre-Upgrade Checklist on page 191, you are now ready to
migrate your data to your version 2020 system.

For Sage 100 Standard or Advanced, use the checklist below. Skip to the next
section for Sage 100 Premium.

Upgrade Checklist for Sage 100 Standard and Advanced

1____ Create a backup of your version 2020 MAS90 folder. Creating a backup
now will save time if you need to revert to the folder’s original sate.

2 Log in to Sage 100 2020, and select Library Master > Utilities > Parallel
Migration. Follow the steps in the wizard to migrate your data.
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After the migration is complete, log into Sage 100 2020 as the
Administrator. Use the tasks available from the Administrative Tools window
to review user security and set up and assign the appropriate roles to your
users.

Review security tasks for new features in version 2020. Review ODBC
security if it is used.

If you are using Unified Logon and you upgraded your system files, you
must add the following statement on one workstation SOTA.ini: Logon=Yes.

If you customized your Desktop, review the customizations.

Upgrade Checklist for Sage 100 Premium

Use this checklist to migrate your Sage 100 Premium data.

For your Sage 100 2020 installation, create a backup of the following:
e The Sage 100 MAS90 folder
e The MAS_System SQL Server database

Creating backups now will save time if you need to revert to the installation’s
original state.

Verify that the required rights and permissions are set up on the server(s)
where SQL Server is installed. If the instance of SQL Server for Sage 100
2020 is installed on a different server than the instance used for your prior
version, you must complete these steps on both servers.

a Open the Control Panel, select Administrative Tools, and the select
Services.

b Inthe Services window, locate the SQL Server instance used for Sage
100 Premium, right click it, and select Properties.

¢ In the Properties window, click the Log On tab and select an option.

e If the SQL Server instance that you’re using for version 2020 is
installed on the same server as the instance used for your prior
version of Sage 100 Premium, select Local System Account.

e If the SQL Server instance that you're using for version 2020 is
installed on a different server than the one used for your prior version
of Sage 100 Premium, select This Account.

In the account field, enter: \\ServerName\Administrator

Replace "ServerName" with the name of the server. Sage strongly
recommends using the actual Administrator or Domain Administrator
account.

Enter the password for the account.
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d Apply your changes and then stop and restart the services.

e If you're working with more than one server, make sure that all servers
can access each other through hidden shares.

For example: \\ServerName\C$, \\ServerName\D$

Start the Parallel Migration Wizard using one of the methods below, and
follow the steps in the Wizard.

e [f you are using Windows Server 2008, start the Parallel Migration
Wizard from the Sage program group on the Start menu.

e If you are using Windows Server 2012 or later, start the Parallel
Migration Wizard from the Start window.

The Migration Wizard creates .bak files in the ..\DATA folders for the two
SQL Server locations. The hidden shares are used to access the source
databases to create the .back files. For example:

\\ServerName\c$\Program Files\Microsoft SQL
Server\MSSQL12.MSSQLSERVER\MSSQL\Data

After the .bak files are created, the wizard copies them to the hidden share
of the destination ..\DATA SQL Server folders.

To complete the process, the wizard then restores the databases into the
new SQL Server location and removes the .bak files from both the source
and destination locations.

If permissions were not set correctly on both servers, you may receive the
following error: "Error Number : 0x80040e14 Description: Access Denied 5
or Access Denied 2 Setup will now terminate”

If this error occurs, see article number 76993 in the Sage Knowledgebase.

After the migration is complete, log into Sage 100 2020 as the
Administrator. Use the tasks available from the Administrative Tools window
to review user security and set up and assign the appropriate roles to your
users.

Review security tasks for new features in version 2020. Review ODBC
security if it is used.

If you are using Unified Logon and you upgraded your system files, you
must add the following statement on one workstation SOTA.ini: Logon=Yes.

If you customized your Desktop, review the customizations.
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Data Conversion Checklist

After completing the steps in the Pre-Upgrade Checklist on page 191 and the
Upgrade Checklist on page 192, you are now ready to convert your data to version
2020.

1___ If your company data contains credit card information, install the latest
version of Sage Exchange and verify that the workstation you are using has
a working internet connection. This is necessary so that credit card records
can be transferred to a Sage Exchange Vault account during conversion.
Credit card records must be transferred to a Sage Exchange Vault account
before company data can be converted.

To install Sage Exchange:

a Start the Sage 100 installation program.

b Select your edition of Sage 100.

¢ Click Productivity Applications.

d Click Install Sage Exchange Desktop to start the installation wizard.
e Proceed through the wizard to install the program.

2 Select Library Master Main menu > Company Maintenance. Select a
company, and then click Convert to convert your data. You must convert
data for each of your companies.

In addition, you can select one or more of the following options:

e Convert Data for All Companies: Select this check box to convert data
for all of your companies instead of doing it one-by-one. This check box
may be unavailable if you’re converting Payroll data, depending on
which version of Payroll you're upgrading from.

e Convert SAP Crystal Reports: Select this check box to convert all of
your custom reports and forms. The time required to convert your
reports and forms depends on how many of them you have that need to
be converted. The process runs in the background, and you can
continue working in Sage 100 while it’s running.

You can convert custom forms and reports later by running the Sage
100 Crystal Report Conversion Wizard.

e Update Custom Office Panels to Current Level: Select this check box to
run the Custom Office panel update for any customized panels for the
companies being converted. This update runs without any prompts.

You can update custom panels later by running the Update Customized
Panels to Current Level utility on the Custom Office Utilities menu.
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If the Purchase Order module is set up for a company, a window with
options for retaining purchase order history appears. You can set up the
feature and create history during data conversion or you can do so at a later
time. For more information, see Purchase Order History on page 93.

3 If you are converting Payroll Data, the Payroll Data Conversion Wizard
automatically opens. Companies that include Payroll data must be
converted one by one. You'll be guided through the following tasks:

e Mapping department numbers. If you use payroll departments and any
of the departments numbers contain special characters, you must enter
new department numbers containing only alphanumeric characters to
replace them.

e Selecting tax groups from the payroll tax database to replace your
existing tax codes. If you are using local tax codes, each state and local
tax code combination will be replaced by one tax group. Depending on
which tax codes you're using, the wizard offers suggestions for you to
review and update as needed.

e Adding tax groups to tax profiles. Tax profiles are collections of tax
groups that you assign to employees to determine how their taxes are
calculated. You can access Tax Profile Maintenance from the wizard to
create tax profiles.

e Selecting filing statuses from the payroll tax database to replace your
existing ones. The filing statuses in the database may differ from the
ones that you are using. The wizard offers suggestions when possible
for you to review and update as needed.

4 If you were not processing transactions through Sage Payment Solutions
but plan to start doing so, contact your Sage Payment Solutions account
executive to convert the Sage Exchange Vault-only account created during
conversion to a processing account.

5 If your system is integrated with Sage CRM, go into CRM Server Options,
and update the following information as needed.

e Integration server port ID
e Sage CRM SQL server name
e Sage CRM SQL database name

The server name and database name should reference the mirror
installation that you created for integration with Sage 100 2020. For more
information on this process, refer to the Installing Sage CRM chapter in the
Sage 100 Installation and System Administrator’s Guide.

After updating the information, load the Sage CRM data.

6 Update customized panels by selecting Custom Office Utilities menu >
Update Customized Panels to Current Level. Review the placement of all
user-defined fields.
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For the Job Cost and Payroll modules, you must manually recreate all of
your customized panels. User defined fields will be automatically converted.

7 If you have customized Advanced Lookup Engine (ALE) lookups, after
converting to the new version of the software and prior to accessing other
modules, select Library Master Utilities menu > Lookup Conversion to
convert your lookups.

For the Job Cost and Payroll Modules, you must manually recreate all
custom lookups.

8 Verify that all module links are functional by selecting Library Master Utilities
menu > Link Maintenance Utility. Links that appear in red are broken and
will need to be fixed using the Relink button in Link Maintenance Ultility. For
more information on relinking files, see Copy/Move/Relink Files in your Help
system.

9 If you use the Payroll Module, review the list of enhancements in the Sage
100 Payroll What’s New guide, available here:
http://cdn.na.sage.com/docs/en/customer/100erp/2018n/open/Payroll_Upgr
ade.pdf

Atfter reviewing the guide, complete the following tasks:

e Select Payroll > Setup > Earnings Code Maintenance. For each
earnings code, select a tax rule.

e Select Payroll > Setup > Deduction Code Maintenance. For each
pension or cafeteria plan deduction code, select a tax rule.

e Select Payroll > Setup > Company Tax Group Setup. For each tax group
that you are using:

o Enter the tax ID number for state and local tax groups. For the
Federal tax group, the tax ID number entered in Company
Maintenance appears and can only be viewed.

o Enter the general ledger account numbers to credit with the tax
amounts withheld from employees’ pay.

o On the Main tab, enter any tax rates that are specific to your
company and the associated effective dates.

o On the Taxes tab, in the Tax field, select the tax(es) for the selected
tax group. The taxes available are based on the selected tax group.
Note: There may be more than one tax that needs to be set up.

e Select Payroll > Setup > Tax Profile Maintenance. Review the tax
profiles that were created when converting payroll data, and make
changes if needed.
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e Select Payroll > Main > Employee Maintenance. On the Taxes tab, enter
at least one tax profile for each employee. Depending on the tax groups,
you may need to enter a filing status, a Workers’ Compensation code, or
other information.

e Also in Employee Maintenance, on the Additional tab, verify that the
correct selection appears in the Ethnicity/Race field.

e If you are using the security feature in Department Maintenance, you
must recreate the lists of users who can access each department.
Select Payroll > Setup > Department Maintenance, and click the
Security tab.

e To ensure that your system can communicate with the tax calculation
engine, add the following URL to your browser's trusted sites list:
spa.na.sage.com

Complete this step on all workstations that will be used to process
payroll, and also on the server where Sage 100 is installed if the
Process Tax Calculation on the Server check box is selected in System
Configuration.

Test your customized Crystal reports and forms.

If you need to troubleshoot issues with customized reports and forms, run
the Crystal Form Comparison Report utility to compare your customized
reports and forms to the standard ones in version 2020.

To run the utility, select File menu > Run, and then type SYWFCU. The
utility tells you which tables, if any, have been added to a report or form. It
does not provide information about formatting changes, such as those
affecting fonts, logos, and so forth.

If you were previously using non-graphical forms, you will need to set them
up using SAP Crystal Reports.

If you are using Sage 100 Standard or Sage 100 Advanced, use the Crystal
Reports Conversion Wizard to convert your Crystal reports and forms. For
more information, see SAP Crystal Reports FAQs in the Help system. If you
do not run the wizard now, it will automatically run the first time that
someone runs a form or report.

If you are using Sage 100 Premium, refer to the Converting Reports for
Sage 100 Premium section in the Sage 7100 Installation and System
Administrators’ Guide for more information.

For the Job Cost and Payroll modules, the Crystal Reports Conversion
Wizard might partially convert your customized forms and reports. Test all of
your customized forms and reports, and use Crystal Reports Designer to
manually update or recreate them as needed.
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If Sage 100 2018 is installed on the same computer as an earlier version of
Sage 100, complete this step to avoid errors when printing forms and
reports in the earlier version:

Copy the pvxwin32.exe.config file from the ..\MAS90\Home folder in your
2018 installation to the same folder in the earlier installation. You must
complete this step on both the server and the workstation.

If your system has custom reports, review the Custom Reports menus to
make sure they are available. If they are not, add them using Report
Manager.

If you use Sage Intelligence Reporting, create a new repository for use with
Sage 100 2020 and import any custom reports into it. For detailed
instructions, see Upgrading Sage Intelligence Reporting on page 216.

For the Job Cost and Payroll modules, recreate all Visual Integrator import
and export jobs.

Review the Paperless Office module configuration for e-mailing statements,
reports, journals, registers, and other forms. For more information, see Set
Up Paperless Office in the Help system.

Review your Business Insights Dashboard pages. For more information,
see Set Up Business Insights Dashboard in the Help system.

To use the eBusiness Manager module, restore the copied templates back
to the IW folder after re-installing the Web Engine.

Copy the poweredby.gif image from the MAS90\Images folder to the IIS
Inetpup\wwwroot\images folder and restart the IIS Web service.

If you use Custom Financials Reporting, you must unhide the menu and
tasks. Select File menu > Run and type *unhidegl in the Run Program
window.

Print all customized form definitions and compare them to the ones
previously printed. Default forms may be erased in the upgrade process.

If you purchased the Return Merchandise Authorization module, after
setting up the data files for the first time, select Return Merchandise
Authorization Setup menu > Create Customer Invoice Search Records to
create customer invoice search records in RMA.

To run Microsoft Script links, you must have the Microsoft Windows Script
Host processor on your system. For information on installing the Microsoft
Windows Script Host processor, refer to the Microsoft Download Center
Web site.

If you use Automatic Update or Task Scheduler, review your scheduled
automatic updates and reschedule those updates by selecting Library
Master Main menu > Automatic Update or Task Scheduler, as applicable.
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24 If you had task folders in your My Tasks area, re-create your Public and
Private task folders.

25 Test all printers, including Device Configurator printers, that you normally
use for printing forms and reports. Each workstation must have a default
printer defined.

26 To use the auto-complete feature with enhanced search, run the Build
Search Index utility to index your existing customer, vendor, and item
records.

To run the utility, select Library Master > Utilities > Build Search Index.

27 Install Sage Exchange Desktop on each workstation for each Windows user
who needs to access credit card and ACH payment information in
Sage 100.

To install Sage Exchange Desktop for Sage 100 Standard:
a Use Windows Explorer to browse to the MAS90\Wksetup folder.

If you are installing Sage Exchange Desktop on a workstation that
connects to a Sage 100 Standard installation on a server, browser to
the MAS90\Wksetup folder on the server.

b Double-click Autorun.exe to open the Workstation Setup program; it
takes a few seconds to launch.

¢ Click Install Sage Exchange Desktop.

d Proceed through the steps in the Sage Exchange Desktop installation
wizard to install the program.

To install Sage Exchange Desktop for Sage 100 Advanced and
Premium:

a Use Windows Explorer to browse to the server where Sage 100 is
installed, and locate the MAS90\Wksetup folder.

b Double-click Autorun.exe to open the Workstation Setup program; it
takes a few seconds to launch.

¢ Click Install Sage Exchange Desktop.

d Proceed through the steps in the Sage Exchange Desktop installation
wizard to install the program.

For information on what is new in this release, see What's New in Version 2020 on
page 3.
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Upgrading from Version 4.50 to Version 2020

When upgrading to version 2020, you must perform a parallel installation, and use
the Pre-Migration and Parallel Migration utilities from the Library Master Utilities
menu to upgrade your data. For more information, consult with your Sage business
partner.

If you have custom modules or modifications to any of your modules, consult your
Sage business partner or development partner prior to beginning the upgrade
process.

If your system is integrated with Sage CRM, you must follow the instructions for
upgrading Sage CRM in the Sage 100 Installation and System Administrators Guide.
You can find the guide on the Sage 100 documents page:
http://cdn.na.sage.com/docs/en/customer/100erp/Documentation.htm

Pre-Upgrade Checklist

You must prepare your version 4.50 data for upgrading. This should be done for
each company you plan to upgrade.

1___ Ifyou haven'tinstalled Product Update 8 for version 4.50, install the update.

2____ Process all pending credit card transactions.

3 Printand update all journals and registers. Failure to do so may result in
loss of data.

4 If you use the Payroll module:

e Update the Payroll Check Register.
e Complete and purge all direct deposit transactions.

e If you have set up departments, you must have a user account set up
with access to all departments in all companies. Department access
must be assigned to individual user logon ID, not by groups. Groups are
no longer used to manage department access.

Note that you must install the Payroll module in addition to installing Sage
100. Payroll is not part of the Sage 100 installation program. To avoid the
need to run a separate data conversion for Payroll, install the module before
proceeding to the Upgrade Checklist.

For more information, see the Sage 100 Payroll Installation and Upgrade
Guide available online at:
http://cdn.na.sage.com/docs/en/customer/100erp/Documentation.htm

5 Create a backup of your version 4.50 MAS90 folder, which includes data for
all of your companies. Perform this step following your usual backup
process. For specific support on how to back up your data, refer to manuals
for your backup software or contact the vendor from whom you purchased
that product.
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6 If you use credit card processing, verify that you have a valid credit card
encryption key in Company Maintenance for proper conversion of credit
card data.

7 If you use the Purchase Order module, you will have the option to start

retaining purchase order history and to create history using records in your
Purchase Order data entry files.

If you plan to create history, consider running the following utilities to clear
out records that you do not want to include:

e Purge Completed Purchase Orders
e Purge Obsolete Purchase Orders

For more information on retaining history, see Purchase Order History on
page 93. For more information on the utilities, see the help system.

8 Rebuild all data files.

e [f you are upgrading from Sage 100 Standard or Advanced, use the
Rebuild Key Files and Rebuild Sort File utilities.

e If you are upgrading from Sage 100 Premium, use the Rebuild Sort File
utility.

You must answer Yes to all recalculation questions.
9 Print all customized form definitions.

10 If you are using eBusiness Manager, back up any templates, .htm files, and
the IW folder before uninstalling the previous version of the Web Engine.

11 If you are upgrading Sage 100 Premium, configure your firewall to allow
access to port number 1433 on the server with your version 4.50
installation. Port 1433 is the default SQL Server port.

Upgrade Checklist

After completing the Pre-Upgrade Checklist on page 201, you are now ready to
migrate your data to your version 2020 system.

1 Create a backup of your version 2020 MAS90 folder. Creating a backup
now will save time if you need to revert to the folder’s original sate.

2 Log in to Sage 100 2020, and select Library Master > Utilities > Parallel
Migration. Follow the steps in the wizard to migrate your data.

3 If you are upgrading Sage 100 Premium, start the Parallel Migration Wizard
using one of the methods below, and follow the steps in the Wizard.

e If you are using Windows Server 2008, start the Parallel Migration
Wizard from the Sage program group on the Start menu.
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e [f you are using Windows Server 2012, start the Parallel Migration
Wizard from the Start window.

The Migration Wizard will back up the Sage 100 SQL databases for your
prior version of Sage 100, copy the backup files to the server where Sage
100 2017 SQL Server instance is installed, and then restore them in the
new location. Administrative rights are required for both your prior version of
Sage 100 and for version 2017. The person running the Migration Wizard
must have rights to the following administrative share:
\\{sourceserver-name}\c$

If local security settings prevent the wizard from migrating the databases,
use SQL Server Management Studio to back up the MAS_System and
company databases that you want to migrate. Then copy the .BAK files to
the ..\MSSQL\Data folder on the server where the Sage 100 2017 SQL
Server instance is installed.

4 After the migration is complete, log into Sage 100 2020 as the
Administrator. Use the tasks available from the Administrative Tools window
to review user security and set up and assign the appropriate roles to your
users.

5 Review security tasks for new features in version 2020. Review ODBC
security if it is used.

6 If you are using Unified Logon and you upgraded your system files, you
must add the following statement on one workstation SOTA.ini: Logon=Yes.

7 If you customized your Desktop, review the customizations.

Data Conversion Checklist

After completing the steps in the Pre-Upgrade Checklist on page 201 and the
Upgrade Checklist on page 202, you are now ready to convert your data to version
2020.

1___ If your company data contains credit card information, install the latest
version of Sage Exchange and verify that the workstation you are using has
a working internet connection. This is necessary so that credit card records
can be transferred to a Sage Exchange Vault account during conversion.
Credit card records must be transferred to a Sage Exchange Vault account
before company data can be converted.

To install Sage Exchange:

a Start the Sage 100 installation program.
b Select your edition of Sage 100.

¢ Click Productivity Applications.

d Click Install Sage Exchange Desktop to start the installation wizard.
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e Proceed through the wizard to install the program.

2 Select Library Master Main menu > Company Maintenance. Select a
company, and then click Convert to convert your data. You must convert
data for each of your companies.

In addition, you can select one or more of the following options:

e Convert Data for All Companies: Select this check box to convert data
for all of your companies instead of doing it one-by-one. This check box
may be unavailable if you're converting Payroll data, depending on
which version of Payroll you’re upgrading from.

e Convert SAP Crystal Reports: Select this check box to convert all of
your custom reports and forms. The time required to convert your
reports and forms depends on how many of them you have that need to
be converted. The process runs in the background, and you can
continue working in Sage 100 while it’s running.

You can convert custom forms and reports later by running the Sage
100 Crystal Report Conversion Wizard.

e Update Custom Office Panels to Current Level: Select this check box to
run the Custom Office panel update for any customized panels for the
companies being converted. This update runs without any prompts.

You can update custom panels later by running the Update Customized
Panels to Current Level utility on the Custom Office Utilities menu.

If your data contains credit card records that will be transferred to a Sage
Exchange Vault account, the Credit Card Conversion To Sage Exchange
Vault Time Estimate window appears. This window provides an estimate of
how long it will take to transfer the credit card data. This estimate is based
on benchmark test results, but results will vary based on Internet connection
speed, network traffic, and the number of customer credit card records
stored in your system.

You may be able to decrease the estimate by updating credit card
transactions and purging credit card data. If this window appears, click Yes
to proceed with data conversion or click No to stop the conversion process.

Additional time is required to convert company data after the credit card
records are transferred; that time is not included in the estimate shown on
the window.

If the Purchase Order module is set up for a company, a window with
options for retaining purchase order history appears. You can set up the
feature and create history during data conversion or you can do so at a later
time. For more information, see Purchase Order History on page 93.

3 If you are converting Payroll Data, the Payroll Data Conversion Wizard
automatically opens. Companies that include Payroll data must be
converted one by one. You'll be guided through the following tasks:
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e Mapping department numbers. If you use payroll departments and any
of the departments numbers contain special characters, you must enter
new department numbers containing only alphanumeric characters to
replace them.

e Selecting tax groups from the payroll tax database to replace your
existing tax codes. If you are using local tax codes, each state and local
tax code combination will be replaced by one tax group. Depending on
which tax codes you're using, the wizard offers suggestions for you to
review and update as needed.

e Adding tax groups to tax profiles. Tax profiles are collections of tax
groups that you assign to employees to determine how their taxes are
calculated. You can access Tax Profile Maintenance from the wizard to
create tax profiles.

e Selecting filing statuses from the payroll tax database to replace your
existing ones. The filing statuses in the database may differ from the
ones that you are using. The wizard offers suggestions when possible
for you to review and update as needed.

4 Verify that credit card processing is enabled for each company in Company
Maintenance if credit cards were previously being processed using Sage
Payment Solutions. For more information, see Set Up the Credit Card
Processing Module in the Help system.

If you were not processing transactions through Sage Payment Solutions
but plan to start doing so, contact your Sage Payment Solutions account
executive to convert the Sage Exchange Vault-only account created during
conversion to a processing account.

5 If your system is integrated with Sage CRM, go into CRM Server Options,
and update the following information as needed.

e Integration server port ID
e Sage CRM SQL server name
e Sage CRM SQL database name

The server name and database name should reference the mirror
installation that you created for integration with Sage 100 2020. For more
information on this process, refer to the Installing Sage CRM chapter in the
Sage 100 Installation and System Administrator’s Guide.

After updating the information, load the Sage CRM data.

6 Update customized panels by selecting Custom Office Utilities menu >
Update Customized Panels to Current Level. Review the placement of all
user-defined fields.

For the Job Cost and Payroll modules, you must manually recreate all of
your customized panels. User defined fields will be automatically converted.
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If you have customers with national accounts and credit cards are assigned
to the sold-to customers, review those records to determine whether the
credit card information should be manually transferred to the bill-to
customer.

If you have customized Advanced Lookup Engine (ALE) lookups, after
converting to the new version of the software and prior to accessing other
modules, select Library Master Utilities menu > Lookup Conversion to
convert your lookups.

For the Job Cost and Payroll Modules, you must manually recreate all
custom lookups.

Verify that all module links are functional by selecting Library Master Utilities
menu > Link Maintenance Utility. Links that appear in red are broken and
will need to be fixed using the Relink button in Link Maintenance Ultility. For
more information on relinking files, see Copy/Move/Relink Files in your Help
system.

If you use the Payroll Module, review the list of enhancements in the Sage
100 Payroll What’s New guide, available here:
http://cdn.na.sage.com/docs/en/customer/100erp/2018n/open/Payroll_Upgr
ade.pdf

Atfter reviewing the guide, complete the following tasks:

e Select Payroll > Setup > Earnings Code Maintenance. For each
earnings code, select a tax rule.

e Select Payroll > Setup > Deduction Code Maintenance. For each
pension or cafeteria plan deduction code, select a tax rule.

e Select Payroll > Setup > Company Tax Group Setup. For each tax group
that you are using:

o Enter the tax ID number for state and local tax groups. For the
Federal tax group, the tax ID number entered in Company
Maintenance appears and can only be viewed.

o Enter the general ledger account numbers to credit with the tax
amounts withheld from employees’ pay.

o On the Main tab, enter any tax rates that are specific to your
company and the associated effective dates.

o On the Taxes tab, in the Tax field, select the tax(es) for the selected
tax group. The taxes available are based on the selected tax group.
Note: There may be more than one tax that needs to be set up.

e Select Payroll > Setup > Tax Profile Maintenance. Review the tax
profiles that were created when converting payroll data, and make
changes if needed.
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e Select Payroll > Main > Employee Maintenance. On the Taxes tab, enter
at least one tax profile for each employee. Depending on the tax groups,
you may need to enter a filing status, a Workers’ Compensation code, or
other information.

e Also in Employee Maintenance, on the Additional tab, verify that the
correct selection appears in the Ethnicity/Race field.

e If you are using the security feature in Department Maintenance, you
must recreate the lists of users who can access each department.
Select Payroll > Setup > Department Maintenance, and click the
Security tab.

e To ensure that your system can communicate with the tax calculation
engine, add the following URL to your browser's trusted sites list:
spa.na.sage.com

Complete this step on all workstations that will be used to process
payroll, and also on the server where Sage 100 is installed if the
Process Tax Calculation on the Server check box is selected in System
Configuration.

Test your customized Crystal reports and forms.

If you need to troubleshoot issues with customized reports and forms, run
the Crystal Form Comparison Report utility to compare your customized
reports and forms to the standard ones in version 2017.

To run the utility, select File menu > Run, and then type SYWFCU. The
utility tells you which tables, if any, have been added to a report or form. It
does not provide information about formatting changes, such as those
affecting fonts, logos, and so forth.

If you were previously using non-graphical forms, you will need to set them
up using SAP Crystal Reports.

If you are using Sage 100 Standard or Sage 100 Advanced, use the Crystal
Reports Conversion Wizard to convert your Crystal reports and forms. For
more information, see SAP Crystal Reports FAQs in the Help system. If you
do not run the wizard now, it will automatically run the first time that
someone runs a form or report.

If you are using Sage 100 Premium, refer to the Converting Reports for
Sage 100 Premium section in the Sage 7100 Installation and System
Administrators’ Guide for more information.

For the Job Cost and Payroll modules, the Crystal Reports Conversion
Wizard might partially convert your customized forms and reports. Test all of
your customized forms and reports, and use Crystal Reports Designer to
manually update or recreate them as needed.
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If Sage 100 2018 is installed on the same computer as an earlier version of
Sage 100, complete this step to avoid errors when printing forms and
reports in the earlier version:

Copy the pvxwin32.exe.config file from the ..\MAS90\Home folder in your
2018 installation to the same folder in the earlier installation. You must
complete this step on both the server and the workstation.

If your system has custom reports, review the Custom Reports menus to
make sure they are available. If they are not, add them using Report
Manager.

If you use Sage Intelligence Reporting, create a new repository for use with
Sage 100 2020 and import any custom reports into it. For detailed
instructions, see Upgrading Sage Intelligence Reporting on page 216.

For the Job Cost and Payroll modules, recreate all Visual Integrator import
and export jobs.

Review the Paperless Office module configuration for e-mailing statements,
reports, journals, registers, and other forms. For more information, see Set
Up Paperless Office in the Help system.

Review your Business Insights Dashboard pages. For more information,
see Set Up Business Insights Dashboard in the Help system.

To use the eBusiness Manager module, restore the copied templates back
to the IW folder after re-installing the Web Engine.

Copy the poweredby.gif image from the MAS90\Images folder to the IIS
Inetpup\wwwroot\images folder and restart the IIS Web service.

If you use Custom Financials Reporting, you must unhide the menu and
tasks. Select File menu > Run and type *unhidegl in the Run Program
window.

Print all customized form definitions and compare them to the ones
previously printed. Default forms may be erased in the upgrade process.

If you purchased the Return Merchandise Authorization module, after
setting up the data files for the first time, select Return Merchandise
Authorization Setup menu > Create Customer Invoice Search Records to
create customer invoice search records in RMA.

To run Microsoft Script links, you must have the Microsoft Windows Script
Host processor on your system. For information on installing the Microsoft
Windows Script Host processor, refer to the Microsoft Download Center
Web site.

If you use Automatic Update or Task Scheduler, review your scheduled
automatic updates and reschedule those updates by selecting Library
Master Main menu > Automatic Update or Task Scheduler, as applicable.
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25 If you had task folders in your My Tasks area, re-create your Public and
Private task folders.

26 Test all printers, including Device Configurator printers, that you normally
use for printing forms and reports. Each workstation must have a default
printer defined.

27 To use the auto-complete feature with enhanced search, run the Build
Search Index utility to index your existing customer, vendor, and item
records.

To run the utility, select Library Master > Utilities > Build Search Index.

28 Install Sage Exchange Desktop on each workstation for each Windows user
who needs to access credit card and ACH payment information in
Sage 100.

To install Sage Exchange Desktop for Sage 100 Standard:
a Use Windows Explorer to browse to the MAS90\Wksetup folder.

If you are installing Sage Exchange Desktop on a workstation that
connects to a Sage 100 Standard installation on a server, browser to
the MAS90\Wksetup folder on the server.

b Double-click Autorun.exe to open the Workstation Setup program; it
takes a few seconds to launch.

¢ Click Install Sage Exchange Desktop.

d Proceed through the steps in the Sage Exchange Desktop installation
wizard to install the program.

To install Sage Exchange Desktop for Sage 100 Advanced and
Premium:

a Use Windows Explorer to browse to the server where Sage 100 is
installed, and locate the MAS90\Wksetup folder.

b Double-click Autorun.exe to open the Workstation Setup program; it
takes a few seconds to launch.

¢ Click Install Sage Exchange Desktop.

d Proceed through the steps in the Sage Exchange Desktop installation
wizard to install the program.

For information on what is new in this release, see What's New in Version 2020 on
page 3.
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Upgrading from Version 4.45 to
Sage 100 Premium Version 2020

Before upgrading your data to version 2020, you must perform a parallel installation
and run the Parallel Migration utility from the Windows Start menu > All Programs >
Sage program group. For more information, consult with your Sage business
partner.

If you have custom modules or modifications to any of your modules, consult your
Sage business partner or development partner prior to beginning the upgrade
process.

Pre-Upgrade Checklist

You must prepare your version 4.45 data for upgrade. This should be done for each
company you plan to upgrade. Several steps should be completed by a SQL
Server® administrator.

1 Process all pending credit card transactions.

2 Print and update all journals and registers. Failure to do so may result in
loss of data.

3 Create a backup of your version 4.45 MAS90 folder, which includes data for

all of your companies. Perform this step following your usual backup
process. For specific support on how to back up your data, refer to manuals
for your backup software or contact the vendor from whom you purchased
that product.

4 Rebuild all data files using the Rebuild Sort File utility. You must answer Yes
to all recalculation questions.

5 Print all customized form definitions.

6 If you are upgrading Sage 100 Premium, configure your firewall to allow
access to port number 1433 on the server with your version 4.45
installation. Port 1433 is the default SQL Server port.

Upgrade Checklist

After completing the Pre-Upgrade Checklist on this page, you are now ready to
migrate your data to your version 2020 system.

1 Start the Parallel Migration Wizard using one of the methods below, and
follow the steps in the wizard to migrate your data.

e [f you are using Windows Server 2008, start the Parallel Migration
Wizard from the Sage program group on the Start menu.

e [f you are using Windows Server 2012, start the Parallel Migration
Wizard from the Start window.
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The Migration Wizard will back up the Sage 100 SQL databases for your
prior version of Sage 100, copy the backup files to the server where Sage
100 2020 SQL Server instance is installed, and then restore them in the
new location. Administrative rights are required for both your prior version of
Sage 100 and for version 2020. The person running the Migration Wizard
must have rights to the following administrative share:
\\{sourceserver-name}\c$

If local security settings prevent the wizard from migrating the databases,
use SQL Server Management Studio to back up the MAS_System and
company databases that you want to migrate. Then copy the .BAK files to
the .\MSSQL\Data folder on the server where the Sage 100 2020 SQL
Server instance is installed.

2 After the migration is complete, log into Sage 100 2020 as the
Administrator. Use the tasks available from the Administrative Tools window
to review user security and set up and assign the appropriate roles to your

users.
3 Review security tasks for new features in version 2020.
4 If you are using Unified Logon and you upgraded your system files, you

must add the following statement on one workstation SOTA.ini: Logon=Yes.

5 If you customized your Desktop, review the customizations.

Data Conversion Checklist

After completing the steps in the Pre-Upgrade Checklist on page 210 and the
Upgrade Checklist on page 210, you are now ready to convert your data to version
2020.

1____ If your company data contains credit card information, install the latest
version of Sage Exchange and verify that the workstation you are using has
a working internet connection. This is necessary so that credit card records
can be transferred to a Sage Exchange Vault account during conversion.
Credit card records must be transferred to a Sage Exchange Vault account
before company data can be converted.

To install Sage Exchange:

a Start the Sage 100 installation program.

b Select your edition of Sage 100.

¢ Click Productivity Applications.

d Click Install Sage Exchange Desktop to start the installation wizard.

e Proceed through the wizard to install the program.
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2 Select Library Master Main menu > Company Maintenance. Select a
company, and then click Convert to convert your data. You must convert
data for each of your companies.

In addition, you can select one or more of the following options:

e Convert Data for All Companies: Select this check box to convert data
for all of your companies instead of doing it one-by-one. This check box
may be unavailable if you’re converting Payroll data, depending on
which version of Payroll you're upgrading from.

e Convert SAP Crystal Reports: Select this check box to convert all of
your custom reports and forms. The time required to convert your
reports and forms depends on how many of them you have that need to
be converted. The process runs in the background, and you can
continue working in Sage 100 while it’s running.

You can convert custom forms and reports later by running the Sage
100 Crystal Report Conversion Wizard.

e Update Custom Office Panels to Current Level: Select this check box to
run the Custom Office panel update for any customized panels for the
companies being converted. This update runs without any prompts.

You can update custom panels later by running the Update Customized
Panels to Current Level utility on the Custom Office Utilities menu.

If your data contains credit card records that will be transferred to a Sage
Exchange Vault account, the Credit Card Conversion To Sage Exchange
Vault Time Estimate window appears. This window provides an estimate of
how long it will take to transfer the credit card data. This estimate is based
on benchmark test results, but results will vary based on Internet connection
speed, network traffic, and the number of customer credit card records
stored in your system.

You may be able to decrease the estimate by updating credit card
transactions and purging credit card data. If this window appears, click Yes
to proceed with data conversion or click No to stop the conversion process.

Additional time is required to convert company data after the credit card
records are transferred; that time is not included in the estimate shown on
the window.

3 Verify that credit card processing is enabled for each company in Company
Maintenance if credit cards were previously being processed using Sage
Payment Solutions. For more information, see Set Up the Credit Card
Processing Module in the Help system.

If you were not processing transactions through Sage Payment Solutions
but plan to start doing so, contact your Sage Payment Solutions account
executive to convert the Sage Exchange Vault-only account created during
conversion to a processing account.

Sage 100 2020 Customer Upgrade Guide Page 212



Upgrading from Version 4.45 to Sage 100 Premium Version 2020

10

11_

Update customized panels by selecting Custom Office Utilities menu >
Update Customized Panels to Current Level. Review the placement of all
user-defined fields. For more information, See Customizer Changes on
page 89.

If you have customized Advanced Lookup Engine (ALE) lookups, after
converting to the new version of the software and prior to accessing other
modules, select Library Master Utilities menu > Lookup Conversion to
convert your lookups.

Verify that all module links are functional by selecting Library Master Utilities
menu > Link Maintenance Utility. Links that appear in red are broken and
will need to be fixed using the Relink button in Link Maintenance Utility. For
more information on relinking files, see Copy/Move/Relink Files in your Help
system.

If you had the Extended Solution for customers with national accounts and
the Populate Bill Address Block with ’Bill To’ Customer Block check box was
selected in AR-1068 Setup Options, you must run the Sales Order Bill To
Address Fix Utility (select File menu > Run, then type *Utl) to populate the
sales order bill-to address information with the bill-to customer’s address
information.

Test your modified SAP Crystal reports and forms. Use SAP Crystal Reports
Designer to modify reports as needed.

You must either be logged on using a Windows account that has read
access to the applicable SQL Server database, or you must have a
separate SQL Server authenticated logon ID and password. Integrated
Security is used by default; if your Windows account does not have rights to
the database, a logon dialog box appears, allowing you to enter a different
logon ID and password for database access.

Before modifying forms or the standard Crystal reports found on the Custom
Reports menu, you must be proficient in the use of SAP Crystal Reports.

If Sage 100 2018 is installed on the same computer as an earlier version of
Sage 100, complete this step to avoid errors when printing forms and
reports in the earlier version:

Copy the pvxwin32.exe.config file from the ..\MAS90\Home folder in your
2018 installation to the same folder in the earlier installation. You must
complete this step on both the server and the workstation.

If your system has custom reports, review the Custom Reports menus to
make sure they are available. If they are not, add them using Report
Manager.

If you use Sage Intelligence Reporting, create a new repository for use with
Sage 100 2020 and import any custom reports into it. For detailed
instructions, see Upgrading Sage Intelligence Reporting on page 216.
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If dictionary changes were made to any files used for import or export jobs
created in the Visual Integrator module, those jobs will need to be manually
updated.

To determine if manual updates are required, review the associated file
layout information using the File Layouts and Program Information link on
the Resources page of the Desktop. Verify that the imported field names are
consistent with the new file layouts.

Review the Paperless Office module configuration for e-mailing statements,
reports, journals, registers, and other forms. For more information, see Set
Up Paperless Office in the Help system.

If you do not use taxation for purchase orders, clear the Sales Tax Reporting
check box in Accounts Payable Options.

If you include sales tax on purchase orders and want to enter default tax
schedules for vendors, use Accounts Payable Assign Vendor Tax
Schedules to set up tax schedules.

Confirm in Accounts Receivable Customer Maintenance that all customers
that have exemption numbers still have the exemption number defined.

If you use Custom Financials Reporting, you must unhide the menu and
tasks. Select File menu > Run and type *unhidegl in the Run Program
window.

If you purchased the Return Merchandise Authorization module, after
setting up the data files for the first time, select Return Merchandise
Authorization Setup menu > Create Customer Invoice Search Records to
create customer invoice search records in RMA.

To run Microsoft Script links, you must have the Microsoft Windows Script
Host processor on your system. For information on installing the Microsoft
Windows Script Host processor, refer to the Microsoft Download Center
Web site.

If you use Automatic Update or Task Scheduler, review your scheduled
automatic updates and reschedule those updates by selecting Library
Master Main menu > Automatic Update or Task Scheduler, as applicable.

If you had task folders in your My Tasks area, re-create your Public and
Private task folders.

Test all printers, that you normally use for printing forms and reports. Each
workstation must have a default printer defined.

To use the auto-complete feature with enhanced search, run the Build
Search Index utility to index your existing customer, vendor, and item
records.

To run the utility, select Library Master > Utilities > Build Search Index.
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24 Install Sage Exchange Desktop on each workstation for each Windows user
who needs to access credit card and ACH payment information in
Sage 100.

To install Sage Exchange Desktop for Sage 100 Standard:

a

Use Windows Explorer to browse to the MAS90\Wksetup folder.

If you are installing Sage Exchange Desktop on a workstation that
connects to a Sage 100 Standard installation on a server, browser to
the MAS90\Wksetup folder on the server.

Double-click Autorun.exe to open the Workstation Setup program; it
takes a few seconds to launch.

Click Install Sage Exchange Desktop.

Proceed through the steps in the Sage Exchange Desktop installation
wizard to install the program.

To install Sage Exchange Desktop for Sage 100 Advanced and
Premium:

a

Use Windows Explorer to browse to the server where Sage 100 is
installed, and locate the MAS90\Wksetup folder.

Double-click Autorun.exe to open the Workstation Setup program; it
takes a few seconds to launch.

Click Install Sage Exchange Desktop.

Proceed through the steps in the Sage Exchange Desktop installation
wizard to install the program.

For information on what is new in this release, see What's New in Version 2020 on

page 3.
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Upgrading Sage Intelligence Reporting

If you use Sage Intelligence Reporting, follow the steps in this chapter to create a
new repository for Sage 100 2020. If you have custom reports, follow the instructions
to export custom reports from your prior version of the program and import them into
the new repository.

For detailed instructions on each step, see:

e Export Custom Reports on this page

e Create a New Repository on page 217

e Set Up Sage Intelligence Reporting in Sage 100 2020 on page 217

e Import Custom Reports on page 218

Report Compatibility

Reports can be imported only from an earlier version of the program or another
instance of the same version. For example, you can import a report created in
version 2013 into version 2020. You cannot import a report created in version 2020
into version 2013.

Reports created in Sage 100 Standard and Sage 100 Advanced are not compatible
with Sage 100 Premium. Likewise, reports created in Sage 100 Premium are not
compatible with Sage 100 Standard and Sage 100 Advanced.

Export Custom Reports

In your prior version of Sage 100, export all of the custom reports that you want to
use in version 2020.

To export custom reports

1 In your prior version of Sage 100, select Sage Intelligence Reporting Main menu
> Report Manager.

2 Right-click a report and then click Export Report. (Alternately, select a report and
then, on the Tools menu, click Export Report.)

3 Select the location where you want to save the file and then click Save. A file
with an AL_ extension is created.

4 Repeat these steps for all custom reports that you want to use in version 2020.
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é NoOTE

These steps may
vary depending
on what version
of Windows you
are using. Check
with your network
administrator if
you need
assistance.

Create a New Repository

Create a shared folder to use as the Sage Intelligence Reporting repository for
Sage 100 2020. We recommend using a separate repository for each installation of
Sage Intelligence Reporting.

To create a repository

1

2

Use Windows File Explorer to create a folder in the desired location.

Right-click the folder, point to "Share with," and click "Advanced sharing."

On the Sharing tab, select the "Share this folder" check box.

Enter a share name.

Click Permissions.

For all applicable users, select the Full Control or Read and Write check boxes.
Click OK.

If you use reporting trees or distribution settings, copy the following folders from
the old repository to the new one:

e Report Trees

e Distribution

Set Up Sage Intelligence Reporting in Sage 100
2020

After creating the shared folder, enter its location in Sage 100 2020. If you haven’t
already registered your 2020 version of Sage Intelligence Reporting, you will be
asked to do so.

To set up Sage Intelligence Reporting

1

In Sage 100 2020, select Sage Intelligence Reporting Main menu > Report
Manager.

Click File and then click Change.
Click Yes in the message window.

In the Network Repository Path field, type the UNC path to the shared folder that
you created. For example: \\ServerName\ReportRpository

Click OK.

If you receive a message asking you to register Sage Intelligence Reporting,
click OK to open the License Manager window.
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8

In the Account Number field, enter your Sage customer number.

In the Serial Number field, enter you unlocking key. This field is case-sensitive.

9 Click Apply and then click Perform Registration.

Import Custom Reports

After creating the new repository and registering Sage Intelligence Reporting, import
any custom report files.

To import custom reports

1

If you want to create folders to organize your reports, on the Home tab, click Add
Folder.

Right-click either the Home folder or any custom folder created in step 1, and
click Import Report. (Alternately, you can click the Tools tab, and then click
Import Report.)

Select one of the custom reports that you exported from your prior version.

In the Import Report window, in the Target Connection field, select a connection.
e For consolidated reports, select Sage MAS Consolidation.

e For any other type of report, select Sage MAS (Auto Connect).

In the Report Destination field, select the folder for the report.

Click Import.

On the Home tab in the Actions group, click Refresh.

Repeat these steps for any other custom reports that you exported from your
prior version of Sage Intelligence Reporting.
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Sage 100 2020 Customer Upgrade Guide

items, extended descriptions 65

J
Job Cost
changes in 2018.x 42
changes in 2020 15
job costs, expensing 15
Journal Drill Down window, Paperless Viewer button 22

L

Library Master
changes in 2020 16
changes in 4.50 124
changes in version 2013 116
changes in version 2015 90
changes in version 2016.x 71
changes in version 2017 62
credit card security 124
enhancements in 2019 26

list boxes, exporting to Excel 5

Logging Level utility 6

lookup views, copying 24

lot/serial distribution, sales orders 128

lots, expiration dates 12

M

Manage Your System 121
map services 5
Memo Maintenance 57
Microsoft Windows Installer 107
miscellaneous charge items, syncing changes for bills 39
Mobility for Bar Code 45
module option
add and edit credit card information 117
allow export to Excel 76
allow printing from Lookup window 76
view vendor number during order entry 129
Module PDFs 119
Months to Retain Paid Invoices field 8
MSI 107

N

national accounts 121

New Report window, Report Type field 103
non-graphical forms 45

0]

Office 365 integration, configuration wizard 19
online payments, accepting from customers 9
Open Invoice By Job Report, unlimited cost types 9

P

Paperless Office
changes in 2018.x 47
changes in version 2013 117
changes in version 2015 90
enhancements in 2019 30

Page 221



Index

Paperless Office Delivery Options window 11
Pay Cycle window (Account Receivable), new fields 38
Payroll

changes in 2018 47

changes in 4.50 124

changes in version 2015 91

changes in version 2016 72

deduction options 124

import jobs 125

imports 125

recalculate deductions 124
PCCharge 113
PDF printer driver 32, 90
PEP 120
period-end report selection, reset 35
Physical Count Entry 26
Physical Count Variance Register 26
Physical Count Worksheet 26
PIl work tables, adding to custom reports 5
postal codes, Canadian 76
posting date warning message 20
printer, report and form setting 121
Product Enhancement Program 120
product key 64
Purchase Order

auto generate options 126

changes in 2018.x 47

changes in 2020 17

changes in version 2015 93

changes in version 4.50 126

copying information 93

data entry 126

enhancements in 2019 32

history 93

renamed, removed, or moved tasks 126
purchase orders, applying to invoices and receipts 17

Q

Quick Order Entry 115

quotes
default expiration date 74
default order date 74
promoting 74

quotes, reprinting from history 51

R
Rebuild Key Files 30
Remove Inactive Customers utility 110
renamed, removed, or moved tasks 52, 86, 97
Report Manager, new reports 103
requested-by name, expanded field 3
retired features
version 2018 53
version 2020 19
retired modules
in version 2013 118
in version 2014 105
in version 4.50 129
Return Merchandise Authorization
changes in version 2015 97

Sage 100 2020 Customer Upgrade Guide

Reverse Check Run Utility 7

S

S/O Invoice Data Entry, consolidating sales orders 49
Sage 100 Desktop 36
Sage Advisor 107
Sage Bank Feeds 38
Sage Contact
customer contacts in Outlook 53
Sage CRM
changes in 2014 105
multi-company integration 114
Quick Order Entry 115
Sage Exchange 61, 111
Sage Intelligence Reporting
changes in version 2014 104
changes in version 2015 98
Sage University videos 7, 22, 24, 34
Sales Order
ACH payments 62
changes in 2018.x 48
changes in 4.50 127
changes in version 2013 117
changes in version 2015 98
changes in version 2016.x 74
changes in version 2017 62
data entry 128
enhancements in 2020 18
item pricing 128
job cost options 127
line item commission 127
lot/serial distribution 128
Sales Order reports, excluding orders being invoiced 51
sales orders, reprinting from history 51
SAP Crystal Reports 2011 107
SAP Crystal Reports 2016 36
SData 106
Search Grid window 101
security
credit card 124
in version 4.50 120
requirement 120
security event
allow entry of inactive customers 110
override credit card information 117
overriding bill-to customer 128
removed 117
select inactive vendors 108
serial items, expiration dates 12
Service Notification Maintenance 37
Shipping Data Entry, consolidating sales orders 48
Simple Mail Transfer Protocol, see SMTP
SMTP e-mail authentication in Paperless Office 117
spell checking 35
State/Province Code Maintenance 4

T

telephone numbers
expanded fields 3
phone type 3

Page 222



Index

text size, changing 64

Time Track 42

TimeCard 42

TimeCard compatibility in version 2018 51
TLS 1.223

tracking numbers, adding to invoice emails 33

U
UDFs
excluding from selection grids 40
saving changes in pending status 11
User Settings window 65
utility, recalculate amounts 121, 122

Vv

Vendor Maintenance
inactive vendors 108
view cleared checks 109
vendor name, expanded field 3
vendors, make inactive 108

view cleared checks in Vendor Maintenance 109

Visual Integrator
changes in 2018.x 52
changes in version 2013 118
enhancements in 2020 19
managing job access 52
Visual Process Flows
changes in version 2013 118
Visual Process Flows Manager 118

w

W2 Puerto Rico Mapping E/D Codes 103
warehouses, inactive 41
Web Reports Server 116
work-in-process job costs, expensing 15
Workstation Synchronization

admin rights 6

standard workstations 37

Sage 100 2020 Customer Upgrade Guide

Page 223



	Introduction
	How to Use This Guide
	Graphic Conventions
	Text Conventions


	What's New in Version 2020
	Global
	Expanded Name Fields
	Expanded Fields for Address Information
	Changes for Telephone and Fax Fields
	International Address Support
	Map Service Choices
	Export to Excel Button Added for List Boxes
	Add PII Work Tables To Custom Reports
	Admin Rights Not Required for Workstation Synchronization

	Desktop Utilities
	Customization Import
	Logging Level
	Links to Sage University Training

	Accounts Payable
	Encrypt PII for Inactive Vendors
	Reverse Check Run Utility
	New Options for Retaining Paid Invoices
	1099-NEC Form Added
	Unlimited Cost Types in Open Invoice By Job Report
	You are no longer limited to selecting only 12 cost types when printing the Open Invoice by Jobs Report. In the Cost Types to Print section of the task window, the check boxes for individual cost types have been replaced with a Select Cost Types butt...
	Relocation of Paperless Option in Vendor Maintenance

	Accounts Receivable
	eInvoicing for Accounts Receivable Invoices
	Viewing Addresses in Invoice History Inquiry
	New Options for Retaining Paid Invoices
	Encrypt PII for Inactive Customers
	Relocation of Paperless Option in Customer Maintenance

	Custom Office
	Improved Grid Customization
	Apply Grid Customizations to a Customization Group
	Save UDF Changes in Pending Status
	Mask Information in Data Entry Fields

	Inventory Management
	Expiration Dates for Lot and Serial Items

	Job Cost
	Option for Expensing Work-In-Process Costs
	eInvoicing for Job Cost Invoices

	Library Master
	Conversion Options

	Purchase Order
	Apply Multiple Purchase Orders to An Invoice or Receipt

	Sales Order
	eInvoicing for Sales Order Invoices

	Visual Integrator
	Change for Import Jobs that Include Addresses

	Office 365 Integration
	Retired Features
	Classic Desktop


	Changes in Version 2019
	Global
	Automatic Update of Daily Transaction Register
	Warning Message for Document Dates
	Links to Sage University Training
	View Paperless Documents from Journal Drill Down Window
	Links to Sage University Training
	Auto-Complete for Account Numbers
	Print Status Updated When Using Keep Open Check Boxes
	Security Update for E-mail Delivery
	Message Enhancements
	Copy Feature for Custom Lookup Views
	Links to Sage University
	Payroll Module Removed from Installation Program

	Custom Office
	General Ledger
	Consolidate Journal Entries in General Journal PDF
	Account Appears on All Pages of Detail Reports
	Encrypted Bank Information

	Inventory Management
	Option to Include Inactive Items in Physical Count
	Option to Print Variances Only
	Item Quantity Inquiry Button in Physical Count Entry

	Library Master
	Data File Display and Maintenance
	Activity Log
	Activity Log Configuration Window
	Activity Log Purge Utility
	Activity Log Filter Window
	Activity Log Report
	User ID Field Expanded
	Keep Window Open Check Box in Rebuild Key Files

	Paperless Office
	Text Formatting Options for Messages
	New Merge Fields
	Cc and Bcc Options for E-mail Address
	Additional Attachments When Emailing Forms
	PDF File Name Options
	Option to Copy Salespeople When E-mailing Forms
	Search by Posting Date in Journal and Register Viewer
	Updated Printer Driver

	Purchase Order
	Change for Drop-Ship Purchase Orders

	Sales Order
	Add Tracking Number to Email Messages


	Changes in Version 2018
	Global Changes in 2018.4
	Links to Sage University

	Global Changes in 2018.3
	Reset Button for Period End Report Selection
	Improved Navigation in Calendar Window

	Global Changes in 2018
	Spell Checking
	Updated Desktop
	SAP Crystal Reports 2016
	Service Notification Maintenance

	Installation Changes in 2018.1
	Workstation Synchronization Update for Sage 100 Standard

	Accounts Payable Changes in 2018.2
	Search Invoice History from Vendor Maintenance

	Accounts Payable Changes in 2018
	Form 1099 Tax Reporting

	Accounts Receivable Changes in 2018
	Fields Added to Pay Cycle Window

	Bank Reconciliation Changes in 2018.5
	Sage Bank Feeds

	Bill of Materials Changes in 2018.3
	Update Changes to Miscellaneous Charge Items

	Business Insights Dashboard Changes in 2018
	Credit Card Processing Changes in 2018.4
	Custom Office Changes in 2018.3
	Calculator Option for Numeric Fields
	Buttons Appear in Screen Editor
	Ability to Exclude UDFs from Selection Grids

	Inventory Management changes in 2018.3
	Item Images Open in Windows Photo Viewer

	Inventory Management Changes in 2018
	Warehouse Status Field in Warehouse Code Maintenance

	Job Cost Changes in 2018.5
	Certified Payroll Reporting
	Cost Code Detail Window

	Job Cost Changes in 2018.2
	Time Track

	Job Cost Changes in 2018
	User Interface Enhancements
	Batch Entry
	History
	Utilities Menu
	Forms and Reports
	Period End Processing Reports

	Mobility for Bar Code Changes in 2018
	Mobility Remote Setup for Scanco Mobile App
	Mobility for Bar Code Options (formerly Bar Code Options)
	EZ Import Tasks
	EZ Import Inquiry
	EZ Import Reject Maintenance
	EZ Import Reporting
	Other Renamed or Removed Tasks

	Paperless Office Changes in 2018
	Payroll Changes in 2018
	Purchase Order Changes in 2018.3
	Auto Generate from Sales Orders

	Sales Order Changes in 2018.4
	Consolidate Multiple Orders in Shipping Data Entry
	View Multiple Sales Order and Purchase Order Numbers
	View Multiple Deposits

	Sales Order Changes in 2018.3
	Apply Multiple Sales Orders to an Invoice

	Sales Order Changes in 2018.2
	Reprint Sales Orders and Quotes from History
	Exclude Orders Being Invoiced from Reports

	TimeCard Changes
	Visual Integrator Changes in 2018
	Module Options for Managing Job Access
	Job Cost and Payroll Import and Export Jobs

	Renamed and Replaced Tasks
	Sage Contact for Office 365
	Retired Features
	Time Track Task Locations

	Changes in 2017
	Global
	Enhanced Auto-Complete
	Full Text Search Option in Lookup Windows
	Search for Empty Fields in Lookup Windows
	Maintain Commodity Codes for Miscellaneous and Inventory Items
	Prior and Next Buttons for Calendar Window
	Resizable Memo Maintenance Window
	Ability to Suppress "Remove Forms" Message
	Larger Font for Selected Reports
	Cancel Button Available When Printing Reports
	New Options on Help Ribbon

	Accounts Receivable
	Ability to Accept ACH Payments
	Renamed Tasks, Tabs, and Fields

	Bank Reconciliation
	Option to Keep Bank Reconciliation Report Window Open
	Improved Export to Excel for Reports

	Credit Card Processing
	Sage Exchange Desktop No Longer Automatically Installed

	Customer Relationship Management
	General Ledger
	Improved Export to Excel for Financial Reports

	Library Master
	Search Added to Role Maintenance
	Changes for ACH Payments

	Sales Order
	Ability to Accept ACH Payments
	Renamed Tabs, Fields, and Buttons


	Changes in 2016
	Global Changes in Version 2016.2
	Easy Way to Update Subscription Information

	Global Changes in Version 2016
	New Product Key Required
	New User Interface
	Extended Item Descriptions for All Items
	User Settings Window
	Expanded Customer Purchase Order Field
	New Fields Added to History Tables
	Transfer Document to a Different Batch

	Accounts Payable Changes in Version 2016
	Electronic Payment Vendor Option for Aged Invoice Report
	Larger Font Size Option for Aged Invoice Report
	New Vendor Maintenance Fields for 1099 Reporting

	Accounts Receivable Changes in Version 2016
	Reference Memos in Repetitive Invoice Entry
	Larger Font Size Option for Aged Invoice Report

	Custom Office Changes in Version 2016.1
	Resizable Option for User-Defined Panels
	Object Positioning Options for Resized Windows

	Credit Card Processing Changes in Version 2016.1
	Sage Payment Center
	New Visual Process Flow
	Security Settings
	Transfer Options for Vault-Only Accounts

	Fixed Assets Changes in Version 2016.1
	Fixed Assets Options
	Asset Depreciation Report Task
	Asset Account Maintenance
	Other Relocated or Renamed Tasks
	Security Settings

	General Ledger Changes in Version 2016.2
	Sage Payroll Services Activity Log

	General Ledger Changes in Version 2016
	Sage Payroll Services Integration
	Reset Linked Company for Sage Payroll Services

	Library Master Changes in Version 2016
	Company-Specific Color Options
	Expanded SMTP (Email) Server Password Field
	Theme Tab in Company Maintenance
	New Task Scheduler Options

	Payroll Changes in Version 2016.2
	Process Employee Pre-Note and Direct Deposit Transactions Window
	Sage 100 Direct Deposit Service Activity Log

	Payroll Changes in Version 2016
	Sage 100 Direct Deposit Service
	Updates for ACA Employer Maintenance
	Renamed Fields
	Renamed Menu Option
	Relocated Fields

	Sales Order Changes in Version 2016
	Default Expiration Date for Quotes
	Additional Options When Promoting Quotes
	Use Default Order Date When Promoting Quotes
	Expanded Check Number Field


	Changes in 2015
	Global Changes
	Migration Changes
	Option to Install Canadian Postal Codes
	Module Options for Printing and Exporting
	Expanded Vendor Name Field
	Company-Specific Color for Window Frame Only
	Lookup Wizard Button Added to Lookup Windows
	Stay in Current Module When Changing Company
	New Fields on User Logon Screen
	Detailed Activity Log Entries for Changes to Module Setup Options

	Accounts Payable Changes
	Changes in Product Update 1
	Changes in Version 2015

	Accounts Receivable Changes
	Changes in Product Update 1
	Changes in Version 2015

	Bank Reconciliation
	Sample Format in Positive Pay Export Wizard
	Remit-To Vendor Name In Positive Pay Export File
	Ability to Sort By Multiple Columns
	Print Full Comments Selection Retained When Printing Journals and Registers

	Bar Code
	Improved Process for Correcting Rejected Import Records

	Bill of Materials
	Option to Synchronize Bill and Item Description
	Print Full Comments Selection Retained When Printing Journals and Registers

	Credit Card Processing
	Level 3 Credit Card Processing
	Customer Purchase Order Number

	Custom Office
	User-Defined Scripts for Windows and Tabs

	Customer Relationship Management
	Changes in Product Update 1
	Changes in Version 2015

	General Ledger
	Changes in Product Update 2
	Changes in Product Update 1
	Changes in Version 2015

	Inventory Management
	Module Options for Transaction Types
	Copy From Button in Product Line Maintenance
	Copy From Options for Items
	Source Journal Zoom Button in Item Maintenance
	Sort Report By Field for Item Audit Report
	Access Bill of Materials Maintenance from Item Maintenance
	Security Options for Item Vendor Maintenance
	Last Physical Count Date Added to Item Maintenance

	Library Master
	Preexisting Codes in Country Code Maintenance
	State Code Required Option

	Paperless Office
	Access Report Viewer Directly from Report Task Windows
	Updated PDF Printer Driver
	Paperless Office Feature Added to Reports and Registers

	Payroll
	Changes in Product Update 1
	Changes in Version 2015

	Purchase Order
	Changes in Product Update 1
	Changes in Version 2015

	Return Merchandise Authorization
	Calculator Button Added to Multiple Fields

	Sage Intelligence Reporting
	Updated Version of Sage Intelligence Reporting
	Security Option for Report Viewer
	Installation Process

	Sales Order
	Ability to Reauthorize Credit Card Transactions
	New Customer Memo Button
	Batch Number Added to Sales Order Entry Message
	Ability to Omit Orders On Hold When Printing
	Calendar Button Added to PO Req Date Field
	Calculator Button Added to Tax Amount Field
	Message Appears if Quantity Packed Does Not Match Quantity Shipped
	Changes to Additional Fields Information
	Option to Keep Window Open after Print or Preview


	Changes in 2014
	Global
	Auto-Complete
	Custom Reports
	Default Column Name in Search Grid Window
	MAS Office Button

	Accounts Payable
	Invoice List Button in Invoice Data Entry
	Repetitive Invoice List Button in Repetitive Invoice Entry
	Form 1099 Filing

	Accounts Receivable
	Repetitive Invoice List Button in Repetitive Invoice Entry

	General Ledger
	Keep Financial Reports Window Open

	Library Master
	Report Manager
	System Configuration
	User Maintenance

	Payroll
	Employer Medical Assistance Contribution (MAC) fields
	Electronic Form Filing
	W2 Puerto Rico Mapping E/D Codes

	Sage Intelligence Reporting
	Installation
	Access within Sage 100
	Excel 2010 and Excel 2013 64-Bit Support
	.NET Framework 4.0
	User Interface and Usability Improvements

	Sage CRM
	Retired Modules

	Changes in 2013
	Global Changes
	64-Bit ODBC Driver
	ALE Lookups in Data Entry Windows
	Feedback Form in Help System
	Installation Changes
	Native SData Provider
	Report Changes
	SAP® Crystal Reports®
	Sage Advisor Update
	Installing with Microsoft Windows Installer (MSI)
	Verify Account Information

	Accounts Payable Changes
	Expanded Accounts Payable Invoice Number
	Inactive Vendors
	View Cleared Checks in Vendor Maintenance

	Accounts Receivable Changes
	Inactive Customers
	Credit Card Processing

	Bank Reconciliation Changes
	Common Information Changes
	Credit Card Processing Changes
	PCCharge

	Customer Relationship Management Changes
	Automatic Installation of Module
	Use of Sage 100 License
	Multiple-company Integration with Sage CRM
	Quick Order Entry

	Inventory Management Changes
	Library Master Changes
	Credit Card Processing

	Paperless Office Changes
	Sales Order Changes
	Credit Card Processing

	Visual Integrator Changes
	Visual Process Flows
	Retired Modules
	Module PDFs

	Changes in 4.50
	Global Changes
	Choose an Installation Option
	Security Requirement
	Participate in the Product Enhancement Program
	Retain Report and Form Printer Information Setting
	Manage Your System Window

	Accounts Receivable Changes
	Create National Accounts
	Define Default Price Levels by Customer and Product Line
	Purge Credit Card Data During Period-End Processing
	Define Split Commissions by Customer
	Recalculate Open Order Amounts

	Bar Code Changes
	Print Lot/Serial Distribution Information

	Inventory Management Changes
	Inactive Items
	View Lot/Serial Distribution Information

	Library Master Changes
	Define Credit Card Security Options

	Payroll Changes
	Recalculate Deductions in Payroll Data Entry
	Define Deduction Code Options
	Recalculate All Option for Payroll Imports
	Select Preconfigured Payroll Import Jobs
	Define Minimum Hours for Benefit Accrual
	Identify Business Type

	Purchase Order Changes
	Renamed Task
	View Sales Orders from Purchase Order Entry
	Set Up Additional Purchase Order/Auto Generate Options

	Sales Order Changes
	Set Up Additional Options for Job Cost
	Calculate Sales Commissions by Line Item
	Calculate Item Pricing by Total Quantity
	Distribute Lot/Serial Items from Sales Order Entry
	Generate Purchase Orders from Sales Orders
	Assign Vendors to Miscellaneous/Special Items

	Retired Modules

	Checklists
	Upgrading from Version 2019 to Version 2020
	Pre-Upgrade Checklist
	Upgrade Checklist
	Data Conversion Checklist

	Upgrading from Version 2018 to Version 2020
	Pre-Upgrade Checklist
	Upgrade Checklist
	Data Conversion Checklist

	Upgrading from Version 2017 to Version 2020
	Pre-Upgrade Checklist
	Upgrade Checklist
	Data Conversion Checklist

	Upgrading from Version 2016 to Version 2020
	Pre-Upgrade Checklist
	Upgrade Checklist
	Data Conversion Checklist

	Upgrading from Version 2015 to Version 2020
	Pre-Upgrade Checklist
	Upgrade Checklist
	Data Conversion Checklist

	Upgrading from Version 2014 to Version 2020
	Pre-Upgrade Checklist
	Upgrade Checklist
	Data Conversion Checklist

	Upgrading from Version 2013 to Version 2020
	Pre-Upgrade Checklist
	Upgrade Checklist
	Data Conversion Checklist

	Upgrading from Version 4.50 to Version 2020
	Pre-Upgrade Checklist
	Upgrade Checklist
	Data Conversion Checklist

	Upgrading from Version 4.45 to Sage 100 Premium Version 2020
	Pre-Upgrade Checklist
	Upgrade Checklist
	Data Conversion Checklist


	Upgrading Sage Intelligence Reporting
	Report Compatibility
	Export Custom Reports
	Create a New Repository
	Set Up Sage Intelligence Reporting in Sage 100 2020
	Import Custom Reports




